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1 About This Manual

The section 1.1 Read This Section First highlights important information that you need to be
aware of being moving to 12d Model 15.

This manual then contains information on:

(a) details on some of the new, or modified, options in 12d Model 15.
Chapter 2 General Items is general information.

Chapter 3 Starting Up describes the new start up screen for 72d Model 15.

Chapter 4 Tools and Concepts explains new or modified concepts.

Chapter 5 Menus on Views has information about the menus on Plan, Section and
Perspective views.

The chapters 6 Project to 24 Help are set out in the order that options appear on the
12d Model 15 menus, Reference manual.

(b) the following sections contain information you need when installing and moving across to
12d Model 15.

31.1 Hardware Locks for 12d Model 15

31.2 Installers for Lock Drivers and 12d Model
31.3 User, User_Lib and env.4d for 12d Model 15
31.4 Network Hardware Locks and 12d Model

IMPORTANT NOTE:

Some of the links in this file may not be valid as they are links to information in the 72d Model 15
Reference manual.

Continue to the section 1.1 Read This Section First.
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1.1 Read This Section First

See
1.1.1 Getting Started Manuals and Videos Now on SPOT
1.1.2 Windows Operating Systems Supported
1.1.3 The old Hardlock dongles will NOT work with 12d Model 15.
1.1.4 CodeMeters Need Drivers of at Least Version 8.20
1.1.5 Installer Deletes the Program Files 15.00 Areas
1.1.6 New Guid File Naming Convention
1.1.7 12d Model 15 Projects
1.1.8 Using V15 Projects with 12d Synergy

1.1.1 Getting Started Manuals and Videos Now on SPOT

Page 28

The Getting Started for Design pdf and Getting Started for Surveying pdf are no longer
shipped with 72d Model 15 but are now available, with videos, as FREE Self Paced Online
Training (SPOT) at www.civilandsurveying.com/civil-and-surveying-institute.

The number of free Getting Started course is being continually expanded and currrently
includes:

The free SPOT courses now include:

(a) 12d Model Fundamentals

(b) Getting Started for Design

(c) Getting Started for Surveying

(d) Getting Started for 12d Field

(e) Getting Started for Utility Modelling

(f) Videos from the sessions of the 12d Technical Forum 2021

(g) Coming soon: videos from the sessions of the 12d Technical Forum 2024

Each SPOT course includes videos, documentation and quizzes, plus, a 72d Model licences to
use for the course, and a Certificate of Completion at the successful end of the course.
SPOT also includes more advanced paid course including

(a) Civil Design Basics

(b) Civil Design Features

(c) Pavements

(d) ALDE Introduction to Land Development

Each paid course includes videos, documentation and quizzes, plus, a 12d Model licences to
use for the course, and a Certificate of Completion at the successful end of the course

Certificates of Competency based on an online proctored exam are also available.

Instructor Led Online or Instructor Led Face-to-Face training is also available and the
courses and the dates for these courses are on www.12d.com/training.
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1.1.2 Windows Operating Systems Supported

(a) There is only a 64-bit version of 12d Model 15.
(b) 12d Model 15 WILL RUN on Windows 11

Windows 11 is now our development platform and all our staff and our Test Suite use
Windows 11.. Please let us know if you have any problems on Windows 11 that didn’t occur
on Windows 10.

(c) 12d Model 15 should run on Windows 10

It is exected that 72d Model 15 will run on Windows 10 but as time passes and
Windows 11 diverges more and more from Windows 10, problems may occur.

(d) 72d Model 15 SHOULDN NOT BE RUN on Windows 8.0.
Windows 8.0 is very buggy and no one should be using it for 72d Model 15.
(a) 12d Model 15 MAY RUN on 64-bit Windows 8.1 but that is not recommended.

Windows 8.1 is better than Windows 8 but is still very buggy so there is no guarantee that
everything will run as expected for 12d Model 15.

(b) 12d Model 15 will NOT RUN on Windows Vista, XP or earlier versions of Windows.

1.1.3 The old Hardlock dongles will NOT work with 12d Model 15.

If you still use the brand Hardlock dongles (they were parallel dongles or purple USB dongles)
which were used with 12d Model 10 and earlier versions, then they will not work with
12d Model 15. Please contact your 12d Model Reseller.

1.1.4 CodeMeters Need Drivers of at Least Version 8.20

To obtain new CodeMeter drivers, see 31.2 Installers for Lock Drivers and 12d Model.

1.1.5 Installer Deletes the Program Files 15.00 Areas
The 12d Model 15 Installer first deletes everything in the 15.00 Area before starting the
installation. That is, the 72d Model 15 Installer delete all files in the 32-bit or 64-bit folders
Program Files\12d\12dmodel\15.00
or
Program Files (x86)\12d\12dmodel\15.00

So do not add or modify any files in those areas because they will be deleted by the next
12d Model 15 Install.

1.1.6 New Guid File Naming Convention

In previous versions of 712d Model, model and tins were saved on disk with the same file name
as the model or tin followed by a dot and a file ending to indicate if it was a model or a tin.

For 12d Model 15 this has been changed and the files on disk for models and tins have a guid as
their name. The actual model or tin name is now inside the guid named file.

This is a totally new concept for 72d Model and because names of models, tins, functions and
templates can no longer be known by just looking at the file name on the disk using Windows
File Explorer.

For more information go to 2.2 Guid Naming Convention for 12d Model 15.

Read This Section First
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1.1.7 12d Model 15 Projects

12d Model 15 writes a V15 Project which means that the V15 project can not be opened by any
earlier versions of 12d Model. For example, 712d Model 14 CAN NOT open a V15 Project.

A V15 Project CAN NOT be converted to an earlier 12d Model Project. For example, a V15
Project can not be converted to a V14 Project.

1.1.8 Using V15 Projects with 12d Synergy

12d Model Projects with a V15 database can be used with 12d Synergy 4 and above.
However, it requires at least 12d Synergy 5.1.1.48 or 12d Synergy 4.3.10.141, both of which

have been released.
Note: both Server AND Client must be on the appropriate version for it to work.

Page 30 _ Read This Section
r g j
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2 General Items

See
2.1 Object Tree
2.2 Guid Naming Convention for 12d Model 15
2.3 Migrating a Project
2.4 Themes
2.5 E Snap
2.6 AutoUpdater for 12d Model 15
2.7 Time Warning When NOT a Release Version
2.8 Active Tab Coloured Blue
2.9 Options Log Files Saved & Emailed to 12d
2.10 Preventing Open GL Views
2.11 Outputting Missing Super Tin Components
2.12 Trimeshes and Drafting Elements Working with Polygon Choices in Source Boxes
2.13 Additional Items for Attribute Manipulator

Read This Section First
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Object Tree

As projects increased in size and the number of models, tins and functions in a project have

rapidly increased, many users have asked about the possibility of models, tins and functions
having groups like linestyles, and to any number of levels. This would make it much easier to
group these objects together, and make pop-up lists etc more readable and usable.

That is, the wish is to allow some object names to have a tree structure and full path names like
attributes or Windows folders so that it is easier to group the objects together in pop-up lists.

For example, if the models were called:
"Stage 1/Survey/Revision 3/22 May 2016 TOPO BANK TOP"
"Stage 1/Survey/Revision 3/22 May 2016 VEG TREE" etc

then when looking at a list of models, the list would have a four level tree structure showing
"Stage 1" at the top level, with "Survey" at the second level, "Revision 3" at the third level and
finally "22 May 2016 TOPO BANK TOP", "22 May 2016 VEG TREE" as sub nodes of "Revision
3" at the fourth level.

B Stagel
B Surv
B3

22 May 2016 TOPO BANK TOP
22 May 2016 VEG TREE
22 May 2016 TOPO DRAIN CL
22 May 2016 TOPO BANK BOTTOM
22 May 2016 TOPO TIMN BDY
22 May 2016 ROAD CROWN
22 May 2016 ROAD PAVEMENT EDC
22 May 2016 TOPO WATER EDGE
22 May 2016 TOPO SURFACE LEVEL
22 May 2016 TOPO CHAMGE GRAD
22 May 2016 SURVEY STN
22 May 2016 SEWER. PIPE
22 May 2016 WATER PIPE

Bl Revision 2
TOPO BANK TOP

This grouping is being called Object Tree, and the example above is the case of Object Tree
being used for model names.

In 12d Model 15, this ability to use a tree path name has been implemented for:
(a) models

(b) tins

(c) functions

(

d) templates
When a new 72d Model 15 is created it is automatically Object Tree enabled.

Note

Any pre and post spaces in the each part of the object tree path will be removed but
imbedded spaces are not.

Thatis," fredjones / joe / lee "isthe same as "fred jones/joe/lee"
but

"fred jones" is different to "fred jones"
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2.2 Guid Naming Convention for 12d Model 15

In previous version of 12d Model, models, tins, functions and templates were saved on disk with
the same file name as the model, tin, function or template followed by a dot and a special file
ending to indicate if it was a model, tin, function or template.

For 12d Model 15 this has been changed and the files on disk for models, tins, functions and
templates have a guid as the unique part of their file name, followed by a dot and a special file
ending to indicate if it was a model, tin, function or template.

For example,
C45EDEB2-0110-4FEB-9699-37EE0364DFDF.model

The actual name of the item is now inside the file and so is no longer easily recognised using
tools such as Windows File Explorer.

These new names will be referred to as the guid naming convention and 72d Model projects
using it are called guid projects.

This change can have important ramifications for anyone replying on the name of the file on disk
for a model, tin, function or template to use for another purpose.

For example, in a back up of your data, you can't tell the name of the model, tin, function or
template just by looking at the file name.

Another consequence of the new guid naming convention is that models and tins from earlier
versions of 12d Model can not be shared into 12d Model 15. All non-guid projects must be
migrated to 72d Model 15 projects before any of their tins or models can be shared into a
12d Model 15 project. For information on migrating a project, see 2.3 Migrating a Project.

However the 12d Model 15 options Copy Project /Folder for models, tins, functions and
templates can be used to bring data from non-guid projects into a 12d Model 15 project.

Also 12dXML and 12da can be used to bring data from earlier versions of 12d Model into
12d Model 15.

This change to a guid file naming convention for models, tins, functions and templates could
have unforeseen consequences so if you run into any difficulties please contact your 712d Model
Reseller ASAP so that is can be looked into.

For information on migrating a project, see 2.3 Migrating a Project.

Guid Naming Convention for-12d Model 15
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2.3 Migrating a Project

When 712d Model 15 attempts to open a non-V15 project, rather than trying to convert the project
and saving on top of the old project, the user is asked if the old project is to be migrated to V15.
What migration does is:

(a) for the existing project called XXX, renames it to XXX_old

(b) in the same working folder as the existing project, creates a new V15 project with the
original project name XXX

(c) copies the models, tins, functions and templates from the original project to the new project.
In the new project all elements are given the same element id’s as in the existing project but
the models, tins, functions are given guid names.

(d) copies all the other files in the old project folder over to the new project folder.
Consequently migration will not destroy the original project.

Notes

1. Migration will be triggered if the project is selected from the list in the Open a Recent Project
panel, from the walk-right list in Project =>Recent projects and when you Drag and Drop a
project onto a V15 desktop shortcut.

2. Migration is also necessary for V15 projects that were created BEFORE the V15 guid version
was available. That is, those created by V15 versions before 15.0.0.689.

3. Migration is also necessary for V15 projects that were created as non-Object Tree projects
BEFORE it was decided that all V15 projects must be Object Tree.

4. Because the original project is renamed to XXX_old, you can only migrate a project once. But
you can get around it by renaming XXX_old to a different name.

When a project that requires migration is selected for opening then the Project Migrate panel is
displayed.

Project Migrate
The project needs to be migrated in order to access it
l . The existing project will be renamed fram

maszher
ta

master_ald
The migrated project will be named

master

Migrate the project ?

Cahcel

When Migrate is pressed, a confirmation panel is displayed:

Page 34 _ Migrating a Projegt
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Project Migrate *

ARE ¥0OU REALLY SURE YOU \WANT TO MIGRATE THE PFROJECT

Yes ‘ Mo |

if Yes is selected then the migration proceeds.

Migrating a Project
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2.4 Themes

Before 12d Model 15, 12d Model was shipped with a fixed set of menus on the Main menu and
fixed menus on each type of View. The icons were 16x16 pixels.

Users could change the size of the icons for toolbars but the resulting icons were the traditional
12d Model 14 icons blown up to the larger size.

In 12d Model 15, there are sets of different Main menus, submenus and toolbars, with a variety
of icon sizes. The different sets are called Themes.

One Theme called Classic has the set of menus, submenus and toolbars as used in

12d Model 14 and using the 16x16 pixel icons from 72d Model 14.

There is another Theme called Neo Classic, or Neo, which has the same menu and toolbar

structure as Classic but has new 16x16 pixel icons that match the icons used in the other

Themes.

For all Themes other than Classic and Neo, Themes allow for:

(a) different menus and submenus for the Main menu across the top of 72d Model.

(b) different menus and submenus for each of the View types.

(c) different icon sets for the standard Microsoft choices 125%, 150%, 175% and 200%.
The icon sets are tailored for each icon size.

(d) changing between the different Themes without leaving 12d Model

(e) changing icons sizes for a Theme without leaving 712d Model

For all Themes other than Neo Classic or Classic, the choice of icon sizes are:
(a) Small (S) - 20x20 pixels

(b) Medium (M) - 24x24 pixels

(c) Large (L) - 32x32 pixels

and

(d) Extra Large (XL) - 36x36 pixels

The available Themes are:

(a) Classic

The Classic theme uses a similar layout for the top menu and submenus as that used in
12d Model 14. The icons and size of icons, are the 16x16 icons used in 12d Model 14.

All 12d Model options appear in the Classic theme.
(a) Neo Classic

The Neo Classic, or Neo, theme uses a similar layout for the top menu and submenus as
that used in 72d Model 14 and the size of icons is 16x16. However the icons are the new
icons used in the other Themes in 12d Model 15.

All 12d Model options appear in the Neo Classic theme.
(b) Standard

has the same menu layout as Classic but the icons are different and the size of the icons
can be selected as small, medium, large and extra large. The small size is slightly larger
than for 72d Model 14 and Classic so that they can have more detail in the icons.

Page 36 Themes -
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(c) Design

a theme set up with the Design options on the main menu. The icon size can be selected
from small, medium, large and extra large.

(d) Water

a theme set up with Water options on the main menu. The icon size can be selected from
small, medium, large and extra large.

(e) Survey

a theme set up with Survey options on the main menu. The icon size can be selected from
small, medium, large and extra large.

(f) 12d Field

a theme set up for working with 12d Field. The icon size can be selected from small,
medium, large and extra large.

(99 CAD

a theme set up for drafting. The icon size can be selected from small, medium, large and
extra large.

(h) BIM

a theme set up for BIM work. The icon size can be selected from small, medium, large
and extra large.

(i) Tin
a theme set up with Tin options on the main menu. The icon size can be selected from
small, medium, large and extra large.

Each theme has its own icon

BIM Design Survey Water Classic  Neo Classic
CAD 12d Field Tin Standard

The BIM, CAD, Design, 12d Field, Survey, Tin and Water themes each has a different menu
structure that is tailored to the type of work being undertaken but this means that not all

12d Model options appear in each theme. However all 72d Model options can still be found
using the Search Bar, or by changing back to the Neo, Classic or Standard themes.

The Theme that is currently being used is shown as the next item after Help on the Main menu,
and for themes other than Neo or Classic, the choice of icon sizes is displayed after the name of
the current Theme, and the icon size currently being used for the theme is surrounded by square
brackets [ 1.

CAD Tin Survey Design Water “olumes FPlot Report Lllities  User Help

weny  Yolumes Design Water Flot Report  Utilities  User Help CStandard [5] M LXL)

tzel 5 =I1I =IT S ) E W Alqa a#l =fl = Aal

For information on changing Themes and icon sizes, see 2.4.1 Changing Themes and Icon
Size.

Themes
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For information on changing the size of the text on menus, see 2.4.2 Changing Text Size on
Menus.

Note - If there are any problems with the Neo, Classic or other Themes, please report them to
12d Solutions on support@12d.com ASAP.

In the meantime you can switch to the Inbuilt menu structure until the problem is fixed. See 2.4.3
Accessing the Inbuilt 12d Model Menus.

Continue to 2.4.1 Changing Themes and Icon Size or return to 2 General ltems.

Page 38 Themes
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2.4.1 Changing Themes and Icon Size

The Theme that you are currently using is shown as the next item after Help on the Main menu
and clicking on the current Theme name will bring up a menu of the available Themes.

CAD Tin | Survey Design “Water “olumes FPlot Report  Utilities  User Help | Meo
[Meo]

Standard Theme
Design Theme
Survey Theme
Water Theme
12d Field Theme
Cad Theme

Bitd Theme

Tin Theme

Classic Theme

«BBAARER G

Clicking on another Theme on the menu will change to that Theme.
For example, Standard.

M {ntxed) - Project "Eddd_docurmentationt12d_\15_Do..Model_15_Projects\docurmentation\documentation” -

wd Tins Survey Volumes Design ‘Water Plot Peport Utlies User Help (( Standard) [S] M L %L

| TR | | — 7 | — T S B

i@ PZoBl B rERALABE R [ X DO,

K M| ps | =l ~|l & ok
o) o e |

2| @\ Cl® Wl & | 9[85 22|« =

I

For all Themes other than Neo and Classic (which use 16x16 pixel icons), there is also a choice
of icon size to sue for the selected Theme. The choices are:

(a) Small (S) - 20x20 pixels

(b) Medium (M) - 24x24 pixels

(c) Large (L) - 32x32 pixels

and

(d) Extra Large (XL) - 36x36 pixels

The choice of icon sizes is displayed after the name of the current Theme, and the icon size
currently being used is surrounded by square brackets [ ].

ectshdocumentationhdocumentation” -

1 Lhilities  User Help  Standard( [S] M L =L

e ™ RN B 2ln a# e =il = Aal

Themes

|
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To change to different size icons for the same Theme, simply click on the §, M. L, or XL to select
the new icon size and 12d Model will then replace the icons and text with the new size.

For example, after changing to XL:

A (ntxed) - Project "EMdd_docurmentation\12d_15_Do. Model_15_Projects\docurmentationtdocumentation” -

o Tins  Survey “olumes Design “Water Plot Report Utilities  User Help  Standard S M L
~ Hllso g g sl =z 2 |10 A 21 4

ﬂf‘@f/@t‘ﬂ' B~ B 5w R A
l = e | I [ —

- (o &
o] 0= @ )2 @ ClmR)i =+

Note: The Standard Theme has the same menu structure as the Neo and Classic Theme but
the icons are the new icons with the selected icon size.

Note: The size of the text on menus is independent to the size of the icons and is changed
separately. See 2.4.2 Changing Text Size on Menus.

Continue to 2.4.2 Changing Text Size on Menus or return to 2.4 Themes.
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2.4.2 Changing Text Size on Menus

The size of the text on menus is controlled separately to the size of the icons and is controlled by
the Microsoft Display Settings.

Scale and layout

Change the size of text, apps. and other items
100% (Recommended)
125%
150%
175%

200%

LAIIay LIS iLanien

To access the Microsoft Display setting, click RMB (right mouse button) in the Microsoft
window to bring up the menu:

View
d
64 Sort by

12d Model 15 Refresh
- 64 Bit

Paste

Paste shortcut
Git GUI Here
Git Bash Here

Mew

1 Display settings
K2 Personalize

Click on Display settings to bring up the Windows Setting panel.

Themes

|
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Settings - o x
@ Home Display

: . Sleep bett
| Find a setting » Rearrange your displays sep better

Night light can help you get to sleep
by displaying warmer colors at night.

System Select a display below to change the settings for it. Press and hold (or select) a display. then drag to . . o -
rearrange it. Select Night light settings to set things
up.
I 3 Display

49 Sound Help from the web
Setting up multiple monitors

L] Notifications & actions 1 i Changing screen brightness
Fixing screen flickering

Q Focus assist
Adjusting font size

[') Power & sleep

Q Get help
= Storage
Identify Detect ;’ Give feedback

[8 Tablet
Hi Multitasking Color
&1 Projecting to this PC Night light

@D or

Shared experiences

Night light settings

[ Clipboard

Windows HD Color
)< Remote Desktop

Get a brighter and more vibrant picture for videos, games and apps that
@ About support HDR.
Windows HD Color settings

Scale and layout

Change the size of text. apps. and other items

100% (Recommended) ~

Advanced scaling settings

Display resolution

1920 x 1200 (Recommended) ~

Display orientation

Under Scale and layout, click on the choice chevron beside Change the size of text, apps,
and other items and a pop-up with the choices 100%, 125%, 175% and 200% is displayed.

Scale and layout

Change the size of text, apps. and other items
100% (Recommended)
125%
150%
175%

200%

LASpmay wrceinatien s

Select the percentage that you want the text size to become.

Continue to 2.4.3 Accessing the Inbuilt 12d Model Menus or return to 2.4 Themes.
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2.4.3 Accessing the Inbuilt 12d Model Menus

Whilst in a 72d Model Theme, if there are any problems you can return to the Inbuilt 72d Model
Main Menu and View menus for the rest of the session by clicking on the 12d icon in the top left
hand corner of the 12d Model window and select Inbuilt menus.

dm\
Restare Strings

e

Size ‘ﬁ‘ :

kdinimize

Click on 12d icon to bring up the menu

Click to return to the traditional menus

Maxirmize

Close Alt+F4

Inbuilt rmenus

However when 12d Model is restarted, it will revert to the last Theme that was being used.

[

07~ x

Please report any problems with a Theme to 12d Solutions on support@12d.com ASAP so they
can be fixed.

Continue to 2.5 E Snap or return to 2.4 Themes.

Themes
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2.5 E Snap

E for Extrusion snap
[F1T £ x| 6 [€ ] 7| KD olf@ A%

In 12d Model 14, Face snap (F) was introduced and when turned on, allowed you to pick on the
triangle face of a trimesh. So using P, L and F snap, you can select the vertex, edge or face a
Trimesh.

For 12d Model 15, a new snap call Extrusion snap (E) was introduced and its use will now be
explained.

In 12d Model super string extrusions are created in a number of ways.

(a) super string as a round pipe

(b) super string as a rectangular pipe

(c) super string with a 2D super string (with and without holes) swept along the super string
(d) super string with multiple extrusion

Round and rectangular pipes are special cases of (c) but because they are easily defined with a

few parameters, they exist as special cases of the super string. Similarly multiple extrusions
includes (c).

[7] Perspective OpenGL 1 =5 SR
B¢ =|&|¢|X|8| 2« & 2§ 3] 2] @ <| 2| B] 7| *|2|

£
B¢ =@ ¢ &) a5 & 5] 6 3] ;

rectangular super string pipe round super string pipe

super string with multiple extrusions

In each case there is only one super string and this become obvious is Extrusions are turned off
on the perspective views:
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rectangular super string pipe round super string pipe

super string with multiple extrusions

The super string itself is referred to as the spine of the super string.
In 12d Model 14, when picking a super string, with or without an extrusion, the pick only selected
the spine of the super string and not the surface of the extrusion.

To overcome this limitation, in 72d Model 15 a new snap, Extrusion (E) snap, has been
introduced.

When E snap is off, picking a super string is the same as in 12d Model 14.

That is, when E snap is off:

(a) you can only pick the spine of the super string
(b) P snap picks vertices of the super string

(c) L snap picks on a segment of the super string.

When E snap is on:
(a) you can only pick on the extrusion itself and not the spine.

(b) P snap picks vertices of the 2D section at the beginning and the end of the super string
segment

(c) L snap picks on the lines on the extrusion created by a point on the 2D section as it is swept
along the super string spine.

(d) F snaps picks on the surface of the extrusion

-

Extrusion "\

Closed 2D cross section
with a hole that is extruded ¥
along a super string /2
. lines on the extrusion 7/ /2
> % 4
7 L
d 7
/ /
P ’/ / / /
4 / g
7/ g %
x denotes vertices on the 2D section 7 4
\ and on the ends of the Extrusion /

Continue to 2.6 AutoUpdater for 12d Model 15 or return to 2 General ltems.
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2.6 AutoUpdater for 12d Model 15

For 12d Model 15, there is a new background service on your computer called 12d Model
Updater Service that removes the requirements that Administrator rights are needed for
subsequent installs.

When implemented, the 712d Model Updater Service checks for newer versions of
12d Model 15 and can automatically download and install the new version.

You can set whether the installation exe is automatically deleted after the installation, or it is left
in case you want to use it for a manual install at a later time.

The installation exes are downloaded to a default folder but this can also be changed to the
folder you want.

Installing the 12d Model Updater Service and setting up the AutoUpdater is done automatically
if 12d Model Update Service is left ticked when the Adminstrator installs 72d Model 15: See
31.2.2 Installers for 12d Model.

!.m

Select components

Select the components you would like to install w

ﬁ:k 12d Model Updater Service to enable
\ auto-installing of future versions of 12d Model 15

12d Model & N~
12d Model Updater Service
Courses and Training

CodeMeter Runtime

Microsoft Runtimes

¥ Microsoft Visual C++ Redistributable 2005

Microsoft Visual C++ Redistributable 2008

Microsoft Visual C++ Redistributable 2010

Microgsoft Visual C++ Redistributable 2012

Microsoft Visual C++ Redistributable 2013

Microsoft Visual C++ Redistributable 2015 2017 2015 =

EEER

B

AEEREER

< Back Mext > Cancel

This creates a background service on your computer that has Administrator rights, and each
time 712d Model 15 is started, it checks if a new version is available and if so, asks if you
would like it to automatically download and install the new version.

The 12d Model Update Service remembers the answers made during this installation and
apart from the Microsoft Redistributables that are only needed to be installed once, reuses
the answers for any future installation made by the 12d Model Update Service.

After these steps are done, each time 12d Model 15 is started a check is made to see if a newer
version of is 12d Model 15 available. See 2.6.1 12d Model AutoUpdater in Action.
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2.6.1 12d Model AutoUpdater in Action

Once the 12d Model Updater Service (background task TDUpdaterService) is running on the
computer, each time 12d Model 15 is started, or the option Help =>Check for updates is run, a
check is made to see if a newer subversion of 712d Model available and, if one is available, the
following 12d Model Downloader panel is displayed:

W 12d Model Downloader * | Settings icon

12

12d Model Update Available

Woeuld you like to update to the latest version?

nstalled :15.0C1p [DEVELOP] INT Build 26-04-2024
Latest 15.0C7p [DEVELOP] INT Build 28-04-2024
Update Now
Later

lgnare Version

Clicking the Settings icon brings up the Settings Window:

W SettingsWindow >

Settings

Download Directory

.

C:A\Users\lee.gregon/\AppData\Local\Temph

Browse

Cl D load
eanup Downloads on ()

Delete the installation files after successful installation

The Browse button allows you to change the location that the installation file will be
downloaded to, and the Cleanup Downloads specifics if the installation file is to be deleted, or
not, after the installation is completed.

On the 12d Model Downloader panel, if Update Now is selected, the 12d Model Update
Service first checks to see if any copies of 12d Model 15 are open. If any are open then they
must be closed before the installation can take place.

For the 12d Model Downloader panel:

AutoUpdater for 12d Model 13

¥
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If Later is selected the newer subversion of 72d Model is not installed now but the question is
asked again when 12d Model is next started up, or Help =>Check for updates is selected.

If Ignore Version is selected then this subversion of 72d Model is not installed but when a
newer subversion of 12d Model is available, the question is asked again when 72d Model is
then started up, or Help =>Check for updates is selected.

If Update Now is selected, the newer subversion of 12d Model is then installed. See 2.6.1 12d
Model AutoUpdater in Action.

If Update Now is selected, the downloading of the 72d Model installer begins

12

Downloading

= b

Cancel

If any copies of 12d Model, including the 72d Model Project Launcher, are already running, the
Error - X instance(s) of 12d Model currently running panel is displayed:

Errar - 1 instance(s) of 12d Model currently runninng >

There is currently 1 instance(s] of 12d Model running from where this
wersion is going to be installed,

Please close them now to prevent interuption during the installation
process,

Pressing OK closes the panel but once the download is finished, if there are still copies of
12d Model running then the message will appear again.

Once the download is complete and all instances of 712d Model closed, the AutoUpdater will
proceed with the installation and posts the message Please wait while installing...:

AutoUpdater for 12d

¥
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12

Installing

Sasc walt whiie 1=d Wod

Show Details

Because the 12d Model Update Service is doing the installation, there are no questions to
answer as they are remembered from when 712d Model was installed by the Administrator.

During the installation, the 712d Model icon is deleted from the screen but it is replaced before the
installation ends.

Once the installation is completed, the message "Install has completed successfully” is
displayed.

Show Details Finish

Click on Finish to remove the panel.

NOTES

1. The installation exe downloaded by the AutoUpdater is given a name with the date (in the
form dd_mmm_yy) as part of the name.

2. The AutoUpdater remembers the location for the downloaded installation exe, and if the
installation exe is to be deleted or not, after the installation finishes.

Both of these can be modified at any time by clicking on Settings icon on the 12d Model

Downloader panel that comes up when 72d Model starts up, or by selecting Help =>Check for
Updates.

AutoUpdater for 12d Model 13
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2.7 Time Warning When NOT a Release Version

If your version of 12d Model 15 is NOT a Release Version then the version will only run for a
maximum of three months from the date that the version was built.

i Special Build Expiry Warning x

Date expires is 2018-10-21 21:02:37

Days remaining are 122 days 6 hours 58 minutes 37 seconds

The only way to continue running after the three months has expired is to install full Release
version or non Full Release version that was built in the last three months.

Non Release versions include Alpha versions, Beta versions, Technical Release versions, INT
versions, Develop versions and Ad Hoc versions.

Page 50 Time Warning When NOT a Release Version
/ /




What’s New in 12d Model 15

2.8 Active Tab Coloured Blue

With Microsoft changes over time, what tab on a panel is actually the highlighted tab has
become very hard to determine and so for 72d Model 15, the active tab is highlighted in blue.

i Survey Data Reduction Function - d

Function name | ﬂ
Default model | J

Report file active

-

LS

v
Report indent XML v

v
v
Repaort type [12d Report Format ﬂ

| ]

| hd
Geodetics ] Others ] Extra l Laa, ] LS8, Diray l Attachments ]
Field Files | Map File ] Libraries ] Advanced ] Traverse

File |Attachment
Wil dcard(s)

|'h-?|_l

Active Tab Coloured Blue
' f
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2.9 Options Log Files Saved & Emailed to 12d

This was introduced in 12d Model 14.

Whilst 712d Model is running, a log of each option used in the session is written to a temporary
file Options.txt in a subfolder of % TEMP%\12d.

At the end of the 72d Model session, the options log file is stored on your computer, and also
emailed back to 12d Solutions at the end of the session.

If a crash occurs, this log file is included in the Crash email that is sent back to 72d Solutions.
These options log files have proved to be invaluable in helping to find crashes.

IMPORTANT NOTE:

To turn options logging off and NOT EMAIL the log file back to 12d Solutions, set the env
variable USE_OPTIONS_LOGFILE_4D to 0.

The log file is stored in the folder options_logs in the working folder for the last project used.
The options log file is renamed to give it a unique name in the folder.

The information that is recorded in the options log file and sent back to 712d Solutions includes:

Microsoft User name:

12d Model Client name

Hardware lock used:

Full path name of the 72d Model project.
Path to the 72d Model executable

12d Model version

and
a line of detail each time an option is used
the number of times certain modules were used in the session.

When you exit 12d Model or have a crash, the options log for that session is emailed to
12d Solutions.

As the number of logs can build up over time, there is an option to delete unwanted options log
files from the options_logs folder in the working folder of a project.

IMPORTANT NOTE:

To turn options logging off and NOT EMAIL the log file back to 12d Solutions, set the env
variable USE_OPTIONS_LOGFILE_4D to 0.
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2.10 Preventing Open GL Views

At times graphics drivers for a graphics card may be shipped with bugs in their OpenGL routines
and they may be so bad as to prevent 12d Model from even starting up when there is an existing
OpenGL view in the project.

The environment variable ALLOW_OPENGL_VIEWS_4D has been introduced to allow users
with problems with their graphics cards that cause regular crashes with OpenGL views, to run
12d Model by replacing OpenGL views by non-OpenGL views.

If set to 0, the environment variable ALLOW_OPENGL_VIEWS_4D will

(a) stop OpenGL Plan and OpenGL Perspective views from being created.

(b) if OpenGL Plan and OpenGL Perspective views already exist in a project, they will be
replaced by Plan and Perspective views respectively on opening the project.

ALLOW_OPENGL_VIEWS 4D  value 0 or 1

If 0, then any Perspective OpenGL views are only opened as Perspective views, and any
Plan OpenGL views are only opened as Plan views.

If 1, then Perspective OpenGL views are opened as OpenGL Perspective views, and any
Plan OpenGL views are opened as OpenGL Plan views. That is, the standard behaviour of
12d Model

The default is 1.

2.11 Outputting Missing Super Tin Components

In all write 12d Solutions Data panels, there is a new tick box Output missing super tin
components.

If the box is ticked then for every super tin in the data source, 712d Model will write out all the
super tin components, even if they are not included in the data source.

The default for this tick box is not ticked.
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2.12 Trimeshes and Drafting Elements Working
with Polygon Choices in Source Boxes

Trimeshes and drafting elements are new type of elements in version 11. Since they are not
strings, there are some conflicting ideas about the definition when they are in/fout/cutting
polygons.

In version 15, we enable some simple logic rules to define the relationship of trimeshes and
drafting elements relative to source boxes polygon.

A trimesh is inside a polygon if all its vertices are inside the polygon. A trimesh is outside a
polygon if all its vertices are outside the polygon. A trimesh with some vertices are inside and
some vertices are outside a polygon is call cutting the polygon.

Note that the above definition does not take into account of trimesh edges and faces. Hence a
trimesh inside a polygon might have part of some edges or faces being out of the polygon -
similar things happen with the outside definition.

Since some drafting elements might use paper-size or device-size similar to texts; the interaction
of those with polygon choices in source boxes will have additional problem as texts,

Two typical examples

Example 1: Global change panel.

Using lasso will pick up trimeshes and drafting elements.

Example 2: Flip trimeshes faces panel.

The data source for trimesh in v15 will be a full one (with polygon choices and filters enables).

2.13 Additional Items for Attribute Manipulator

More 12d Model element properties have been added to the attribute manipulator so that the
properties can be set using attributes and the attributes can be created using properties.

Some additions are:
1. Water link name (segment property)
2. Water node name (vertex property)

3. Internal, external diameter of round pipe for super string, super alignment (string or segment
property)
4. Thickness of round pipe for super string, super alignment (string or segment property)

5. Internal, external width of culvert (rectangular pipe) for super string, super alignment (string or
segment property)

6. Internal, external height of culvert (rectangular pipe) for super string, super alignment (string
or segment property)

7. Left, right, top and bottom thicknesses of culvert (rectangular pipe) for super string, super
alignment (string or segment property)

8. Segment bearing for string (segment property)

9. Segment grade for string (segment property)

Page 54 imeshes and Drafting Elements W
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3 Starting Up

This chapter contains information about how to start 12d Model, organising 12d Model error
logging and how to run chains and macros when starting up 72d Model.

See
3.1 12d Model Start Up Icon
3.2 Project Launcher
3.3 Organizing Working Areas
3.4 Project Shortcuts
3.5 Creating Project Shortcuts by Hand
3.6 Environment Variables Shortcut
3.7 Error Logging File
3.8 Running Macros and Chains on Start Up

3.1 12d Model Start Up Icon

When 712d Model is installed, the 72d Model 15 icon is created.

12d bdaodel 15
- 64 Bit

\_icon for 12d Model 64 bitexe /

The 12d Model icon is a shortcut to start 72d Model and then attach to the folder C:\72d\15.00

Double clicking the 72d Model icon starts 712d Model and brings up the Project Launcher panel (3.2
Project Launcher).

12d Model Start Up Icon
|

/
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3.2 Project Launcher

The Project launcher panel is used to access existing 712d Model projects and create new projects.

P Project Launcher - *

§ 12d°Model"

D = ® O &

Last Opened Recent New Open Settings
3.2.1 Last Opened 3.2.2 Recent  3.2.3 Create 3.2.4 Open an 3.2.5 Start-Up
Project Projects New Project Existing Project  Settings
Macro manual Youtube
Reference manual www.12d.com
K/

What's New —— . (i) ® @

Note: If there are no projects that have been previously opened, the Last Opened and Recent
icons will not appear on the Project launcher:

The icons in the bottom right hand corner open the What's New in 12d Model 15 pdf, the
12d Model 15 Reference Manual, the 12d Model section of Youtube and the 12d website
www.12d.com

Macro manual  Youtube

Reference manual www.12d.com

What's New — 3 (D = @

Clicking on the icons Last Opened, Recent, New, Open and Settings accesses the functionality of
the Project Launcher.

See

3.2.1 Last Opened Project

3.2.2 Recent Projects

3.2.3 Create New Project

3.2.4 Open an Existing Project

3.2.5 Start-Up Settings

3.2.6 Selecting a Theme Using the Theme Icons
3.2.7 Recent Projects List
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3.2.1 Last Opened Project

Clicking Last Opened opens the last 12d Model project you opened and uses the same settings as
when that project was last opened.

That is, it opens the first project in the Recent Projects list (see 3.2.2 Recent Projects).

Hovering over the Last Opened icon displays the name of the last opened project as a tool tip.

D 0o— N
- L/
O—
Last Opened Recent New Open Settings

|Open project”"Georeferencing Survey 12d 1"|
— Name of the last project opened

Continue to 3.2.2 Recent Projects or return to 3.2 Project Launcher.

Project Launcher
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3.2.2 Recent Projects

Clicking Recent accesses the Recent Projects panel which displays a list of your recently opened
projects sorted in the reverse date order of when the projects were last opened.

® close any project open in this session
d ‘and open the highlighted project

return to Project
Launcher panel

\ A g Survey (15 T Db:1514) Last access: 23-10-21 16:42:13 f
@ o C\12d\15.00Mraining\design\getting started basic\Survey'. @
Refresh the \A @ o New New Project (15 T Db:1514) Last access: 23-10-21 16:41:04
1 1 ? CA\12d\Project\Mew Project’ .
project details = . ta\ k \{:sje'; ;::s;j:i\ t 23-10 open anew instance of / @
o nKs ast access - -
8] o C\2d\Project\Tanks\ 12d Model for the
. . = o dam (14 X Db:1427) Last access: 23-10.2highlighted project
icon ShOWlng | / =] g CA12d414.000 courses'testh,
project theme | A\ o Dam (15T Db:1514) Last access: 23-10-21 16:34:21
g o C\12d\Project\Dam\ \ . o
project name and version
Q ° Not found: Sruvey
o C\12d\15.00\raining\design'getting started basic\5n |
| 72\ o  Survey (15T Db:1514) Last access: 23-10-21 16:18:0 working folder of project
click on the ! op  C:\12d\Project\Surveyh,
Theme icon to /
change the
Theme

\ click to bring up extra options for project ONO) ® @

For each project in the Recent Projects list, there are two icons and two lines of information about
each project.

I— dam (14 X Db:1427) Last access: 23-10-21 16:36:07
L2l 3 c12d14.00\coursesitesty

M AR T R ARAAN L . mm oAm M As mA A

(a) On the left is an icon displaying the Theme being used for the project.

Clicking on the Theme icon brings up a panel to change the Theme, Environment
configuration and the Dongle for the project. See 3.2.2.1 Change Theme.

o
(b) In the middle is an icon o that when clicked brings up extra options that can be performed on
the project. See 3.2.2.4 Exira Options for the Project.

(c) On the right, there are two lines of information about the project.

The first line gives the project name, the project view, the project database number and finally
the date that the project was last accessed.

The first line is coloured to provide additional information about the project. The line is:
if the project is already open and hence locked
green if the project is a V15 Object Tree project
red if the project no longer exists

blue if the project is a V15 non-object Tree project which will need to be
migrated to a V15 Object Tree project before use
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black if the project is an earlier 12d Model version that needs to be migrated to
a V15 project

The second line gives the path of the working folder that contains the project.

Double clicking on the lines of information closes any existing project in the session and opens
the project.

When the project lines are selected (and hence highlighted), click on an Open icon @ or
@ , to open the project.

For documentation on the Open icons, @ and @ , see 3.2.2.3 Open and Open New Instance
Icons

Click the refresh icon % to refresh the details of the projects in the Recent Projects list.
Click the left arrow icon @ to return to the Project launcher panel.

Continue to 3.2.2.1 Change Theme or return to 3.2 Project Launcher.

Project Launcher
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3.2.2.1 Change Theme

Clicking on the Theme icon
beside the project name
displays more information
about the project and allows
the theme for the project to

be changed by selecting the
new theme from the Theme @ @ @ /i\ E&j A @ @ @ @ Eh @
Icons on tOp' Project location Gdd documentationt 12d V15 Docol12dm ref\P...
Project name MetaConnex Basics

The Environment Theme name Design

. . Theme size small (&)
configuration and the T o
dongle to be used can also R o
be changed using the '
Environment configuration
and Dongle configuration
pop-ups

ONONIE NN
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§ 12d°Model"

Design

The fields and buttons used in this panel have the following functions.

Field Description Type Defaults Pop-Up
Project location output only
Location of the working folder for the project.
Project name output only
Name of the project.
Theme name Theme select

Name of the theme for the project.
The theme can be changed by clicking on the required Theme icon just above Project location field.

BIM Design Survey Water Classic
1
SENFAREOQP D
CAD 12d Field Tin Standard Neo Classic

For more information on Themes, see 3.2.6 Selecting a Theme Using the Theme Icons.

Environment configuration and Dongle Configuration fields

The Configuration file given in the Configuration file field in the Start-up Settings panel is used for the
pop-ups for the Environment configuration and Dongle configuration fields in this panel. See 3.2.5
Start-Up Settings.

For information on the Environment configuration and Dongle configuration fields, see 3.2.2.2
Environment Configuration and Dongle Configuration fields.

If any of the fields are changed then for the changes to take effect you need to click on an Open icon

@ or @ , to open the project.

For documentation on the Open icons, @ and @ , see 3.2.2.3 Open and Open New Instance
Icons.

Clicking the left arrow icon @ returns to the Project Launcher panel but the changes will not be
displayed in the Recent project list until the refresh icon E is pressed.
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Continue to 3.2.2.2 Environment Configuration and Dongle Configuration fields or return to 3.2
Project Launcher.

Project Launcher
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3.2.2.2 Environment Configuration and Dongle Configuration fields

The Configuration file given in the Configuration file field in the Start-up Settings panel is used for the
pop-ups for the Environment configuration and Dongle configuration fields in this panel. See 3.2.5
Start-Up Settings.

Environment configuration
To tailor 12d Model, there are a large number of environment variables in a file called env.4d.

For most users, one env.4d file provides enough customisation for their site but for users with customers
requiring very different set ups, a more flexible system is required.

For example, one project may be for a Main Roads Department which requires its own mapping files,
linestyle files, ppf files etc, and another project is for a Local Authority who has totally different standards

and requirements.

For this more complex situation, different env.4d files and environment variable overrides can be defined
for each project using Environment configurations, and any number of different Environment
configurations can be defined in a Configuration file so they are easily accessible as pop-up in the
Environment configuration field.

If the project already has an Environment configuration then it will be displayed in this field.
A new value can be selected from the pop-up for this field that comes from the Configuration file.

For more information on Environment configuration settings, go to 6.10.4 Creating/Editing
Environment Configurations, and for more information on the Environmental configuration section in
particular, go to Creating/Editing an Environments Set Up.

Dongle configuration
If the project already has a Dongle configuration then it will be displayed in this field.
A new value can be selected from the pop-up for this field that comes from the Configuration file.

Dongles configuration is part of Environment configuration settings so _for more information see 6.10.4
Creating/Editing Environment Configurations and for more information on the Dongle section in
particular, go to Creating/Editing a Dongles Set Up.

Continue to 3.2.2.3 Open and Open New Instance lcons or return to 3.2 Project Launcher.
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3.2.2.3 Open and Open New Instance Icons

@ @ @ / :\ E&j ,c?oseﬁy p?ojeﬁpmn ﬁ'ﬁs session @

and open the highlighted project

Project location
Project name

Theme name

Theme size small open a new instance of ©

Environment configuration 12d Model fOl' the @

Bl sEmEie highlighted project ©
ONONIEN TN )

After filling in the details for the project to be opened, there are two icons on the right hand side of
the panel to open the project.

Click: on the:

(a) Openicon @ to first close any project opened in the current session of 12d Model, and
then open the project.

(b) Open new instance icon @ opens a new instance of 12d Model for the selected project

Continue to 3.2.2.4 Extra Options for the Project or return to 3.2 Project Launcher.

Project Launcher

|
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3.2.2.4 Extra Options for the Project

Options n

[T

Preview Info

©

Remaove  Copy

©

a 2
Move  Rename
-l

%)

> g
o &

Shortcut  Explore

J

GUID

Preview - display the preview of the project. See 3.2.2.4.1 Preview icon.

Info - display the project description. See 3.2.2.4.2 Info icon.

Remove the project from the Recent Projects list.

Copy the project and optionally copy the working folder with the project in it. See
3.2.2.4.3 Copy Project icon.

Move the project and optionally the working folder to a new folder. See 3.2.2.4.4
Move Project icon.

Rename the project and optionally rename the working folder. See 3.2.2.4.5
Rename Project icon.

Delete the project and optionally delete the working folder. See 3.2.2.4.6 Delete
Project icon.

Zip the project and optionally zip the working folder with the project in it. See
3.2.2.4.7 Zip Project icon.

Shortcut - create a desktop shortcut that starts 12d Model and opens the project.
See 3.4 Project Shortcuts.

Explore - Open Windows explorer at the working folder.

GUID - Change all the GUID filenames in the project to new GUID names.

Click the left arrow icon @ to return to the Project Launcher panel.
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3.2.2.4.1 Preview icon

Options n
EENO)
Preview Info

Clicking on the Preview icon displays the preview of the project

§ 12d°Model"

Click the left arrow icon @ to return to the Project Launcher panel.

Continue to 3.2.2.4.2 Info icon or return to 3.2.2.4 Extra Options for the Project.
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3.2.2.4.2 Info icon
Options n
=ENO)
Preview Info

Clicking on the Info icon displays the description for the project

& 12d°Model"

@ This is a test description

Click the left arrow icon @ to return to the Project Launcher panel.

Continue to 3.2.2.4.3 Copy Project icon or return to 3.2.2.4 Extra Options for the Project.
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3.2.2.4.3 Copy Project icon

Position of option on menu:  Project Launcher =>Recent =>Copy Project icon

This option copies a project to a new location. If you are attempting to copy the project you are
currently in, 12d Model will prompt you to save and restart.

Selecting CI_"'—|-| brings up the Copy Project panel:
opy

il CopyProject - >

Warking falder |Eady documentationy12d_%15_Docoy12d_ref_dum g

Project |
Target Erdd_docurmentationy12d_415_Doco'12d_ref_dum g
Include warking folder (containing project) [
Reset project id {required for sharing) [

Copry Finish Help

The fields and buttons used in this panels have the following functions.
Field Description Type Defaults Pop-Up
Working folder file
The folder containing the project.
Project
The name of the project to copy.
Target file
Where the project should copied to.
Include working folder (containing project) tick box
If'ticked, the folder containing the project (and all sub folders) will also be copied.

Reset project id (required for sharing) tick box

If you are intending to share the copied project, you must reset the ID - otherwise sharing will not be
allowed from the copied project.

Buttons at Bottom
Copy button
Copies the project.

Additional Information
Example:
if
Working folder is: "d:\4d_test\one\jobl1234"

project is: "detailed survey"

target is: "e:\4d_test\two\three"

Project Launcher
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When Include working folder (containing project) is ticked, the resulting folder will be copied from
d:\4d_test\one\job1234

to

e:\4d_test\two\three\job1234

This includes all files and folders recursively, including the nominated project.

When Include working folder (containing project) is not ticked, the resulting folder will be copied from
d:\4d_test\one\jobl234\detailed_survey.project

to

e:\4d_test\two\three\detailed survey.project

Additional checks made.

That there is sufficient disk space on the target volume.

Continue to 3.2.2.4.4 Move Project icon or return to 3.2.2.4 Extra Options for the Project.
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3.2.2.4.4 Move Project icon

Position of option on menu:  Project Launcher =>Recent =>Move Project icon

This option moves a project to a new location. If you are attempting to move the project you are
currently in, 12d Model will prompt you to save and restart.

(=
Selecting MD brings up the Move Project panel:
ove

i Mowve Project — ot

Warking folder |Eadd documentation’12d_415_Docob12d_ref_dum E

Project |
Target [Etdd_docurnentationy12d_415_Docoy12d_ref_dum g
Include warking folder {containing project) [
Reset project id {required for sharing) [

b e Finish Help

The fields and buttons used in this panels have the following functions.

Field Description Type Defaults Pop-Up
Working folder file
The folder containing the project.
Project
The name of the project to move.
Target file
Where the project should moved to.
Include working folder (containing project) tick box

If ticked, the folder containing the project (and all sub folders) will also be moved.

Reset project id (required for sharing) tick box

If you are intending to share the moved project, you must reset the id - otherwise sharing will not be
allowed from the moved project.

Buttons at Bottom
Move button

Moves the project.

Continue to 3.2.2.4.5 Rename Project icon or return to 3.2.2.4 Extra Options for the Project.

Project Launcher
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3.2.2.4.5 Rename Project icon

Position of option on menu: Project Launcher =>Recent =>Rename

Project =>Utilities =Rename
The Rename option is used to rename any project (other than the current project) in a given folder (a
working folder), and if required, the contents of the working folder as well.

U S : .
Selecting £~ brings up the Rename Project panel:

Rename

i Rename Project — by

Warking falder |Eadd documentation’12d_415_Docoy12d_ref_dum E

Project |
MNewr narme | @
Renarme working folder {containing project) [

Renarme Finish Help

For documentation, see 6.13.7 Rename Project.

Continue to 3.2.2.4.6 Delete Project icon or return to 3.2.2.4 Extra Options for the Project.
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3.2.2.4.6 Delete Project icon

Position of option on menu: Project Launcher =>Recent =>Delete Project icon

This will delete a project. This cannot be the current open project.

Selecting D|1| brings up the Delete Project panel:
1=

elet

i Delete Project — *

Warking falder |Eadd documentationt12d_15_Docoy12d_ref_dum E
Froject |

|
Delete| Finish Help

The fields and buttons used in this panels have the following functions.
Field Description Type Defaults Pop-Up
Working folder file

Folder containing the project to be deleted.
Project

Name of the project to delete.

Buttons at Bottom
Delete button

Delete the project.

Continue to 3.2.2.4.7 Zip Project icon or return to 3.2.2.4 Extra Options for the Project.

Project Launcher
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3.2.2.4.7 Zip Project icon

Position of option on menu:  Project Launcher=> Recent =>Zip Project icon

Position of option on menu:  Project =>Open=> Zip Project icon

This option zips a project. If you attempt to zip the current project, 712d Model will prompt you to
save and restart.

Selecting I;El brings up the Zip Project panel:
ip

i Lip Project - =

Warking folder |Eadd documentationy12d_v15_Docoy12d_ref_dum E
Project |
Tip file |

Delete existing zip file

Include directory containing project

g 11 9|P [

Exclude zip files

l
dip Finish Help

The fields and buttons used in this panels have the following functions.

Field Description Type Defaults Pop-Up
Working folder file box

Folder where the project resides.

Project project box

Name of the project you wish to zip.

Zip file file box
The file to zip to.

Note:

If a folder path is provided along with the zipped file name the project will be zipped to that location on
the PC.

If no folder path is provided with the file name the zipped project will be saved to the "C:\12d\XX.00\"
location by default. XX is the 12d Model major version.

Delete existing zip file tick box

If ticked, any existing zip file will be deleted.

Include directory containing project tick box
Ifticked, the directory containing the project (the working directory) will also be zipped, along with all sub
folders.

Buttons at Bottom
Zip button
Zips the project.

Continue to 3.2.3 Create New Project or return to 3.2.2.4 Extra Options for the Project.
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3.2.3 Create New Project

Clicking on New displays the Create New Project panel which is used to create a new 712d Model 15
project.

"W Create New Project — X

@ 12d® Model

Standard

Project location c\12d415.00 (] @
Project name A
Create working folder yes
Theme name Standard
Theme size ©
Environment configuration @
Dongls configuration @
ONORNIEN N
The fields and buttons used in this panel have the following functions.
Field Description Type Defaults Pop-Up
Project location folder box

Folder location for the new project.

The field will initially be filled with the Default project location field from the 3.2.5 Start-Up Settings
panel (which may be blank).

Project name text box
Name of the new project.
Create working folder tick box

If ticked then a folder of the same name as the Project name is created in the Project location and the
project is created inside that folder. In that case the working folder and the project will have the same
name.

If not ticked then the project is created in the Project location. In that case, the working folder is the
Project location.
Theme name Theme select

Name of the theme for the project.
The theme can be selected by clicking on the required Theme icon just above Project location field.

BIM Design Survey Water Classic
CAD 12d Field Tin Standard Neo Classic

For more information on Themes, see 3.2.6 Selecting a Theme Using the Theme Icons.
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Environment configuration and Dongle Configuration fields

The Registry file given in the Registry file field in the Start-up Settings panel is used for the pop-ups for
the Environment configuration and Dongle configuration fields in this panel.

For information on the Environment configuration and Dongle configuration fields, see 3.2.2.2
Environment Configuration and Dongle Configuration fields.

After filling in the details for the project to be opened, click on an Open icon @ or @ , to open
the project.

For documentation on the Open icons, @ and @ , see 3.2.2.3 Open and Open New Instance
Icons

Click the left arrow icon @ to return to the Project Launcher panel without creating a new
project.

Continue to 3.2.4 Open an Existing Project or return to 3.2 Project Launcher.
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3.2.4 Open an Existing Project

Clicking on Open allows brings up the Open Existing Project panel that allows you to open an
existing 72d Model 15 project.

P Open Existing Project - *

OQHE/NFARO QP 22 a2 ©

Project location c\12d\15.00 O

Project name

Theme name

Theme size small open a new instance of 724 ©
Envirenment configuration Model for the pl'()j ect @
Deongle configuration @

OCOEH®®

The fields and buttons used in this panel have the following functions.

Field Description Type Defaults Pop-Up

Project location folder box

Location for the project to be opened.
The field will initially be filled with the Default project location field fiom the 3.2.5 Start-Up Settings
panel (which may be blank).

Project name project box projects in Project location
Name of the project to be opened.
Theme name Theme select

After a project is selected, the name of the Theme for the project is displayed in this field.
A new theme can be selected by clicking on the required Theme icon just above Project location field.

BIM Design Survey Water Classic
y 1

SBE/NGFARE O QP
CAD 12d Field Tin Standard Neo Classic

For more information on Themes, see 3.2.6 Selecting a Theme Using the Theme Icons.

Environment configuration and Dongle Configuration fields

The Registry file given in the Registry file field in the Start-up Settings panel is used for the pop-ups for
the Environment configuration and Dongle configuration fields in this panel.

For information on the Environment configuration and Dongle configuration fields, see 3.2.2.2

Project Launcher:
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Environment Configuration and Dongle Configuration fields.

3.2.2.2 Environment Configuration and Dongle Configuration fields.

Atfter filling in the details for the project to be opened, click on an Open icon @ or @ , to open
the project.

For documentation on the Open icons, @ and @ , see 3.2.2.3 Open and Open New Instance
Icons

Clicking the left arrow icon @ will return to the Project Launcher panel without opening a project.

Continue to 3.2.5 Start-Up Settings or return to 3.2 Project Launcher.
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3.2.5 Start-Up Settings

Clicking on Settings displays the Start-up Settings panel.

PP Start-up Settings - *

@ & E] B S8 «——— Abouticon @
Default project locatio ()
Configuration file c\12d\15.00user\env_configs.4d O
Default environment configuratio ©

mfagurati ©
©

Configurations icon

OCOEH®®

The fields and buttons used in this panel have the following functions.
Field Description Type Default
Configurations icon

Default project location  folder box

Common location where 12d Model projects are stored.

If not blank, the folder in the Default project location field will be used in the Project location field on
the 3.2.3 Create New Project and 3.2.4 Open an Existing Project panels. 3.2.4 Open an Existing
Project.

Configuration file folder box $USER\env_configs.4d

If a Configuration file is selected then it is used for the pop-ups for the Default environment
configuration and Default dongle configuration fields in this panel and for the pop-ups for the
Environment configuration and Dongle configuration fields in other panels in the Project Launcher.

Default environment configuration

A value can be selected from the pop-up for this field (the pop-up is taken from the Configuration file.
This value will be used as the default value in the Environment configuration fields in the Project
Launcher.

Default dongle configuration

A value can be selected from the pop-up for this field (the pop-up is taken from the Configuration file.
This value will be used as the default value in the Dongle configuration fields in the Project Launcher.

For information on the Environment configuration and Dongle configuration fields, see 3.2.2.2
Environment Configuration and Dongle Configuration fields.
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Default theme

The Theme to use for a new project.

Default theme size

The size of the Theme to use for a new project.

12d Model Reference Manual

After filling in the any of optional setting for the Configuration file, Default environment configuration
and Default dongle configuration fields, click the tick icon @ to save the settings.

Click the left arrow icon @ to return to the Project Launcher panel.

nodes.4d editor icon

Clicking on the nodes.4d editor icon brings up the Installing a 12d Model 15 Nodes File panel

‘ﬂ Install 3 12d Model 13 Modes File

Install  Manage

Source: |
Operation: Prepend
Destination: |c:'-.12c| \15.004nodes 4d

dongle.4d editor icon

Install Cancel

Clicking on the dongles.4d editor icon brings up the Installing a 12d Model Nodes File panel

P Donglesdd Editar — *
Delete ﬂﬂ
Codemeter Local Type Codemet..,
Cloud Codeheter Mame Codermet..
Cod " ) Active true w

oderneter MNetiar Eilter B
Wibu Local # retries 0

Wiait time (seconds) a

Miérite Finish

Help

Click the left arrow icon @ to return to the Project Launcher panel.




About icon

Clicking on the About icon changes to the About information
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il Start-up Settings

Application
Build number
Path

User

Finger print

oo

(]
8o
12d Model 15.0C1b Build 24-01-2022
15.1.2.52
C\Program Files\12d\12dmodel\15.00\nt.x64\12d.exe
fred

346F-EF9B-F167-CAD9-7750-9B2-1DCF-2410

Copy to Clipboard

OCOEH®®

Copy to Clipboard icon

Clicking on the Copy to clipboard copies the information on the panel to the clipboard.

Click the left arrow icon @ to return to the Project Launcher panel.

Continue to 3.2.6 Selecting a Theme Using the Theme Icons or return to 3.2 Project Launcher.
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12d Model Reference Manual

3.2.6 Selecting a Theme Using the Theme Icons

Page 80

For some options, the available themes are displayed as a toolbar of icons.

BIM Design Survey Water Classic
1
SENFAROQDP D
CAD 12d Field Tin Standard Neo Classic

To select a Theme from the toolbar of icons, simply click on the icon for the required theme. The
selected theme will then be displayed with a bar below the theme icon.

For example, in the above image, Design has been selected.

The Classic theme uses the same top menu arrangements, icons and size of icons (16x16 pixels),
that is used in 12d Model 14. All options appear in the Classic theme.

The Neo Classic theme uses the same top menu arrangements as in Classic except the icons are
the new icon in 16x16 pixels.

The Standard theme uses the same top menu arrangements as Neo Classic but the size of the
icons can be selected as small, medium, large and extra large. The small size is slightly larger
than for 72d Model 14 and Neo Classic so that they can have more detail in the icons.

The BIM, CAD, Design, 12d Field, Survey, Tin and Water themes each have a different top menu
structure and tool bars that are more tailored to the type of work being undertaken. This means that
many options will not appear in some Theme menus but all the available options can still be found
using the Search Bar, or by changing back to the Neo Classic, Classic or Standard themes.

Continue to 3.3 Organizing Working Areas.

Continue to 3.2.7 Recent Projects List or return to 3.2 Project Launcher.
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3.2.7 Recent Projects List

The list of recent projects is shared between all versions of 12d Model.and is recorded in the file
"Recent Projects.4d" stored in the folder %APPDATA%.

The maximum number of entries stored in "Recent Projects.4d" is controlled by the environment
variable RECENT_PROJECTS_4D,

Note:
To access %APPDATA%., type %APPDATA% into Microsoft’s File Explorer and press <Enter>.

| Iﬂ = | Roaming

Home Share View
3, Cut {75 New item - 0 Open
L] X - v

w.| Copy path -T__'| Easy access = Edit
Pinto Quick Copy Paste Move Copy Delete Rename Mew Properties .
access |#]| Paste shortcut to to - folder - History
Clipboard Organize Mew Open
= ~ 4[] %appDATAY
-
12dm_ref ~ Mame Date modified Type

Continue to 3.3 Organizing Working Areas or return to 3.2 Project Launcher.
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3.3 Organizing Working Areas

For each project,72d Model creates a unique sub-folder of the working folder with the name
consisting of the project_name followed by .project. For example, for the project Olympic, and
folder called Olympic.project is created.

This sub-folder (Olympic.project) is called the project area. All the internal 12d Model information
for that project is kept inside the project area.

All outputs, reports and plots are written to the working folder (the folder containing the project) and
are not held inside the project area.

Hence to get a complete backup of the project and all associated information, it is best to backup
the entire working folder.

The project name, which can be up to 256 alphanumeric characters and can include spaces, must
be unique within the working folder but other folders may include 72d Model projects with the same
name - these projects are distinct and are not related in any way.

There is no limit to the number of projects in a particular working folder but because all the outputs,
reports and plots for each project in the same working folder would be mixed in together, it is
recommended to have each project in its own working folder. That way the inputs files, output
files, plots, reports etc. from the separate projects do not end up in the same working folder. Each
separate working folder can then be easily backed up.

As an example, if three unrelated projects - olympics, airport, and dam - are to be created in a folder
called 12d jobs, it is suggested that the project olympic is created in a sub folders of 12d jobs
called olympic, dam is created in a sub folders of 12d jobs called dam and airport is created in a
sub folders of 12d jobs called airport.

am

working folders olympic n airport

olympic.project airport.project
project folders dam.project [_j

To help users adhere to this convention, when creating new projects, there is a Create working folder
tick box which if ticked, will first create a folder of the same name as the project being created and
then create the project in that folder.

Continue to 3.4 Project Shortcuts.

Continue to 3.4 Project Shortcuts or return to 3 Starting Up.
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3.4 Project Shortcuts

A | [

Shortcut | Explore

R

The list of most recent projects makes it very easy for 712d Model operators to get into their projects.

However if there is a folder of projects, or even a particular project, that a user wants to get into by
simply double clicking on an Icon on the screen, then a Windows shortcut can be used to do it.

The easiest way to create the Windows shortcut is to

(a) first make sure that the project is in the recent projects list. To do this, just open up the project
and then exit 72d Model.

(b) start up 12d Model again by clicking on the 72d icon on the desktop,

(c) highlight the project in the recent projects list and select the icon for Shortcut on the right
hand side of the project list.

This will create a shortcut on the desktop with the name of the project, and the shortcut is set to
open up the project when the icon is double clicked.

B, 12d° Mode

_ }g\ ° Survey (15 T Db:1514) Last access: 23-10-21 16:42:13
@ o CA\12d\15.00training\ desic
o  Mew N options E3° T Db:1514) Last access: 23-10-21"
click to bring up @ g CA12d\ E @ st
the extra options
for the project F 2 t;::';:& Preview  Info | Last access: 23-10-21 16:40:24
=] :
— H dam (” @ I_"'—I.I Last access: 23-10-21 16:36:07
2] 8 cataqy Remove Copy
then click on the' /:\ = Dam (' rI-fl ﬁ Last access: 23-10-21 16:34:21
Shortcut icon ! o CA\12d\f Move Rename

Z\ g Nﬂ‘tfﬂ‘ '?' E

w Delete  Zip T _ _ .

_ o Survey 4) Last access: 23-10-21 16:18:07
= 1&1\ o  CAl2d\i ~ | [

Shortcut | Explore

)
GUID
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To see what has been created
with the new 72d Model icon,
highlight the icon and click RB
to bring up the icon menu and
then select Properties and click
on the Shortcut tab

i
Security Details Previous Versions
General Shortcut Compatibility
™ Diam
A
Target type: Application
Target locationy

Garget: ) (‘ B4 12d exe” "C:'-.12d'-.F‘rc'ject'-.Dam'-.Dam.project"D

@art in:

Shortout key: ‘ Mone

‘C A12d Project Dam

Run: Maximized -
Comment: ‘12[) Madel Project ‘
Open File Location Change lcon... Advanced. ..

QK Cancel Apply

E; Run as administrator

[ Edit with Notepad++
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Open file location

) Share with Skype
Upload to 12d Synergy
Troubleshoot compatibility

Pin to Start
7-Zip p
CRC SHA "

Pin to taskbar

Restore previous versions

Send to >

Cut
Copy

Create shortcut
Delete

Rename

roperties

Target: has the path
to 12d.exe

And as well as the
path to 12d.exe,
Target: has
optionally

(a) a full path name
to an existing project
(including the project
name) and this is
opened when the
icon is clicked

OR

(b) just the name of
an existing project
and this must be in
the folder given in
Start in: and it is
opened when the
icon is clicked

Start in: is used as
the working folder
when no full project
path is given in
Target:

Continue to 3.5 Creating Project Shortcuts by Hand or return to 3 Starting Up.
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3.5 Creating Project Shortcuts by Hand

Creating an icon to open up in an existing 12d Model project can also be done by hand by copying
a 12d icon that is already on the screen, and then renaming the copied icon to the name of the
project (say survey).

To display and modify the B pen

properties of a 12d desktop Upeui ety

icon, click RB over the 12d icon ® Run as administrator

and select Properties from the Q Share with Skype

menu. Upload to 12d Synergy
Treubleshoot compatibility

Then click on the Shortcut tab Pin to Start
7-Zip -
CRC SHA >

[of Edit with Notepad++
Pin to taskbar

Restore previous versions

Send to ¥

Cut
Copy

Create shortcut
Delete

Rename

Properties

The Properties for the icon survey is then modified by changing what is in the Target: box and
maybe the Start in: box.

To display and modify the properties of a desktop icon, click RB over the 712d icon and select
Properties from the menu. Then click on the Shortcut tab

The Properties for the icon survey can now be modified to:

(a) open an existing project by giving the full path name

If an icon is to open a given project, then the full path to the projects (including the project folder
name) in given in the Target: field after the path to the 12d exe.

For example, if the 12d Model project survey was in the folder "12d jobs\survey ", set the Target:
for the icon survey to:

"C:\Program Files\12d\12dmodel\15.00\nt.x86\12d.exe" "C:\12d jobs\survey\wurvey.project"
The icon survey would then automatically open up the project
C:\12d jobs\survey\survey.project

Note that if the path name for the project in Target: contain spaces, then it must be enclosed in
double quotes (").

If the survey icon was double clicked on, it would now open the project survey.
The Start in: is ignored.
(b) open an existing project given in the Start in: field

Another way that an existing project can be opened is that if a project such as survey already

Creating Project Shortcuts'by Hand
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exists in the folder given by the Start in: field, then in the Target: field, the project name is added
after the path to 12d. exe.

For example, the Target:
"C:\Program Files\12d\12dmodel\15.00\nt.x86\12d.exe"  survey
would automatically open the project survey in the Start in: folder of the shortcut.

So Target: and Start in: are used to obtain the existing project to open whereas in (a), only
Target: is used.

Note that if either the path names for the Target: or Start in:, or the project name contain
spaces, then they must be enclosed in double quotes (").
A Note on Target: Field

The Target: field is actually a command line to use when starting up 72d Model. For more
information on what can be done in such a command line, see 32.7 Arguments When Starting 12d
Model in Appendix 32 Setting Up and Configuring 12d.

Continue to 3.6 Environment Variables Shortcut or return to 3 Starting Up.

3.6 Environment Variables Shortcut

Page 86

If a file of 12d Model environment variables has been set up by the user (see 31 Environment
Variables in Appendix 32 Setting Up and Configuring 12d), then instead of setting the environment
variable ENVIRONMENT_4D to point to the file or setting it up with the default name, env.4d, the
environment file can be passed to 12d Model using the Target of the icon properties.

For example, the Target:

"C:\Program Files\12d\12dmodel\15.00\nt.x64\12d.exe" -env F:\12d\env.4d
would fire up the 64-bit 12d.exe using the file of environment variables called F:\12d\env.4d

The Target:

"C:\Program Files\12d\12dmodel\15.00\nt.x64\12d.exe" -env F:\12d\env.4d airport

would fire up the 64-bit 12d.exe using the file of environment variables called F:\12d\env.4d and
also automatically open the project airport in the Start in: folder of the shortcut.

Again if any of the path names contain spaces, then they must be enclosed in double quotes ().

The Target: field is actually a command line to start up 12d Model. For more information see 32.7
Arguments When Starting 12d Model in Appendix 32 Setting Up and Configuring 12d.

Continue to 3.7 Error Logging File or return to 3 Starting Up.
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3.7 Error Logging File

When 12d Model starts up, it tries to create an error logging file, called
logxxxxx.4de

where xxxxx is a hashed number using your login name, process id & the current time.

When 12d Model terminates, the error log file is deleted if no errors were logged.
The folder that the error log file is created in is given by the environment variable LOG DIR_4D.

If LOG_DIR 4D is not used,72d Model tries to create the log file in the current folder, the HOME
folder, the TMP folder and the TEMP folder.

If creating a error log file fails in all these areas, 12d Model will not start up. This should never
happen.

Continue to 3.8 Running Macros and Chains on Start Up or return to 3 Starting Up.

3.8 Running Macros and Chains on Start Up

To allow for tailoring 72d Model when a new project is created or an existing project opened,
12d Model can be set up to run user supplied files of macros and/or chains both for new projects or
when an existing project starts up.

For more information see 32.6 Running Macros and Chains on Start Up.

Continue to 3 Tools and Concepts or return to 3 Starting Up.

Error Logging File
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4 Tools and Concepts

There has been changes to the Tools and Concepts chapter in the 12d Model Reference manual.
See

4.1 Attribute Data Panel

4.2 Polymesh

4.3 Border and Border Style

4.4 Panel Fields

4.5 Options Search Bar

4.6 Select for Model, Tin, Template, Function, Name Boxes & Views

4.7 Chainage Equalities

4.8 Sharing of Models and Tins

4.9 Enabling Long Paths in Windows

4.10 Migration of Projects From Command Line

4.11 Startup Information in Output Window

4.12 Comparing Attribute Data

4.13 Writing XSLT Files
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4.1 Attribute Data Panel

In many options when attributes are to be defined, the Attribute Data panel is displayed. Or similar
panels with the name of the Object having attributes added to it. For example, Project, or Model, or
String.

The Attribute Data panel can create and edit attributes.

On the left hand side of the panel, the attribute groups are displayed as the nodes on a tree
structure.

The attributes for a highlighted group (node) on the left hand side are displayed on the right-hand
side of the panel,

When no attributes exist for an object, the Attribute Data panel just shows the [Top] node of the
attribute tree.

ke Add -

+ [T Top] W A

Oy - 5ub Copy Attribute | ype | Value + / Insert

2] Paste 1|Sample  Text A bit of text T above
2 | Index Integer 1 + |<g— Insert

J. | €——— Merge 3| Weight Real 1.5 : below

& -€—— Replace 4 | Sub Group " \ Move up

LD | <«——— Insert

/> | <«—— Copy path E:ii: E‘E': Move down

T | @——— Moveup Delete—» [#]

Y | <«——— Move down Search g

= | <¢——— Delete Goto —p»| =

| "[Top]" selected

New attributes are added for the top level node by highlighting the node Top and then adding the
attributes to the grid displayed on the right hand side.

The attribute name is entered in the Attribute column.

The type of the attribute is entered using the pop up in the Type column.
The value for the attribute is entered using the pop up in the Value column.
Click on Set to save the attributes.

Subnodes:
Subnodes (the lower levels of the attribute tree) can be created for any node.
A subnode of an attribute node is created by highlighting it and clicking the Add icon.
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P Attribute Data — >
+ [ = [Top] Group name [Group ab)
D_l Attribute| Type | Value —+
£ T
b ot
~ 4y
(9
subnode J
L
O
<f> :I
N |
3
4
Q
B >
| "Group" selected
Set Clear Finish Help

A subnode call Group is then created.

Any attributes for the subnode are then entered into the right hand grid that displays when the
subnode is highlighted. Clicking the Set button saves the attributes.

To change the name of the subnode Group, you need to either edit the Group name box and click Set
or you need to click on the node above it where 'Group' will be displayed as an attribute of type
Group. Under the Attribute column, change Group to the new name and then click Set.

The subnode will then be displayed with the new name.

P Attribute Data —

= [Top] Group name |pn|e

Attribute | Type | Value

g 0> m O 4+

A

!

o

-

e
VOEM@O€ >+ A+ ~

B3]

| Greup name updated

Set Clear Finish Help

Attribute Data Panel

|




Attributes can be added to the new subnode
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S —
+ (= [Tl:-p] Group name [pole @
D_l Attribute| Type | Value —+
I-:-I 1| type Text wood e
R |
R g ¢
o Insert above +
Insert below e
ln Copy O
> Paste =l
Duplicate E]
T~ Delete
Copy path &
v Copy data Q
B >
| choice ok
Set Clear Finish Help
Each subnode is a node in its own right and can have attributes and subnodes.
» - -
+ | = [Top) Group name [pole @
D_l m Attribute | Type | Value -+
B wires
I-é-l i wire 1 1| type Text wood -
----- A Pr—r T .
— - - e
’: ----- wire 3 now =
o wire 4 Insert above *
™ box Insert below A
\ Copy D_l
o> subnodes Paste _
Duplicate |'=_'|
T Delete =
" Copy path
£ dat
Oy aata Pop-up menu Q
£l when RB on Y
Set the values in row number
the displayed grid
| "pole” selected
Set Clear Finish Help

The buttons used in this panel have the following functions.

Field Description

Icons on Left Hand Side
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Add icon
Create a new attribute node (sub node) beneath the highlighted attribute node.

Copy icon

Copy the highlighted attribute node into clipboard, which can be later paste, merge or insert into other
attributes across 12d Model.

Paste icon

Paste the attribute buffer to the highlighted attribute node, a new attribute is added.
Merge icon

Merge the attribute buffer with the highlighted attribute node.
Replace icon

Replace the highlighted attribute node with the attribute buffer.
Insert icon

Insert the attribute buffer as a child to the highlighted attribute node.
Copy path icon

Copy the highlighted attribute node path to clipboard.
Move up icon

Move the highlighted attribute node up the tree.

Move down icon

Move the highlighted attribute node down the tree.

Delete icon

Delete the highlighted attribute node.
Grid on Right Hand Side
Attribute

Name of the attribute.

Type i

Integer
Real

Text
Group
Uid

Guid
Integertd
Binary

Type of attribute.

Value

Value for the attribute.

Icons on Right Hand Side

Attribute Data Panel

|
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Add icon

Create a new attribute row at the bottom of the table.
Insert above icon

Create a new attribute above the currently selected row.
Insert below icon

Create a new attribute below the currently selected row.
Move up icon

Move the selected attribute rows up the table.
Move down icon

Move the selected attribute rows down the table.
Delete icon

Delete the selected attribute rows.

Search icon

Open the Find and Replace attributes panel. For information on the Find and Replace panel see 6.14.1.8
Finding an Entry the Names.4d File.

Copy icon

Copy the selected attribute rows or cell range to clipboard, which is available for 12d Model and other
software to use.

Paste icon
Paste the content of the current clipboard from 12d Model and other software (tab delimited format) to the
currently selected cells and create new attributes if the clipboard buffer has more data.

Go to icon

Go to the hyperlink specified in the "Value" field of the current row. Hyperlink can be a web address,
Synergy URL or command line argument to launch a Windows application.

Attribute row menu
Right click on selected attribute rows open the row menu.

Row 1 n

Insert above
Insert below

Copy
Paste

Delete
Copy path
Copy data

Insert above icon

Create a new attribute above the currently selected row.

Insert below icon
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Create a new attribute below the currently selected row.
Copy icon

Copy the selected attribute rows to clipboard.
Paste icon

Paste attribute data from clipboard to the selected rows.
Delete icon

Delete the selected attribute rows.
Copy path icon

Copy the attribute path of the selected attribute row.
Copy data icon

Copy attributes of the selected attribute rows to clipboard.

Buttons at Bottom

Set button

Set the values given in the current grid in the attribute tree.

Clear button

Clears out the entire attribute tree.

Continue to 4.1.1 Comparing Attribute Data or return to 4.1 Attribute Data Panel.

Attribute Data Panel
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4.1.1 Comparing Attribute Data
Two Attribute Datas are the same if each Attribute Data has:
(a) exactly the same nodes (groups) with exactly the same names
(b) each node (group) has exactly the same attributes in them

and
(c) each identical attribute has exactly the same value.

P Attribute Data B x
=+ | = [Top] Group name  [flower g
M Attribute| Type | Value
D_l YP
- 1| type Text rose T
| Text d
j 2 | celour =4 e ) .i.
P Attribute Data B x
+ = Topl Group name  [flower @
D_l M Attribute | Type Value +
I'i'l 1| type Text rose T
G colour  Text white) +

1 R

For example, the two attribute data shown above have exactly the same attribute group "flower" and
the group "flower" has exactly the same attributes "type" and "colour".

But the attribute data is not the same because the value of "colour" is "red" for one attribute data,
and "white" for the other attribute data.

Continue to 4.1.2 Accessing Attribute VValues or return to 4.1 Attribute Data Panel.

4.1.2 Accessing Attribute Values

In some options, in particular in the Map File, the actual value of a given attribute (the column called
Data in the Attribute Data panel), is specified by putting a $ in front of the attribute path name.

That is

$earth/australia/sydney/lee
refers to the actual value of the attribute given by the path name earth/australia/sydney/lee.

Continue to 4.2 Polymesh or return to 4 Tools and Concepts.
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4.2 Polymesh

The Trimesh was introduced in V11 and for V15, it has been generalised to a polymesh.

A polymesh is a 3D object that is composed of Jordan (simple) polygons (polyfaces) and
triangles. The polygons and triangles are connected to each other to form a mesh that defines the
shape. The whole shape can be open, where some edges belong to only one polygon or triangle,
or closed, where all edges belong to two polygons or triangles so that the mesh is watertight.

So a trimesh is a polymesh where all the polygons are triangles.
An example of a polymesh that is not a trimesh is a box.

[-7] Perspective OpenGL & [ | S|
Bl & =& ¢ x| @] 2| % &

The polygons that make up the polymesh are the polymesh faces and a face can be:
(a) a planar face of more than three vertices.

That is, the face is bounded by a simple polygon of more than three vertices that is in the one
plane.

Because it is in the one plane, a planar face uniquely defines the z-values of all the points
inside the bounding polygon. In 12d Model a planar face does have a triangle decomposition
but how the triangles are defined does not affect the z-values - they are all in the one plane.

(b) anon-planar face.
That is, the face is bounded by a simple polygon that is not in the one plane.

Unlike a planar face, for a non-planar face there is no uniquely defined surface within the
bounding polygon. So to ensure the 3D surface represented by a non-planar polygon is unique,
in 12d Model a non-planar face must also have a triangle decomposition to uniquely represent
the 3D surface of the non-planar face.

So in 12d Model, a polymesh is made up of triangles and polyfaces but internally, each polyface
is decomposed into triangles.

The polygon boundary of a polyface can have a name and a colour

Polymesh
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To display a polymesh on an OpenGL Perspective view, the Toggles menu on an OpenGL
Perspective view has an extra walk-right menu called Polymesh drawing that are used when
Drawing wirefame is [on].

The three toggles on the Polymesh drawing walk-right menu Polymesh Drawing Toggle are:

Polyfaces - when toggled on, the boundary polygon of any planar faces are drawn on the view. This
probably should say Planar polyfaces.

Non-Planar Triangles - when toggled on, the boundary polygon of any non-planar face, plus the
enclosed triangles of the non-planar faces, are drawn on the view. This probably should be Non-
planar polyfaces and their internal triangles.

Triangles - when toggled on, the faces that are not polyfaces are drawn on the view.

So to see all the components that are contained in a polymesh, you need all three toggled on.

In the image below, the polymesh in view 3 consists of a non-planar face on the top (cyan) and a
planar face on the bottom.

=@ =] |3 S [@ = = [@]=

JJJJJJJJIJJ&J

JJJJJJJJJJJ&JJJJJJE JJJJJJJJIJJEJ

Polyfaces [on]
Non-Planar Triangles [off]
Triangles [off]

Polyfaces [off]
Non-Planar Triangles [on]
Triangles [off]

o || B [ &R

JJJJJJJJIJJEJJ

o || B [ &R

JJJJJJJJIJJEJJ

[] Perspective OpenGL 6

JJJJ %] @] @& Pofacss o

Non-Planar Triangles [off]
Triangles [off]

Polyfaces [off]
Non-Planar Triangles [off]
Triangles [on]

Polyfaces [on]
Nen-Planar Triangles [on]
Triangles [on]

¥ Timesh from 30 Planar Polygons ~ —

Data te create from

(] = @] | g ol | 915>
s

Maodel

Use point id as vertex name

Use segment text as edge name

Use string colour as face colour

Create polymesh
—

Timesh colour [oan

Timesh model [

So in view 3 Copy 2 which has only Polyfaces turned on, you only see the bounding polygons of
the top and the bottom of the object.

In view 3 Copy which has only Non-Planar triangles turned on, you only see the bounding
polygon of the top and its triangle decomposition.

In view 3 Copy 3 with only Triangles turned on, you only see the triangles that are not polyfaces
which is how the sides of the object were constructed.

In view 3 Copy 4, Polyfaces, Non-Planar triangles and Triangles are all turned on so you can
see all the triangles that make up all the polyfaces of the polymesh.

Note: a polymesh could be converted into a trimesh but then all the polygon boundaries of the
polyfaces would be lost.

Continue to 4.3 Border and Border Style or return to 4 Tools and Concepts.
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4.3 Border and Border Style

Additional styles include:
Triangle1, Triangle2, Pentagon1, Pentagon2, Hexagon1, Hexagon1, Octagon1, Octagon2

I""..,Ipantagom

Continue to 4.4 Panel Fields or return to 4 Tools and Concepts.
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4.4 Panel Fields

See

4.4.1 Unit Conversions in Real Value Fields
4.4.2 Choice Box

4.4.1 Unit Conversions in Real Value Fields

Conversions from various distance units into metres are possible by post-fixing a valid real value
with a defined single character, these combined values can be freely used in expressions.

For example, to find the width in metres of a standard gauge railway, 4' 8 2" we need to convert the
feet and inch parts to metres and add them together.

Post fixing a value with f indicates the value is in feet, i it is in inches, (full list follows further down),
the expression first converts the values into metres then performs any operations on the resulting
values. So, the above example can be written in 2 ways, 4f + 8.5i or 4f + 8i + 1i/2.

Note how to enter fractions, for example 5/8 of an inch will be entered as 5i/8. (5/8)i is not a valid
syntax and 5/8i is actually 5 divided by 8 inches.

Due to the small differences between international, (imperial) and US feet an environment variable
TYPED_UNITS_MODE_4D controls which unit is used.

if 0, the default value, only international units are supported, for example 4f and 4F will both
represent 4 international feet.

if 1 only US units are supported, for example 4f and 4F will both represent 4 US feet.

if 2 both international and US units are supported, lower case for international units and upper
case for US units, for example 4f is 4 international feet and 4F US feet.

Units that support both international and US versions
i/l - inches
fIF - feet
ylY - yards
m/M - miles
IIL - links
¢/C - chains
p/P - perches
r/R - rods
Units that do not have US versions, the upper case version is an error and the expression will fail
k - kilometres,

n - nautical mile
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4.4.2 Choice Box

The Choice Box is for a general tool for displaying a list of items that the user can select from.

A choice can be typed in, or the list of available choices displayed in a pop-up by clicking on the
Choice icon at the right hand end of the Choice box

Being a general box, what choices are in the pop-up is different for each Choice box and are
documented for each option that includes a Choice box.

There are three different styles of Choice Boxes:
(a) Choice Box with a select field on the Select Choice pop-up

This is the most general purpose Choice Box and is used when there is a large number of
choices and depending on the application, more than one choice can be selected.

The required choices can often be more easily selected by first typing in selection criteria into a
search field and then the required choice(s) selected from the smaller list.

Searches can be by whole or partial words, and case can be ignored or not ignored.
See 4.4.2.1 .Choice Box with Search Field on Select Choice Pop-Up

(b) Select choice without a search field on the Select Choice pop-up

This is used when there is a small number of choices and so a search field is not needed.
See 4.4.2.2 Choice Box With No Search Field on Select Choice Pop-Up
(c) Older Style Choice Box

This is the original Choice box and is still used in some panels, especially when the number of
choices is very limited and only can be selected.

See 4.4.2.3 Older Style Choice Box

Note:
There are other specialised boxes such as Model box or a Tin Box that also allow users to select
from a pop-up list.

-
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4.4.2.1 .Choice Box with Search Field on Select Choice Pop-Up

This is the most general purpose Choice Box and is used when there is a large number of
choices and depending on the application, more than one choice can be selected.

The required choices are often more easily selected by first typing selection criteria into a
search field and then the required choice(s) selected from a smaller list.

Searches can be by whole or partial words, and case can be ignored or not ignored.

Choice box field \

il Clean Model =
Choice icon

Madel 12D MESH

= .
Permanently clean? search field

e

Format |keep all raster elements /
e | | o
e | P | =i keep all raster elements

confirm for individual raster element

/ confirm ocnce
Select Choice pop-up list

clean all raster elernents without confirming

K | Select V

Click on one the Choice icon at the end of the Choice Box brings up the Select Choice pop-up with
the search field at the top, followed by the list of choices satisfying the search criteria, and a Select
and possibly other buttons such as Clear, at the bottom.

Clicking on the X at the top right hand corner of the Select Choice pop-up removes it.

Clicking and dragging on the title area of the pop-up allows you to move and pin the Select
choice pop-up.

When there is a [Clear] button, clicking on it will clear what is in the Choice box field when having
no selection is allowed.

The choices above [Clear] will be different for each option.

If nothing is typed into the search field then all the choices are displayed in the pop-up list but there
is a special syntax using the characters plus (+), comma (,) and minus (-) for AND, OR and NOT
logical operators to restrict what is shown in the pop-up. See 4.6.3.6 Search Field Syntax for
Selects.

For a Choice Box with a search field, full information on the search settings Match Case, Whole
Word, Search field and on Save Selects is in 4.6 Select for Model, Tin, Template, Function, Name
Boxes & Views.

Continue to4.4.2.2 Choice Box With No Search Field on Select Choice Pop-Up or return to 4.4.2
Choice Box or 4.4 Panel Fields.
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4.4.2.2 Choice Box With No Search Field on Select Choice Pop-Up

g

Choice icon

Model |

Colour |white

Type |Line Select Choi
. — i elec oice
Linestyle |4 o0 Select Choice pop-up list
| e
Tinability |F'|:|ir1tsar1|:| segments ¥
Allow point ids B
Many strings r
Create | Same as Finish Help

Select

[Clear]
Clicking on the Choice icon will display the pop-up choice list.
As an example:

Select Choice n

Point

Select

[Clear]

Clicking on the X at the top right hand corner removes the option.
Clicking and dragging on the title area of the menu allows you to pin the menu.
Clicking on the [Clear] button will clear the current field.

For the meaning of the buttons above it, refer to the help for the specific option.

The Select button uses the current selection in the list and populates the panel field.
This style is used when the there is a large number of choices, usually greater than 26.
Double clicking on a choice, populates the panel field directly.

Continue t04.4.2.3 Older Style Choice Box.
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4.4.2.3 Older Style Choice Box

R
Choice icon

Model |
Colour  |white Select Choice pop-up list
Type |Line
Linestyle |4

| _E-F'Diﬂt

—Line

| A Clear
Tinability |Pgints and segments vl
Allow point ids [
Many strings [

Create Same as Finish Help

Clicking on the Choice icon will display the choice list.
As an example:

Select Chnicen

Point
Line
[Clear]

Clicking on the X at the top right hand corner removes the option.
Clicking and dragging on the title area of the menu allows you to pin the Select choice menu.
Clicking on [Clear] will clear what is in the Choice box field.

The choices above [Clear] will be specific to the particular choices required in an option.

Continue to 4.5 Options Search Bar or return to 4 Tools and Concepts.
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4.5 Options Search Bar

The Option Search Bar allows quick access to most options in 72d Model.

[100 [ [paired cuts new [ [ dark red LB E B =B =2 iz IE @mr @
(2] [ (%) (&) (&) (1) (7] (5] (@ (0] (@) [A) (K (M) : ), KL (2L 0L 0L [Diemeter [ [lvert [+ [01

Option Search bar | \ _,:3

search field

search icon

Clicking LB in the Search bar or on the Search icon, or typing in the Search bar, brings up the
Search for 12d Model Options panel.

Search for 12d Model Options n Search for 12d Model Options n

| & |h

120 Multi Images Attach

12d archive data [File->Data input-=12d]

12d archive data [File->Data cutput->12d]

12d design to ADAC 4.0 debug [BIM-> ADAC-= Alternate-= 1
12d design to ADAC 4.1 debug [BIM->ADAC-> Alternate-= U
12d design to ADAC 4.2 debug [BIM-> ADAC-= Alternate-= 1
12d design to ADAC 5.0 debug [BIM->ADAC-> Alternate-= U
12d Field Helmert Resection

12d Field Trimesh Edge Setout

12d Field Theme [Meo]

12d Field Theme [Project-> Thermes-» Load Themes]

12d Macro Manual [Help]

12d Model Reference manual [Help]

12d chjects [BIM-=Trimesh-= Create->From]

12d Solutions Home Page [Help-»12d on the Web]

12d survey to ADAC 4.0 debug [BIM-> ADAC-= Alternate-= 1

12d cuinvew tn ANVAC A 1 dehin [RIM-s ANAC-> Altarnate-s ] ¥
< >

Select | Select |

The Options Search bar uses key words separated by spaces and the logic operators comma
(","), plus ("+") or minus ("-") (see 4.5.1 Options Search Bar Syntax) to define the accepted
matches in the text being searched for from:

(a) the titles of the hard coded panels (i.e. not macros) that satisfy the search criteria
The full title of the panel is shown

(b) the full path names of menu items on the Main menus in the current Theme that satisfy the
search criteria

The final text on the menu is displayed followed by the full menu path name in square brackets.
(c) the name of the options in the Classic Theme that satisfy the search criteria
The final text on the menu is displayed.

So even if an option is not on any menu for the current Theme, it can still be found in the Classic
Theme.
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How matches are made is controlled by the Match case and Whole word fields that are set in the
Select Settings panel brought up by clicking on the Select Setting g3 icon:

Search for 12d Medel Options n‘/ Select Settings icon
Yelume End Area ﬁ-

End Area Volume Between Sections ~ Select Settings n

End Area Volume Between Tins B EE

End Area Volurne From Sections to a Height

End Area Volurne From Tin to a Height Match case r

End Area Violume from Tin to Sections Whole word r

End Area Volumes Case sensitive sorting -
Report from AM reference strings [Volumes-»End Area] Descending order r

Sections to height [Volurnes->End Area]
Saved Select

Sections to sections [Volumes->End Area]

Double clicking on an item in the list brings up the panel for that option.

For example, typing in the key words End Area Volume into the Search field with Whole word not
ticked will bring up the list of found options in the Search for 12d Model Options panel:

| End Area Volume ,_] J J (
| Search for 12d Model Opticns ==
- | | End Area Volume -n- -

End Area Volume Between Sections ~E .
panels from the panel title search

End Area Volume Between Tins

End Area Velurne From Sections to a Height E items from the Main menu search
End Area Volurne From Tin to a Height

\

End Area Volume from Tin to Sections

\End Area Volumes / The final text on the menu is given
| _— before the square brackets [ ]

The position on the menu
— is given in the square brackets

ﬁpnrtfrom AM reference strings [Volurmes-»End Area]

Sections to height [Volumes->End Area]

Sections to sections [Velumes-= ‘::/
String tin to heigh urmes-»End

String tin to tin [Volumes->End Area] | Volumes is matched by Volume because
Tin to height [Velumes-=End Area) Whole word is not ticked

“\| Tin to sections [Volumes->End Area) / W
DN

Select |

Because Whole word is not ticked in the Select Settings, Volume matches with Volumes. For
more information, see 4.6.3.2 Select Settings - Match Case and Whole Word.

Important Note

The order of the key words for selecting options is not important.Typing Volume End Area
brings up exactly the same list.
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Search for 12d Medel Options

Volume End Area

>'ﬁ'n

End Area Volume Between Sections

End Area Volume Between Tins

End Area Volume From Sections to a Height
End Area Volurne From Tin to a Height

End Area Volume from Tin to Sections

End Area Volumes

Report from AM reference strings [Volumes-»End Area]
Sections to height [Volurmes-»End Area]
Sections to sections [Volumes-=>End Area]
String tin to height [Volumes->End Area]
String tin to tin [Velurmes->End Area]

Tin to height [Velumes-=End Area]

Tin to sections [Volumes-=End Area] W

Select |

The sorting order of the items in the list is controlled by the Case sensitive sorting and Descending
order fields that are set in the Select Settings panel brought up by click on the Select Setting £»
icon:

Search for 12d Medel Options BA/ Select Settings icon

Volume End Area

End Area Violume Between Sections A Select Settings n
End Area Volume Between Tins B EE
End Area Volurne From Sections to a Height

End Area Volurne From Tin to a Height Match case -
End Area Volume from Tin to Sections Whaole word -
End Area Volumes Case sensitive sorting I
Report from AM reference strings [Volumes-»End Area] Descending order r

Sections to height [Volurnes->End Area]
Saved Select

Sections to sections [Volumes->End Area]

It was just luck that in this list all the panel names came before the Main menu path names. Typing
in area with Match case not ticked and Case sensitive sorting not ticked, mixes them up.
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Search for 12d Model Options

|area
Area [CAD->Dimension]
Area [CAD->Leader]

}ﬂn

Area [File-»Range files]

Area by string colour [Report-» Moreg]

Area Range File

Cad Dimension Create Area

Cad Drafting Create Inforrmation Leader Area

Cad Drafting Create Information Leader trimesh area

Calc pit overflow areas [Water-»Water Metwork-= Old-»Vers
Calculate areas [BIM-=Trimesh- = Utilities]

Calculate Trimesh Areas

End Area Volume Between Sections

< >

| Select |

For more information, see 4.6.3.3 Select Settings - Case Sensitive Sorting and Descending Order.

Note: The values for the Match case, Whole word, Case sensitive and Descending order fields are
saved for the project in Project Settings - see 6.8.2.7 Search Bar Settings.

Horizontal and Vertical Scroll Bars:

The settings for controlling the horizontal and vertical size of the list of options before horizontal
and vertical scroll bars are added to the Search for 12d Model Options Bar panel are stored in
Project Settings - see 6.8.2.7 Search Bar Settings.

Search for 12d Model Options n .

search text in
| area - ﬁ the search field
Area [CAD->Dimensian] ~

Area [CAD-=Leader]

Area [File-»Range files]

Area by string colour [Report-=More]

Area Range File

Cad Dimensicn  Create Area

horizontal scroll bar Cad Drafting Create Information Leader Area

Cad Drafting Create Information Leader trimesh area

Calc pit overflow areas [Water-=Water Metwork-= Old-=Vers
Calculate areas [BIM->Trimesh- = Utilities] vertical scroll bar
Calculate Trimesh Areas

End Area Volume Between Sections

£ >

| Select |

Page 108 _ Options Search Bar




What’s New in 12d Model 15

The Search for 12d Model Options panel can be pinned (4.5.2 Moving the Search for 12d Model
Options Panel).

The Search text can also be saved for reuse using the Save icon on the Select Settings panel. See
4.5.3 Saving and Reusing Option Searches:

search text in

Save icon
the search field

Search for 12d Model Options n

Volume End Area - ﬁ

End Area Volume Between Sections = SEIE;S}mﬂg/S n
End Area Yolume Between Tins a EE
End Area Velume From Sections to a Height

End Area Velume From Tin to a Height Match case N
End Area Volume from Tin to Secticns Whaole word N
End Area Velumes Case sensitive sorting [
Report from AM reference strings [Volurnes->End Area] Descending order r

Sections to height [Volumes-»End Area] caved Select

Sections to sections [Volumes-=End &Area]

Continue to 4.5.1 Options Search Bar Syntax or return to 4.4 Panel Fields.
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4.5.1 Options Search Bar Syntax

search field

Option Search bar | - ’:)

The search field in the Options Search Bar allows for one or more words separated by spaces.

When you type alpha numeric keywords into the search field of the Options Search Bar, the words
can be separated by the special characters space'', comma',’, plus '+' or minus '-' and 12d Model
will interpret them to perform the following logic operations:

AND use space ' ' or plus '+'
For example:
XY will search for text that contain BOTH X and Y.
X+Y will also search for text that contain BOTH X and Y.
That is, the search will return only results that have both X and Y in them.

OR use comma ',
For example:
X,Y will search for text that contain EITHER X or Y or BOTH X and Y.
That is, the search will return results that have X or Y, or both X and Y in them.

NOT use minus '-'
For example:
-X will exclude text that has X in them

That is, the search will return results that don’t contain X.

The syntax is evaluated from left to right.
That is, you can have things like:

XY, Z-A
which means the search will find text with

(XandY) or Z, but none of them containing A

Continue to 4.5.2 Moving the Search for 12d Model Options Panel or return to 4.4 Panel Fields.

Page 110 _ Options Search Bar




What’s New in 12d Model 15

4.5.2 Moving the Search for 12d Model Options Panel

When information is typed into the Options Search bar, the Search for 12d Model Options panel
comes up.

If the Search for 12d Model Options panel is moved, it is automatically pinned. That is, it stays at the
new position until the panel is deleted (by clicking on the x).

Fﬂﬂﬁﬂﬂﬂﬁﬂmﬂﬁm |regre55

s — = = i i | S| | i i i i =
;lﬁ@ﬂ Search for 12d Model Options

| regre55|
Arc [CAD-=Regression]

i ¥ [ Cad Arc Regression

Cad Line Regressicn

Cad Regression

i General [CAD->Regression]

% | Line [CAD->Regression]

o | Linear Regression

Linear regression [Strings-= Utilities]

Linear regression [Survey->Extras]

Select

This means that any number of options can be selected from the Search for 12d Model Options panel
and it won’t be removed from the screen until the X button is selected.

If you click in the Search bar whilst the Search for 12d Model Options panel is up, the cursor is
automatically moved to the Search field in the Search for 12d Model Options panel.

When the pinned panel is removed, the text in the Search field of the Search for 12d Model Options
panel is written to the Options Search Bar.

Any text in the Search field text can be saved and reused for future Search for 12d Model Option
panels (see 4.5.3 Saving and Reusing Option Searches).

Continue to 4.5.3 Saving and Reusing Option Searches or return to 4.4 Panel Fields.
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4.5.3 Saving and Reusing Option Searches

Page 112

When text is typed into the Search field in the Search for 12d Model Options panel, the text typed in
can be saved and reused for future Searches.

For further information, see 4.6.3.7 Saving and Reusing Searches with Select Settings.

Continue to 4.6 Select for Model, Tin, Template, Function, Name Boxes & Views or return to 4 Tools
and Concepts.

Options Search Bar
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4.6 Select for Model, Tin, Template, Function, Name Boxes & Views

See
Select for Model, Tin, Template, Function and Name Boxes
View Select, Add (+) and Remove (-) View Buttons
Select Settings

4.6.1 Select for Model, Tin, Template, Function and Name Boxes

For a model/tin/template/function box, typing characters into the panel field and then typing <ctrl>+d
brings ups a select list of all the items that start with the typed characters.

By clicking on the icon at the end of the Model box, Tin box, Template box, Function box or Name
box, a Select Model/Tin/Template/Function/Name panel is displayed so that a model/tin/template/
function/Name can be selected.

w modelicon M tinicon | template icon

fx function icon [N] name icon

The Select Model/Tin/Template/Function panel has a Search field and a settings icon above the list of
models/tins/functions/template, and also menu items at the bottom of the Select panel (see 4.6.1.1
Menu Items on the Bottom of Model, Tin, Template and Function Selects.

W Clean Model  — w search field Settings icon for select
Model | N \ \
Permanently clean? [ Select MDde" \ ﬂ
| ) o
Farmat |keep all raster elerments bt
| ——| 4 BASEPOINT -
@ TRIMESH 3400 CSR COMEINED BUILDINGS
Clean | Finish Help | @ water string
— [ 12d
W Tin Infarmation — W search field Settings icon for select
Tin | @l \
® min x max = Select Tin ¥ \n
Y ik Y Fas | ‘ﬁ‘
zmin zmax | ® 12da drainage
Paints Tris ® moved test
| W test
Info | Calc Extent| Finish | Help |
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i) Retriangulate Function — > search field Settings icon for select
Function name | _.f_‘.:| \
Tin | E Select Functh¥1 \n
o W tin test
Create/Set | Firish Help | e
B Ternplate Create/Edit - % search field Settings icon for select
Termplate name |std =l \

| — SelectTempg:e \ n
Ficed | Decisions | cut | Fill |FinaICuthiI| o

M M ‘ # 12d Barrier Type A ‘

- 12d Barrier Type B

) search field  Settings icon for select
il Change String — >

~ / N\
| — Select Name

| LY

|

(]
o =|="&F Alignment ~
Mew: point-line Jignore " ® s
| Z M
| B ® g5

The Select Settings icon controls the:

(a) Display mode: whether the list is displayed as full path name, final name and node name, or
tree name

path

\Inlrie I:A/tree
<> = [@
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Select Model — Select Model n
Select Model | ﬁ
base | ® base
base :
batter outside ® batter outside
batter outside #* cadastral
cadastral .
i cadastral ® construction
construction ->
construction = conts
conts conts ® mech
mesh |D|splay mode path | Display mode name | © movie Display mode tree
mesh X
mavie - ® point
maovie
pad/pad polygons node or branch name e oiqon:
B ; pad polygons pad * oad
pad/pad sections
. pad sections pad ® structures
pad/pad temp strings o
. pad temp strings pad ® tin final
point point ® tin terrain
polygans full path polygons final name or leaf ® topography
road [» @ pad
road
structures [» m tank
ekrnrtiiras

(b) when the choice is a tree name, the level of tree expansion to use

1 2 3 4 5 6 a— Objecttree expansion

— U 37 Defaults
v i—
— Select Model
-
E
Ip ® point
® polygons

® topography isplay mode tree

~ ¥ pad Object tree expansion 2
® pad polygons

@ pad sections Dynamic search ticked

® pad temp strings

(c) search setting for dynamic search, match case and whole word

Match case v
Whole word r

(d) display sorting setting for case sensitive and descending order.

Case sensitive sorting [v

Descending order [

(e) Dynamic search is currently only set in Project Setting >Select >Models, Tins, Functions, Templates
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This also contains extra setting for List box width, List box height etc.

{5} Settings
35 Defaults
2 Systern
= E‘ Inquire
E Heads-Up Display
B [ Select
B 2 View Models

Choices
|§| Marres
za Options Search Bar
On-screen Keyboard
20 Cad
fl] Crrafting
Save
T Trash bodel
= Plots and Reports
CJ Object Display

o I |Typing overiew + or - yree expansion |1

Panel
List o width [320 ]
List box height 640 )
| (0]
| (O]
| ~
=
Search
Dynarmic search v
Match case r
Wirhole waord r
Sorting
Case sensitive Dynamic search v
Descending arder r
[ Teaed 2elarts PN

For a detailed description, see4.6.3 Select Settings.
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When there are model/tin/function/template names displayed in the list, one item is selected from

the list by either:

(a)
or by

double clicking on the item in the list

(b) clicking on an item in the list to highlight it and then clicking on Select at the bottom of the list.

DESIGM C01 BO1

DESIGM D01 BO1
DESIGM DRIVEWAYS

DESIGM C03

|D|splay mode path |

il ==l =
< Select

[EI ear]

[Sameas]

[Options]

The selected item is then written to the panel field.

Note

If the display setting is Tree = and a node is selected that contains sub levels and that node is
clicked on, then the first node under that node that has no subnodes is selected.

For example,

Select for Model, Tin, Template,

unction, Name ~
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i Clean Madel — x
Model | ¢
Permanently clean? r
Format |keep all raster elements e | 'ﬁ
| #® BASE POINT A
Clean | T, | Help | # TRIMESH 3400 CSR COMBINED BUILDINGS
# cogo

W water string

double clicking on 12d ——— -~ [ 12d

will select # ARROW LINEMARKING
2d/ARROW LINE MARKING ® arrow drag
# construction drainage data
— o 12da
P Clean Mac\ — * & basin
Model  |124/ARROW LINEMARKING ﬂ ® basin super bypass primary
< [@F CAD
Permanently clean? -
Format |, Il raster el t ﬂ ® LINE
eep all raster elements — g Old
| @ Reader
Clean | Finish | Help | ® Reader CyanlFCRELSPACEBOUNDARY
A Reader CwanlfrRearm
Note

The documented Search was introduced in 72d Model 12.

If the old Search is wanted, the environment variable model_search_4d must be setto 0

The default for model_search_4d is 1 which uses the new Search. The old Search method is NOT
documented.

To set this environment variable, see the Variables section in the 6.10.2 Create/Edit env.4d.

Page 117




What’s New in 12d Model 15

4.6.1.1 Menu Items on the Bottom of Model, Tin, Template and Function Selects

There are extra menu items at the bottom of the Select Models, Select Tin, Select Template and

Select Function panels.

# Reader CyanlfcRoof

# [ Select Model panel
* i

(Select Tin panel )

Select

Select |

[Clear] «—— [Clear

[Sameas]

[Options] ——— [Sameas]

[Options] for Select

<Se|ect Template panel >

[Clear] <——— [Clear]
[Sameas]

[Optian;] ‘\_[M 3

3

[Options] for Select Tin

(Select Function panel)

Select

| Select

[Clear]

see [Clear]

[Sameas]

see [Sameas

[Clear]

If [Clear] is clicked on, any text in the selected Model/Tin/Template/Function box is cleared.

[Sameas]

If [Sameas] is clicked on, a select element is started and the name of the select element is added to
the Model/Tin/Template/Function box.

[Options] for Select Model

If [Options] is selected on the Select Model panel,

Options n

Clean

String Info
Model Info
Write to 12da
Add to View r

?? it is not obvious what those options do with respect to the any models selected. The Clean is a
worry because it just comes up with "Are you sure you wish to clean this model"

[Options] for Select Tin

If [Options] is selected on the Select Tin panel,

Page 118 Select for Model, Tin, Template, Function, Name .
r g j




What’s New in 12d Model 15

Retriangulate

?? itis not obvious what those options do with respect to the any tins selected. The Clean is a worry
because it just comes up with "Are you sure you wish to clean this model"

Continue to 4.6.2 View Select, Add (+) and Remove (-) View Buttons or return to 4.6.3 Select
Settings.
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4.6.2 View Select, Add (+) and Remove (-) View Buttons

Plan, Section and Perspective views have two special View buttons: + for adding models to the
view and = for removing models from the view.

e pnsaad
ECTIE

The + and = view buttons can be activated in five ways:

e

FiE||

1. Clicking LB over the + or =

Brings up the Models to Add to or Models to Remove from panels which have Search bars

Sezzrch field Settings icon for Select

ModelstuAé‘m"W" \n Madels to Remove fram "18" n
| 1%

[] ¥ BASE POINT ] = first TRIMESH 3400 CSR COMEBINED BUILDINGS
] = TRIMESH 3400 CSR COMBIMED BUILDINGS vD
[0#® cogo O $ Test strings
[ & water string — 1@ survey
— [ 12d I» ] mm Vegetation
[ # ARROW LINEMARKING < [1'aw tins
(] *® arrow drag ] # 12da drainage
] *#® construction drainage data [] 4 test

How the data appears in the list, what the sorting order is and how to select data is controlled
by the 4.6.3 Select Settings.

There are also icons on the bottom of the Models to Add to and the Models to Remove from
panels for adding models/removing models etc. See 4.6.2.1 Icons on Bottom of Models to Add.
Models to Remove Panel.

L o I g S g e
O«

O Z Models to Add panel N (Models to Remove panel >
[] #® Reader CyanlfcRamp
[] * Reader CyanlfcRoof

Move to front

[] = Reader CyanlfcSlab w
/ = 4 0 4 = A i |
Add selected X Mk\ Remove selected X to back \
Add all w Remove a” w

Page 120 Select for Model, Tin, Template, Function, Name —




What’s New in 12d Model 15

2. Clicking MB over the + or =

Brings up the Add Models to View by Pick or Remove Models from View by Pick panels where the
mouse can be used to select the models to added to the view, or removed from the view

P Add Models to Wiew by Pick — h:4 i@ Remowve Models fram Wiew by Pick — =

Wi |y @ Wiews [ @
| |
Pick Finish Help Pick Finish Help

See 5.4.9 Same As for Views.

3. Clicking RB over the + or =

Brings up the Models Ops menu for that view

Model Ops "1" [ |

hodels 3
Add model 4
Add all models

Rermowve model 3
Fermove all models

Add tin rmodels 4
Rermowve tin models 3

Add tagged models »
Rermove tagged models ¥

Model order
Models to front k
todels to back 3

Calc extents

See 5.4.1 Model Ops.

4. Typing a * over the + or the =

Brings up the Add Models to View or Remove Models from View panels where wild cards (*) and
wild characters (?) can be used to add models to a view, or remove models from a view.

PP Add Models to View — . P Rermowve bodels fram Wiew — e
Wiew [y @ Wiew |y @
Model | ﬂ Model | ﬂ
| |

Add | Finish Help | Remove| Finish Help |

See 9.8.2.3 Add Model to View and 9.8.5.3 Remove Model From View.
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5. Typing an alphanumeric character or over the + or the = brings up the Models to Add or Models
to Remove from View panels with the Search bar already containing the typed character.

Search field Settings icon for Select

A\

\
Models tu\gj to "19" \ n Models to Remove from "13" n
a 2 |a o

[] #® water string | |==0O @ survey
— & 12d = [1'&F Vegetation
] *® arrow drag ] = TREES
] *# construction drainage data v|:|=tin5
— [ 5@F 12da (] & 12da drainage
] *#* basin
[] *® basin super bypass primary
—['&F oid

Once the Search panel is up, more typing after the a puts extra characters into the Search field
and they are immediately used (Dynamic select). To change Dynamic Select, see 4.6.3.4
Dynamic Search.

How the data appears in the list, what the sorting order is and how to select data is controlled
by 4.6.3 Select Settings.

Note

The documented Search was introduced in 72d Model 12.

The default for model_search_4d is 1 which uses the new Search. The old Search method is NOT
documented.

To set this environment variable, see the Variables section in the 6.10.2 Create/Edit env.4d.

Continue to 4.6.2.1 Icons on Bottom of Models to Add, Models to Remove Panel or return to 4.6
Select for Model, Tin, Template, Function, Name Boxes & Views.
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4.6.2.1 Icons on Bottom of Models to Add, Models to Remove Panel

For a view, the icons at the bottom of the Models to Add to and the Models to Remove from panels
are used to add models to/remove models from the view, add models to the back of the view, send
models to another view, and move models to the back or front of the view:

L <o MSGLS @i L gL
0% e
7{ Models to Add panel (Models to Remove panel )
] *#& Reader CyanlfcRamp
[ ] *® Reader CyanlfcRoof
] # Reader CyanlfcSlab v

— S
H = & 3 B = 3 ¥+ 3

Move to front

Add selected X _Add to back Remove selected X Move to back

Add all -Send to view Remove all Send to view

Add selected

If Add , is clicked on, the selected (highlighted) models are added to the view.

Multiple selects of models is only possible when the Select Setting setting is _Path ¢f> , or Name
:= butnot Tree = .
Add all

If Add all =%, is clicked on, all the models in the list are added to the view.

Add to back
If Add to back .t | is clicked on, the selected (highlighted) models are added to the back of the
view.

Multiple selects of model is only possible when the Select Setting setting is Path ¢/ , or Name
:= butnot Tree [z .

Send to view

If Send to view %] , is clicked on, a list of existing views is popped up and when one is double
clicked on, the selected models are added to the selected view.

Multiple selects of models is only possible when the Select Setting setting is Path </ , or Name
:= butnot Tree = .

Remove selected

If Remove [<] , is clicked on, the selected (highlighted) models are removed from the view.

Multiple selects of models is only possible when the Select Setting setting is Path </ , or Name
:= butnot Tree = .

Remove all
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If Remove all =; , is clicked on, all the models in the list are removed from the view.

Move to back
If Move to back T is clicked on, the selected (highlighted) models are moved to the back of the
view. This is on the Models to Remove panel so all the models are already on the view.

Multiple selects of model is only possible when the Select Setting setting is Path ¢/ , or Name
:= butnot Tree = .

Move to front

If Move to front -+ , is clicked on, the selected (highlighted) models are moved to the front of the

view. This is on the Models to Remove panel so all the models are already on the view.

Multiple selects of model is only possible when the Select Setting setting is Path ¢/ , or Name
:= butnot Tree = .

Continue to 4.6.3 Select Settings or return to 4.6 Select for Model, Tin, Template, Function, Name
Boxes & Views.
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4.6.3 Select Settings

There are Select Settings for

(a) Model, Tin, Template and Function boxes
(b) Name box which uses the Names.4d file
(c) Add (+) View button

(d) Remove (-) View button

(e) Choice boxes

(f) Search for 12d Model Options panel

Save the
settings Path N/ame Tree _Tree Level Expansion View Name
| \
%Iect Settings X j F/ Select Settings / n Select Settings \ n
(=] > = IR B o @ =B B =
1 2 4 5 6
1 2 3 4 5 6 3 Match case I
Whol d
Match case I Match case Match case v ° ewu.r. _ I
Whole word v w Whole word - Case sensitive sorting ™
.. . . o ) Descending order -
Case sensitive sorting [# | Case sensitive | Case sensitive sorting W
Descending order o sorting Descending order [ | |S5aved Select
Saved Select Descending Saved Select
order
Select Settings for Model, Select Settings for Remove (-) Sgerccthsglt‘nllg; f;;;) del Obtions
Tin, Template, Function boxes View button p
and Add (+) View button

The Select Settings control:
(a) How the items in the pop-up list are displayed

The icons control how the 2.1 Object Tree names are displayed. See 4.6.3.1 Select Settings -
Displaying Path Name.

(b) The order that the items are displayed

The tick boxes _Case sensitive sorting and _Descending order control the order of the items in
the list.

For Remove (-) View button, the _View icon displays the models in the order that the models
have been added to the view. The models are only displayed as Path.

(c) How typing into the Search field works

When typing in the Search field, Match case and Whole word restrict the items in the list and
makes it easier to make selections.

. Models to Add to "19"

Search field ﬂ
water string =
moved test tins
construction drainage data 12d
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The Search field in conjunction with the Match case, Whole word, Case sensitive sorting
and Descending order adds increased functionality for controlling what is in the pop-up for
existing Models/Tins/Functions/Templates.

(d) Typing into the Search field - Dynamic mode

When Dynamic search is turned on, the search is done as each character is typed into the
Search field.

“ 95 Defaults

—

Select Model

E

® point
#® polygons
# topography
~— @ pad
#® pad polygens
> pad sections
> pad temp strings

B

By default Dynamic search is set to on and can not be changed in the Select Settings but is
changed in the subnodes of 6.8.2 Project =>Settings. See 4.6.3.4 Dynamic Search

For a description of the behaviour of each icon and tick box on the Select Settings panel:
Path, Name, Tree icons and Remove (-) view button, see 4.6.3.1 Select Settings - Displaying
Path Name
Match Case see 4.6.3.2.1 Select Setting Match Case
Whole Word see 4.6.3.2.2 Select Setting Whole Word
Case sensitive sorting see 4.6.3.3.1 Select Setting Case Sensitive Sorting
Descending Order see 4.6.3.3.1.1 Select Setting Descending Order
Dynamic search see 4.6.3.4 Dynamic Search

Continue to 4.6.3.1 Select Settings - Displaying Path Name or return to 4.6.3 Select Settings.
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4.6.3.1 Select Settings - Displaying Path Name

Path Name Tree Tree Level Expansion _View Name
\
Selec&&{{‘\ \ n Select Settings & n Select Settings \ n
= < = I3 B s MiStE B =
1 2 3 4 5 6 1 2 3 4 5 6
Select settings for Model, Se.:lect settings for Remove (-) Select Settings for '
Tin, Template, Function boxes View button Search for 712d Model Options
and Add (+) View button
Path

If Path </» | the full path name of the object tree is displayed as text.

Models to Add ta "19" n
12d/ARROW LINEMARKING A

12d/arrow drag
12d/construction drainage data
12da/basin

12da/basin super bypass primary
BASE POINT

CAD/LINE

Old/Reader

When this is the NOT selected, it is displayed as */*
Name

If Name := , the final name in path name (leaf) is shown in the first column and the full name of
the node containing the leaf is shown in the second column.

Models to Add to "18" [ x |
] o
12da drainage tins

ARROW LINEMARKING 12d

BASE POINT

[fcBearn Test
[fcBuildingElementProxy Test

feColurnn Test

[fcCovering Test

[feCurtainWall Test

When this is NOT selected, it is displayed as =
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Tree

If Tree = , the path name is displayed in a tree form.

Models to Add to "19"

[] # BASE POINT
[] # TRIMESH 3400 CSR COMEINED BUILDINGS
[] *# water string
—[]&F 12d
[] = ARROW LINEMARKING
[ *# arrow drag
[] *# constructicn drainage data
— [ 12da
] # basin

>ﬁn

When this is NOT selected, it is displayed as [ .

Tree Level Expansion
This is only used when Tree = has been selected.

The Tree Level Expansion 1 2 3 4 5 6 | setsthe number of levels that the tree
path is expanded to when the list is displayed. It can only take the integer value 1 to 6.

Models to Add te "19" n Models te Add to "19" n

| T | o
[] # BASE POINT 14 BASE POINT
[] # TRIMESH 3400 CSR COMEINED BUILDINGS 14 TRIMESH 3400 CSR COMEIMED BUILDINGS
[] *# water string 1 water string

b O e 12d Level 1 —['5 12d Level 2

[ O] mm 12da [] = ARROW LINEMARKING

[ (] mm CAD 1 arrow drag

[ ] @ Old ] #® construction drainage data

[» O] i QWN — 15 12da

[ O] Test ] *# basin

View

This icon is only displayed when the Select is for a Remove (-) View button.

If View [a] , the models are displayed in the order that they were added to the view.

Medels to Remove from "19" n

| o

survey/Vegetation/ TREES

tins/12da drainage

tins/test
When this is NOT selected, it is displayed as [&] .
For View, the names are only displayed in Path ¢/ form.

Continue to 4.6.3.2 Select Settings - Match Case and Whole Word and 4.6.3.3 Select Settings -
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Case Sensitive Sorting and Descending Order or return to 4.6.3 Select Settings.
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4.6.3.2 Select Settings - Match Case and Whole Word

Match caze v
Whaole word I

Match case
If Match Case is ticked, the search matches on alphabetical case. That is, the search is case sensitive.

If Match Case is not ticked, the search does not match on alphabetical case. That is, the search is case
insensitive.

For more information and examples, see 4.6.3.2.1 Select Setting Match Case.

Whole word
If Whole word is ticked, the search is against the entire names. Wild cards (*) and wild characters (?) can
be used.

If Whole word is not ticked, the search is for the typed characters anywhere in the names.
For more information and examples, see 4.6.3.2.2 Select Setting Whole Word.

4.6.3.2.1 Select Setting Match Case

The Match case tick box, in conjunction with the tick box Whole word, controls how typing into the
Search field works

Select Model
Search field ﬂ
@ BASE POINT ~

@ TRIMESH 3400 CSR COMBINED BUILDINGS
W water string
—'aw 12d

When the Match Case is ticked on, the search matches on case. That it, the search is case
sensitive.

When the Match Case is ticked off, the search does not match on case. That is, the search is case
insensitive.

The setting for Match Case is the same for Models, Tins, Functions and Templates and any change
to the setting is automatically made to the Project Settings >Model, Tins, Functions setting and
so if a save is done for the project, the new Match Case setting are be remembered. See 6.8.2.6.2
Select >Models, Tins, Functions Settings.

The setting for Match Case is the same adding models to a view and removing models from a view
and any change to the setting is automatically made to the Project Settings >View Models setting
and so if a save is done for the project, the new Match Case setting are be remembered. See
6.8.2.6.1 Select >View Models Settings.

For examples, see 4.6.3.2.2.1 Whole Word is Off - Anywhere Search and 4.6.3.2.2.2 Whole Word is
On - Pattern Search.

Continue to 4.6.3.2.2 Select Setting Whole Word or return to 4.6.3 Select Settings.
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4.6.3.2.2 Select Setting Whole Word

The Whole word tick box, in conjunction with the tick box Match case, controls how typing into the

Search field works

. Select Model
Search field \" [=]
= BASE POINT ~

# TRIMESH 3400 CSR COMBINED BUILDINGS
W water string
— o 12d

If Whole word is ticked, the search is then against the entire name in the list. Wild cards (*) and wild
characters (?) can be used. For examples, see 4.6.3.2.2.2 Whole Word is On - Pattern Search.

If Whole word is not ticked the search is then for the typed characters anywhere in the name in the
list. For examples, see 4.6.3.2.2.1 Whole Word is Off - Anywhere Search.

Continue t0 4.6.3.2.2.1 Whole Word is Off - Anywhere Search or return to 4.6.3 Select Settings.

4.6.3.2.2.1 Whole Word is Off - Anywhere Search
When the Whole word is ticked off, the search looks for the characters anywhere in the item names.

That is, if Whole word is off, when text is typed into the search field it will display in the list the items
that contain the typed letters anywhere in the item name.

Note: The search will only consider case if the Match Case is ticked on.
For example, typing in “mesh" with Match Case off displays

Select Model n

| mesh Models to Add to "18" [ |
120 MESH Fo
DESIGM MESH ACD RBO1 - B
12da drainage tins ~
DESIGM MESH EXT
ARROW LINEMARKIMG 12d
DESIGM MESH FOOTING BASE POINT
DESIGM MESH FPATH REOL lfcBeam Test
DESIGN MESH GR1 RBO1 [fcBuildingElernentProxy Test
DESIGM MESH GR2 REOL lfcColumn Test
DESIGM MESH KBA RBO1 [feCovering Test
DESIGM MESH PKEA RBO1 FcCurtainWall Test
DESIGM MESH PVA RBO1 [feDoor Test
DESIGM MESH PVE REO1 [feFlowMovingDevice Test
DESIGM MESH STRS ACD RBO1 [fcFlowTerminal Test
FEFTAR L L EESD T T [ TS S Tt

For example, typing in “mesh" with Match Case on displays
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Select Model n
mesh -ﬁ
Design Trimesh RO1 Inner
lee split trimeshes Match Case is on
Split trimeshes Whole word is off

trimesh cont labels

trimesh conts

None of the models containing MESH are then listed.

Having one of more sets of letters separated by a plus sign (+) will list only the appropriate items
containing each of the sets of letters on each side of the +. For example
mesh+GR1

only selects items that contain the letters mesh AND the letters GR in them.

Select Model n

mesh+GR1 ﬂ Aa Bbl

DESIGM MESH GR1 RBO1

DESIGM MESH STRS GR1 REO1 Match Case is off
DESIGM MESH WALLGR1 REO01 Whole word is off

Using a minus sign (-) means that the following letters will NOT appear in the list.
For example
mesh-GR1

only selects items that contain mesh but do not contain GR

Select Model n

mesh-GR1 - e
120 MESH la
DESIGM MESH ACD RBO1
DESIGMN MESH EXT
DESIGN MESH FOOTING Match Case is off
DESIGMN MESH FPATH REOL
DESIGMN MESH GR2 REDL
DESIGMN MESH KBA RBO1
DESIGM MESH PEBA REO1
DESIGN MESH PVA RBO1
DESIGMN MESH PVE REO1

NCCTAR RACCU CTOC A DDAA

Whole word is off
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The setting for Whole Word is the same for Models, Tins, Functions and Templates and any change
to the setting is automatically made to the Project Settings >Model, Tins, Functions setting and
so if a save is done for the project, the new Whole Word setting are be remembered. See 6.8.2.6.2
Select >Models, Tins, Functions Settings.

The setting for Whole Word is the same adding models to a view and removing models from a view
and any change to the setting is automatically made to the Project Settings >View Models setting
and so if a save is done for the project, the new Whole Word setting are be remembered. See
6.8.2.6.1 Select >View Models Settings.

Continue to 4.6.3.2.2.2 Whole Word is On - Pattern Search or return to 4.6.3 Select Settings.

4.6.3.2.2.2 Whole Word is On - Pattern Search

When the Whole word is ticked on the search is switched to pattern mode and the text searched for
must exactly match the typed in text. Wild cards (*) and wild characters (?) can be included in the
search text.

Note: The search will only consider case if Case sensitive is ticked on.
So when Whole word is on, typing mesh does not select any items.

Select Model n

mesh - ﬁ

Match Case is off

Whole word is on

But typing *mesh when Whole word is on, selects all items ending in mesh.

Select Model n

| *mesh ﬁ

12D MESH
HW TRIMESH

Match Case is off

Whole word is on

Typing *mesh* when Whole word is on, selects all items that include the text mesh.
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Select Model n

| *mesh* 7 e

12D MESH

DESIGM MESH ACO REO1
DESIGM MESH EXT
DESIGN MESH FOOTING Match Case is off
DESIGM MESH FPATH REO1 Whole word is on
DESIGM MESH GR1 REO1
DESIGM MESH GR2 RRO1
DESIGM MESH KBA RBEO1

MECTSKI BACCH DR A BRI

So typing characters into the Search field in Anywhere search (Whole word off) is equivalent to
typing * before and after the characters in Pattern Search (Whole word on).

>

The setting for Whole Word is the same for Models, Tins, Functions and Templates and any change
to the setting is automatically made to the Project Settings >Model, Tins, Functions setting and
so if a save is done for the project, the new Whole Word setting are be remembered. See 6.8.2.6.2
Select >Models, Tins, Functions Settings.

The setting for Whole Word is the same adding models to a view and removing models from a view
and any change to the setting is automatically made to the Project Settings >View Models setting
and so if a save is done for the project, the new Whole Word setting are be remembered. See
6.8.2.6.1 Select >View Models Settings.

Continue to 4.6.3.3 Select Settings - Case Sensitive Sorting and Descending Order or return to
4.6.3 Select Settings.
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4.6.3.3 Select Settings - Case Sensitive Sorting and Descending Order

Case sensitive sorting ~

Descending order [

Case sensitive sorting
If Case sensitive sorting is ticked, the display order of the items in the list is case sensitive.
If Case sensitive sorting is not ticked, the display order of the items in the list is case sensitive. That is, it
is as though all characters are in upper case.
For more information and examples, see 4.6.3.3.1 Select Setting Case Sensitive Sorting.

Descending order
If Descending order is ticked, the display order of the items in the list is in descending alphanumeric
order according to the ascii sort sequence.
If Descending order is not ticked, the display order of the items in the list is in ascending alphanumeric
order according to the ascii sort sequence.

For more information and examples, see 4.6.3.3.1.1 Select Setting Descending Order.

4.6.3.3.1 Select Setting Case Sensitive Sorting
If Case sensitive sorting is ticked, the display order of the items in the list is case sensitive.
If Case sensitive sorting is not ticked, the display order of the items in the list is case sensitive.

For Path, the sorting is done on the path name

Madels to Add to "19" B ratn
12d/ARROW LINEMARKING ~| Case sensitive sorting is on
12d/arrow drag Descending order is off

12d/construction drainage data
12da/basin

12da/basin super bypass primary
BASE POINT

CAD/LINE

Old/Reader

For Name, the sorting is done on the first column (leaf).
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Models to Add to "18" [ x |

| L Name

12da drainage tins = )
ARROW LINEMARKING 124 Case sensitive sorting is on
BASE POINT Descending order is off
lfcBeam Test

IfcBuildingElementProxy Test

feCelurmn Test

lfeCovering Test

feCurtainWall Test

For Tree, the sorting order is:

Not descending order - Ascending:

All the items that have only the one level are displayed first and are sorted in ascending order using
the value of case sensitivity. The items with more than one level come next and are sorted using
the top level name in ascending order using the value of case sensitivity.

Descending order:

The items with more than one level are displayed first and are sorted first in are sorting using the top
level name in descending order using the value of case sensitivity. All the items that have only the
one level come next and are sorted in descending order using the value of case sensitivity.

Madels to Add to "19" n
Tree

[ BASE POINT & Case sensitive sorting is on
[] 4 TRIMESH 3400 CSR COMBINED BUILDINGS i
[ @ water string Descending order is off
- ['aF 12d
[ ¥ ARROW LINEMARKING
[0 arrow drag
[ construction drainage data
- /a5 12da
[ ¥ hasin

Whether the sorting in the list is sorted case sensitive or not, is controlled by Project Settings. See
6.8.2.6.1 Select >View Models Settings.

The choice for Case sensitive sorting is automatically made to the Project Settings >View
Models setting and so if a save is done for the project, the new setting are remembered. See
6.8.2.6.1 Select >View Models Settings.

Continue to0 4.6.3.3.1.1 Select Setting Descending Order or return to 4.6.3 Select Settings.
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4.6.3.3.1.1 Select Setting Descending Order

If Descending order is ticked, the display order of the items in the list is in descending alphanumeric
order according to the ascii sort sequence.

If Descending order is not ticked, the display order of the items in the list is in ascending
alphanumeric order according to the ascii sort sequence.

For _Path, the sorting is done on the path name

Models to Add to "19" B ran
water string ~| Case sensitive sorting is on
tins/moved test Descending order is on

Test/IfcWindow
Test/IfcWallStandardCase
Test/IfcWall
Test/IfcVirtualElement
Test/IfcTransportElernent
Test/IfcStairFlight

For Name, the sorting is done on the first column.(leaf)

Madels to Add to "19" [ x |

L3 Name
water string = ]
rmoved test tins Case sensitive sorting is on
construction drainage data 12d Descending order is on
basin super bypass primary 12da
basin 12da
arrow drag 12d
TRIMESH 3400 CSR COMEBINED BUILDIMNGS
Reader fcWindow Oid

For Tree, the sorting order is:

Not descending order - Ascending:

All the items that have only the one level are displayed first and are sorted in ascending order using
the value of case sensitivity. The items with more than one level come next and are sorted using
the top level name in ascending order using the value of case sensitivity.

Descending order:

The items with more than one level are displayed first and are sorted first in are sorting using the top
level name in descending order using the value of case sensitivity. All the items that have only the
one level come next and are sorted in descending order using the value of case sensitivity.
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Models to Add te "19"

| n Tree

O tins ~ Case sensitive sorting is on
[] ® moved test . .

- Test Descending order is on

O * ifcWindow

[ # IfcWallStandardCase
[ & ifcwall

[ = IfcVirtualElement
[ # (fcTransportElement
[ # (fcStairFlight

Whether the list is sorted in ascending or descending order is controlled by Project Settings. See
6.8.2.6.1 Select >View Models Settings.

(e) clicking on the View Order icon means that the item list is in the order that the models were
added to the view.

The choice of Name Order or View Order is automatically made to the Project Settings >View
Models setting and so if a save is done for the project, the new setting are be remembered. See
6.8.2.6.1 Select >View Models Settings.
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4.6.3.4 Dynamic Search

When Dynamic search is turned on, the search is done as each character is typed into the Search
field.

“ 95 Defaults

—

Select Model

E

® point
#® polygons
# topography
~— @ pad
#® pad polygens
> pad sections
> pad temp strings

B

Dynamic search is by default set to on and can not be changed in the Select Settings but can only
be changed in the subnodes of 6.8.2 Project =>Settings.

That is, in the subnodes:
(a) View Models
(b) View Models >Typing over View + or -,

(c) Models, Tins, Functions, Templates

(d) Choices
and
(e) Names.
. - —
{GF Settings Panel
9= Defaults List box width [320 L]
L Systern List box height 640 @
= |I| Ingquire | @
E Heads-Up Display
o [E Select | o] _ Dynamic search
B %2 View Models | ,2/
hd

o T [Typing cver View + or '|;tree expansion |1 /
Chaoices Search

El Marnes (Dynamic search
Za Options Search Bar

&

Match case [
On-screen Keyboard
40 Cad Whole weard
flll Drafting Sorting

See 6.8.2 Project =>Settings.
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4.6.3.5 View Order Icon on for Removing (-) on View Buttons

View Order icon

Select Settings
B > =
1 2 3 4 5 6

Match case v
Whole word I_
Case sensitive sorting [v
Descending order [

Clicking on the View Order icon means that the model list is displayed in the order that the models
were added to the view.

Models to Remove from "13" n

survey/Vegetation/ TREES
tins/12da drainage

tins/test

The choice of View Order is automatically made to the Project Settings >View Models setting and
so if a save is done for the project, the new setting are remembered. See 6.8.2.6.1 Select >View
Models Settings.

Continue to 4.6.3.6 Search Field Syntax for Selects or return to 4.6.3 Select Settings.
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4.6.3.6 Search Field Syntax for Selects

The following documentation applies to the Search field for the Select on:

(a) + and - buttons on Views
(b) Model boxes

(c) Tin boxes

(d) Function boxes

(e) Template boxes

(f) Choice boxes

The search for the Options Search Bar is different and is discussed separately in 4.5.1 Options
Search Bar Syntax).

To search for special text among a list of text items, the following rules apply:

When you type alpha numeric keywords into the search box, the words can be separated by the
special characters space '', comma ', plus '+' or minus '-' and 12d Model will interpret them to
perform the following logic operations:

AND use space ' ' or plus '+'
For example:
XY will search for text that contain BOTH X and Y.
X+Y will also search for text that contain BOTH X and Y.
That is, the search will return only results that have both X and Y in them.

OR use comma ',
For example:
X,Y will search for text that contain EITHER X or Y or BOTH X and Y.
That is, the search will return results that have X or Y, or both X and Y in them.

NOT use minus '-'
For example:
-X will exclude text that has X in them

That is, the search will return results that don’t contain X.

The syntax is evaluated from left to right.
That is, you can have things like:
XY,Z-A or X+Y,Z-A
which means the search will find text with
(X'and Y) or Z, but none of them containing A

Continue to 4.6.3.7 Saving and Reusing Searches with Select Settings or return to 4.6.3 Select
Settings.
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4.6.3.7 Saving and Reusing Searches with Select Settings

When text is typed into a Search field, the typed text can be saved as a Saved Select and reused
for future selects.

There are distinct sets of Saved Selects for the:

(a) panels Models to Add to View and Models to Remove from View that are brought up when LB is
pressed over the + or - icon on a View

(b) panels Models to Add to View and Models to Remove from View that are brought up when a
character is typed over the + or - icon on a View

(c) Select Model, Select Tin, Select Template and Select Function panels that come up when you
click LB on the icon on the right hand side of a Model, Tin, Template, or Function box

(d) Search for 12d Model Options panel when you start typing into the Search bar.

To create a Saved Select, after the text is typed in the Search field of any of the above panels, click
on the Select Setting g3 icon to bring up the Select Settings panel and then click on the Save icon.

Search for 12d Model Options n Save icon

Volume End Area

End Area Volume Between Sections ~ SEIE;S}“GQS n

End Area Volume Between Tins a EE
End Area Volurne From Sections to a Height

End Area Volurne From Tin to a Height Match case B
End Area Volume from Tin to Sections Whole word N
End Area Volumes Case sensitive sorting I
Report from AM reference strings [Volumes->End Area] Descending order -

Sections to height [Volures-»End Area] caved Select
Sections to sections [Volumes->End Area]
String tin to height [Volumes->End Area]
String tin to tin [Velurmes-=End Area]

Tin to height [Volumes->End Area]

Tin to sections [Volumes-=End &Area] v

Select

The text will be saved in Project Settings when a Project Save is one.

In future, for any Searches of the same type, clicking on the Select Setting g icon will display the
list of saved Search texts in the Save Select grid.

Page 142 Select for Model, Tin, Template, Function, Name =l

-/




Search for 12d Model Options

ol - |

What’s New in 12d Model 15

Select Settings

Match case

Saved Selects Whaole word

Case sensitive sorting

Descending order

Saved Select

Volume End Area

Clicking on one of the Saved Selects will pipe the text into the Search field of the panel and apply it.

Search for 12d Model Options

Volurme End Area

[=]
&

End Area Volume Between Sections

End Area Volume Between Tins

End Area Velume From Sections to a Height
End Area Velume From Tin to a Height

End Area Volume from Tin to Sections

End Area Volumes

Report from AM reference strings [Volurnes-»End Area]
Sections to height [Volumes-»End Area]
Sections to sections [Volumes-=End Area]
String tin to height [Velumes->End Area]
String tin to tin [Volurmes->End Area]

Tin to height [Veolurnes-» End Area)

Tin to sections [Volumes-=>End Area]

Select

Notes:

1. The Search Selects are only saved for the Project when a Project =>Save is done.

2. The Saved Option Searches can also be displayed, created and modified in the Saved Selects
grid in the Project Settings nodes 6.8.2.6.1 Select >View Models Settings, 6.8.2.6.1.1 Select
>View Models >Typing over View + or - Settings, 6.8.2.6.2 Select >Models, Tins, Functions

Settings, 6.8.2.6.3 Select >Choices and 6.8.2.7 Search Bar Settings.

Continue to 4.7 Chainage Equalities or return to 4 Tools and Concepts.

Select

‘or Model, Tin, Template, Functipn, Name
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4.7 Chainage Equalities

In some Jurisdictions, Chainage Equalities are called Station Equations, or Broken Chainages.
See

4.7 .1 Natural/Raw Chainage

4.7.2 Chainage Equalities

4.7.3 Internal Equality

4.7.4 K-Post

4.7.5 Zones

4.7.1 Natural/Raw Chainage

When designing and using an alignment, the horizontal distance (plan or 2D distance) along the
alignment is regularly used to define and position objects in 2D that are on the alignment, or near
the alignment.

For an alignment, the natural chainage (raw) is defined to be the horizontal distance along the
alignment as measured from the start of the alignment plus a given start chainage value for the

alignment.
Natural/Raw chainage of a = Start chainage + Horizontal distance from the start of the
place on the alignment alignment to the place
Example 1
In Example 1, the alignment on the left has a start chainage of %‘ﬂﬁ‘?
0.000 and an end chainage of 295.567. 25, 3,&%?
Labelling of the chainages on the left occur in intervals of 50.
]
<5p
The alignment on the right has a start chainage of 23.200 and 10
an end chainage of 316.767. 20g
Labelling of the chainages on the right also occur in intervals 100
of 50. 150
w 400
poeR @
42290

Continue to 4.7.2 Chainage Equalities or return to 4.7 Chainage Equalities
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4.7.2 Chainage Equalities

One issue with natural chainages is that whenever the horizontal section of an alignment is
modified, the natural chainages of positions on the alignment may be affected.

This can be a problem in some industries, especially railways, were the places of objects along the
railway alignment is often only recorded as a chainage value and a perpendicular offset at that
chainage. In this case, having the chainages change would invalidate all those records.

To overcome this problem, the concept of Chainage Equalities evolved to allow some of the
original chainages to be maintained.

So chainage equalities, also known as chainage equations or station equations, are used so
that even when the horizontal geometry, and hence raw chainages, change for an alignment, labels
can still be produced that reflect the original, or recorded, chainages.

In 12d Model, the super alignment supports chainage equalities.

A chainage equality is a place on the super alignment where the chainage value is reassigned
and given a new chainage value at that place. This new chainage will normally be different to the
natural/raw chainage.

The new chainage (equality chainage) for a position on the alignment after a chainage equality is
the new chainage value at the preceding chainage equality plus the horizontal distance of the
position from the preceding chainage equality.

That is:
Chainage of a position after a = New chainage at the + Horizontal distance from
chainage equality (equality chainage) chainage equality the chainage equality

So when chainage equalities are involved, the equality chainage of a place on the super alignment
depends on the chainage equalities, especially the last one, that proceeds it.

Equality chainage of a position = New chainage at the + Horizontal distance from
after a chainage equality chainage equality the chainage equality

So for a position on an alignment, there is its natural/raw chainage and its equality chainage.

In 12d Model, the super alignment supports two types of chainage equalities: 4.7.3 Internal Equality
and 4.7.4 K-Post.

What the equality chainage is after a chainage equality depends on whether the chainage
equality is an 4.7.3 Internal Equality or a 4.7.4 K-Post.

Continue to 4.7.3 Internal Equality or return to 4.7 Chainage Equalities

P
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4.7.3 Internal Equality

An internal equality is a chainage equality where a Before value and an After value is provided.

Page 146

The value in the Before value is the equality chainage where the chainage equality occurs. That is,
the Before value takes into account the previous chainage equalities.

The value in After value is the new chainage that the place where chainage equality occurs, takes.

All subsequent chainages beyond the internal equality point are adjusted to be relative to the
After value.

That is:
Chainage of a place after = "After" chainage at the + Horizontal distance from
an internal equality internal equality the internal equality

An Internal equality is written as:

Before value = After value

where the value in Before value is the equality chainage of where the chainage equality
occurs. That is, the Before value takes into account the previous chainage equalities.

In Example 2, the Before value is 100 Example 2 Example 3
and the After value is 25. 22 9
2,7 350

Therefore, chainage 50 is repeated
twice - once before the Internal equality

and once after the internal equality. "0 %o
100 250
In Example 3, the Before value is 25 Before value
and the After value is 100. 50 200
Hence chainage 50 does not exist at 100,000 05,000
all. ' . 450
Aft | ®
er value !
\ _ 400 0% |
0% 26907 qond

Continue to 4.7.4 K-Post or return to 4.7 Chainage Equalities
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4.7.4 K-Post

K-post stands for Kilometre post.

In 12d Model, a K-post is a place on a super alignment where the chainage (and Zone number)
is reset to zero and all subsequent chainage values until the next K-post include the unique
Name of the K-post as text before the chainage value.

This is:
Chainage of a place = K-Post name followed by Horizontal distance from
after a K-post the K-post equality

A K-post is written as:
Before value = K-Post name

where value in Before value is the equality chainage where the K-post occurs. That is, Before
value takes into account the previous chainage equalities.

In 12d Model, the position of a K-post can be defined in three ways - 4.7.4.1 K-post coord, 4.7.4.2
K-post chainage and 4.7.4.3 K-post relative

Note: If the preceding chainage equality to an internal equality is a 4.7.4 K-Post, the Before value
is the horizontal distance from that K-post.

Continue to 4.7.4.1 K-post coord or return to 4.7 Chainage Equalities

4.7.4.1 K-post coord

74,
For K-post coord, the position of the K-post K 773 ;
is calculated by giving the coordinates of a Example 4 74.0} V38
point near the alignment and the K-post is / 7S
where that point drops perpendicularly onto
the alignment. 7477; 700
. ® point to drop onto the
In Example 4, the point drops onto the super 1km 50  alignment to define
alignment at equality chainage 122.429. The the position of the K-post
K-post name (used as pretext) is 1km. /
122429 =1km — —
100
K-post name
50
000

Continue to 4.7.4.2 K-post chainage or return to 4.7 Chainage Equalities
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4.7.4.2 K-post chainage

¥/
For K-post chainage, the position of the "’b 72,
K-post by giving its 4.7.1 Natural/Raw Example 5a 74_0? 56>
Chainage. / 70y
y Zkey %

In Example 5a the position of the K-post
chainage is at natural chainage 175 and 175 0g
the K-post name is 1km. m \

150 the natural chainage of

K-post name this point is 175
400
50
000
Thr,

In Example 5b the position of the K-post 243.767
chainage is at chainage 175 and the K- Example Sb , /
post name is 1km. /’",’eoo
Note that because the start chainage is not
zero, the position of natural chainage 175 Thn 15
changes from where it was in Example 5a. o

1km 109

K-post name the natural chainage of

1km 50
\ \ / this point is 175
«

X
1169%° AB0
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4.7.4.3 K-post relative

For K-post relative, a distance is given and a K-post is created at that horizontal distance from
the previous chainage equality in the list in the super alignment editor.

If there is no previous chainage equality, the distance of the K-post is calculated from the start
chainage:

In Example 6 the K-post relative has a Before value of
125 which represents a horizontal distance from the
previous chainage equality which is a K-post at raw
chainage 78.033 and with a K-post name of 1Km.

The K-post name for the new K-post is 2km.

What’s New in 12d Model 15

Example 6 ?'f/}; 9
353
2

Before value 2
T, & 3
725 000
&= ek[h

K-post name  7km 15,

1km 50

= Ak

8033
T 50

000

Continue to 4.7.5 Zones or return to 4.7 Chainage Equalities

Chainage Equalities
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4.7.5 Zones

When Chainage equalities, either Internal Equalities and/or Example 7 205,
K-posts, are allowed, a chainage value can be repeated multiple <Oy ’
times.
For example in Example 7, chainage 50 refers to two places. "0
100
Before value
50
400000 = 25000
After value

o0

To distinguish between the duplicated chainages, the concept of Zones is used.

A Zone is the section of the alignment from a chainage equality until the next chainage equality.

The first Zone 0 (or zoneless) by default occurs from the start chainage to the following chainage
equality.

The following Zones are labelled as 1, 2, 3, etc until a K-post occurs and then the Zone numbering
is reset to Zone 0 (or zoneless) and the chainage is reset to zero.

If there are chainage equalities prior to the start chainage then Zone 0 will begin at the first chainage
equality and not the start chainage.

For zone numbers other than Zone 0, the zone number is written in round brackets after the
chainage value.

g

8,
Example 8 '56‘2(9
/ )
7
In Example 8, there are three chainages Before value oo(e)
equal to 50 but each is in a different Zone.
700.000 (1) - 50(
They are 50, 50 (1) and 50 (2). =25.000 @) |
After value

Before value  gq (1)

100,000 = 25.00° M

50
After value

000
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In Example 9, there are two chainage
equalities for the super alignment.

The first chainage equality is a K-post
Chainage with a Before value of 125 and a K-
Post name of 1 km.

Subsequent chainages are displayed with a
horizontal distance relative to the K-post
and the prepended K-post name.

For example, 1km 50

The second chainage equality is an Internal
Equality with a Before value of 1 km 115 and
an After value of 1 km 25.

Subsequent chainages to the second chainage
equality are displayed with an horizontal
distance relative to the After value of the
internal equality (ie 25.0 + horizontal distance
from the internal equality), with the prepended
K-post name from the first chainage equality.
Plus an appended zone label of (1) to indicate
it a new zone with an incremented number
starts after an internal equality.

In example 10, there are two chainage equalities
for the super alignment.

The first chainage equality along the super
alignment is an Internal Equality with a Before
value of 135 and an After value of 25.

Subsequent chainages until the K-post are
displayed with an offset relative to the After
value with an appended zone label of (1) to
indicate the new zone after the internal equality.

The second chainage equality is a K-post
Relative with a Before value of 130. The
subsequent chainages along the super
alignment are displayed with a horizontal
distance from the K-post and the prepended K-
post name of 1 km.

Note: Zoning is reset to 0 (Zoneless) after each
K-post

What’s New in 12d Model 15

Example 9

74777 y
0

/
7,(-”750
Before value / '000(

7 g
"‘"’fgio

After value

Before value X

50
e

K-Post name

Before value

100 (%)
K-Post name

50 (1)
Internal equality

A00
Before value q

After value \
506?3
2%

Continue to 4.8 Sharing of Models and Tins or return to 4.7 Chainage Equalities or 4 Tools and

Concepts.
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4.8 Sharing of Models and Tins

See

4.8.1 Share In

4.8.2 Share Out

4.8.3 Share In and Out

4.8.4 Object Tree Object With Shared In and Shared Out Objects
4.8.8 Sharing Cache Folder

4.8.5 Master Share Files

4.8.1 Share In

Models and Tins can be shared into your project from other projects.

What that means is that in your project, you can have models and tins that are not created in your
project, but are copies of the models and tins from the other project.

Project A| gharein Your Project
model a to Your Project model x
. model y
tin s mogell b
i model ¢
tint ~
tinp
Project B tin q
] tinr
model b A tin t
e tinw
tinu
tinv

And when the models and tins are modified in the other project, they can be automatically updated
in your project.

In the pop-up lists for models and tins, the models and tins that have been shared in to your project
are shown in blue.

; Flat List ' Select Madel Object Tree List x|
I B o
Alignment Al [ 12D ARROW LINEMARKING
MESH PAVEMEMT Blue Mountains Express [ 120 FIELD
MESH PAVEMENT ISLAMD [ 120 MESH
MESH PAVEMENT LE3LAT Median [ 12d Fence Preview String
Rail MC40 [ 12d Fence Preview Trimesh

[ ADAC DESIGM SURFACE
[ ADAC SEw COMMECTIONS
[Y 2Dac sEw MHS

cadastral [ aDac sEw PIPES
construction [Y 2DAC s hHS

base

batter outside

If the list is being displayed as a tree and an object includes one or more shared in objects in its
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tree, and no shared out objects (see 4.8.2 Share Out) in its tree, the higher level object is
displayed in blue.

The top of the folder icon is also coloured blue.

01 [ tin SURVEY Object Tree List
O [ tin Test Road
O [ tin WIDEN
O [ tin lees super
O [ trimesh conts
PO e
b0 .
= ] @ Existing
O [Y Contour labels
O Y Contours
O [ Design
[ ] mm COwerlay
PO . sat
[ ] Test
[» (] @ drainage plots

top of the folder icon

H = & 32

Note: the colour denoting shared out models and tins can be changed in the env.4d file. See_
Projects > Sharing or SHARED_BOTH_ELEMENT COLOUR_4D.

To share in models, see 9.8.7.2 Share In Other Models.
To share in tins, see 13.14.16.2 Share In Other Tins.

Continue to 4.8.2 Share Out or return to 4.8 Sharing of Models and Tins.
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4.8.2 Share Out

In a project, which models and tins are available to be shared in to other projects is totally controlled.

This is done by specifying in the project, which models and tins can be shared out and hence
available to be shared in to other projects.

Project A | share out Your Project share in to Project X
model a | from Project A - Project X model a
model y m» model x
tin s moge: b from Your Project tin p
tint model ¢ / tin t
—
Project B ting T~
1 i Project Y
share out s finr
model b from Project B :!n t share in to model a
] - tin w ProjectY
tinu tin
tin v share in to share out tin ,'.)
Your Project from Your Project

In the pop-up lists for models and tins, the models and tins in a project that have been designated as

share out models are shown in

7 Select Model

. i
Flat List B scmon Object Tree List B
| Drainage Cross ~ I:I Trash Model
[ wis POLYGONS
Drape Work Zone Drainage Cross I:I il L

MESH PAVEMENT RSK3A101
MESH PAVEMENT RSK4A101

MESH STRS PAVEMENT Blue Mountains Express
MESH STRS PAVEMENT LE1LAT Median

[ wWaATER RETIC

|:| lee split trimeshes

|:| rmore 30 legends

|:| plot rmodel rmapped
|:| plot rodel unrmapped

G

[ tin B0

If the list is being displayed as a tree and a object includes one or more shared in objects in its
tree, and no shared out objects in its tree, the higher level object is displayed in

The top of the folder icon is also coloured
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E tin SURVEY  Object Tree List
[ tin Test Road

[ tin WIDEM
[ tin lees super top of the folder icon
[ trimes

e ™

[ cROSS SECTIOMS BO1
[ cROSS SECTIONS BOT CO1
[ crOSs SECTIONS COM
[ cROSS SECTIONS CO1 BO1
[ cROSS SECTIONS CO3
[ cROSS SECTIONS DO1 BO1
[ CROSS SECTIOMS RS1OWD

G
I:I CROSE SECTIOMSE RE2DOT j
I Y
Select
[Clear]
[Sarmeas]

Note: the colour denoting shared out models and tins can be changed in the env.4d file. See_
Projects > Sharing or SHARED ELEMENT_COLOUR_4D.

To share out models, see 9.8.7.1 Share Out Models and 6.12.2 Share Manager.
To share in tins, see 13.14.16.1 Sharing Out Tins and 6.12.2 Share Manager.

Continue to 4.8.3 Share In and Out or return to 4.8 Sharing of Models and Tins.
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4.8.3 Share In and Out

It is possible to have Shares of Shares. That is, you share a model or tin in to your project, and

then that model or tin is shared out to another project.

Project A Your Project Project X
model a share in _ model a
_w model y share in to | model x
tins share out ™ model b — | Project X
. - rrojectX ]
tin t from Project A model ¢ share out ) » tinp
from Your Project tint
Project B tin q
tinr Project Y
model b tint model a
tinw
tinu tin
tinv share in to share out tin f
Your Project from Your Project

In the pop-up lists for models and tins, the models and tins that have been shared in to your project,
and then made available to be share out from your project, are shown in mauve. This colour can be
changed in the env.4d file - see _Projects > Sharing.

! Select Model n
ﬂ‘ |

model shared in from another |

project and the shared out T 5|

Alignment Al i
MESH PAVEMEMT Blue Mountains Express
| MESH PAVEMENT ISLAND

model shared in from another project / MESH PAVEMENT LE3LAT Median

Rail MC40

baze

model in the project that are allowed /
to be construction

conts

movie

pad pelygons

Continue to 4.8.4 Object Tree Object With Shared In and Shared Out Objects or return to 4.8
Sharing of Models and Tins.
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4.8.4 Object Tree Object With Shared In and Shared Out Objects

If the list is being displayed as a tree and an object includes one or more shared in objects in its
tree, and one or more shared out objects in its tree, the higher level object is also displayed in
mauve.

The top of the folder icon is also displayed in mauve.

|:| CROSS SECTIOMS BOM Cﬂbbject Tree List
|:| CROSS SECTIONS CN

|:| CROSS SECTIONS CO1 BIM
|:| CROSS SECTIONS CO3

|:| CROSS SECTIONE DM BOM
|:| CROSS SECTIOMS RZ10MD

G
[} cROSS SECTIONS RS2001
b top of the folder icon

( I:I rotes rmodel

[» mm Test

[ @ drainage plots

Select |

[Clear]
[Sarmeas]

Continue to 4.8.5 Master Share Files or return to 4.8 Sharing of Models and Tins.
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4.8.5 Master Share Files

Page 158

Although the models and tins that are shared into a project can be defined for each project, this can
become unwieldy when there are a number of projects sharing in data from a many other projects.

Master share files can be used in these situations.
A Master Share File is a file that contains a list of projects, and for each project, the models and tins
that are to be shared in from that project. There can be more than one master share file.

When a project uses a master share file, all the models and tins listed in all the projects in the
master share file are shared in to the project without each model or tin needing to be shared in
individually.

A project can use one or more master share files, and different projects can use the same master
share files.

So master share files are an easy way to set up a list of models and tins that are be shared in by a
group of projects.

Master share files are created and edited using the Share Out tab of the Share Manager panel.

For a particular project, the Share In tab of the Share Manager panel specifies which master share
files are to be used by the project. See 6.12.2 Share Manager.

Important Note

If a project is listed in a master share file, all the models and tins in a master share file for that
project must be shared out in that project.

That is, a master share file CAN NOT make a model or tin in any project available for sharing out.
This is strictly under the control of each individual project.

So even though a model or tin is listed for a particular project in a master share file, it is only when
the model or tin has been shared out in the project itself, that the model or tin can be share into
another project using the master share file.

For more information on sharing, see 4.8 Sharing of Models and Tins.

Continue to 4.8.6 Direct Share Ins and Master Share Ins or return to 4.8 Sharing of Models and Tins.
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4.8.6 Direct Share Ins and Master Share Ins

Models and tins can be shared into a project in two ways: direct share ins and master share file
share ins (also known as master share ins).

Direct Share Ins need to be done in each project using the options 9.8.7.2 Share In Other Models
and 13.14.16.2 Share In Other Tins.

Master share ins are done using the Share In tab on the Share Manager panel. See 6.12.2 Share
Manager.

Important Note

A model or tin can not be shared in unless it has first been shared out in the project that it is being
shared in from.

Continue to 4.8.7 Synchronising Shares or return to 4.8 Sharing of Models and Tins.
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4.8.7 Synchronising Shares

When models and tins that are shared in to your project are modified in their original projects, the
shared in models and tins in the project need to be updated to match the modified models and tins.

Page 160

Updating the models and tins that have been share in to a project so that they are the same as in
their original projects is called synchronisation.

When synchronising occurs, models and/or tins shared in to the current project are checked to see if
the model or tin has been modified in their original projects since the models or tins were last copied
to the current project. If any model and/or tin has been modified, it is re-copied to the current project

There are a number of options to synchronise models and tins so that the appropriate method can
be used at a particular time.

1. Manually synchronising direct shared in models

Direct shared in models can be manually synchronised at anytime using the option Synchronize
Shared In Models (9.8.7.4 Synchronize Shared In Models). The option allows each shared in
model to be individually synchronised.

2. Manually synchronising direct shared in tins

Direct shared in tins can be manually synchronised at anytime using the option Synchronize
Shared In Tins (6.12.6 Synchronize Shared In Tins). The option allows each shared in tin to be
individually synchronised

3. Manually synchronising all the direct and master shared in models and tins

All the direct shared in models and tins and the models and tins in the master share files used
in the project can be manually synchronised at anytime using the option Sync all shared ins -
direct and MSF.

4. Automatically synchronising shared in models and/or tins at a user specified time interval

Synchronising of shared in models and tins can be automated and done at a user specified
time interval.

The Project Share Settings panel is used to control whether synchronising shared in models and
tins automatically occurs, and if it does, what the time interval is to check for updated models
and/or tins

il Project Share Settings —

Interval to check for updates (sec) |,:|

Suto sync tins

Luto sync models

|® 9 q|= X

Set Finish Help |

The time, in seconds, between checks is given by the environment variable 9.8.7.4
Synchronize Shared In Models. There are also two other environment variables, _
AUTO_MODEL_SYNC_4D and AUTO_TIN_SYNC_4D, to control if synchronization is done or
not done for models and tins respectively.

The three (3) environment variables SHARE_CHECK INTERVAL 4D, _
AUTO_MODEL_SYNC_4D and AUTO_TIN_SYNC_4D are set in the Projects > Sharing
section of the env.4d editor (6.10.2 Create/Edit env.4d).

Sharing of Models.ang
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For more flexibility, the values of the three environment variables can be modified for the
current session using the panel Project Share Settings found at Project =>Sharing =>Settings
(6.12.3 Project Share Settings).

Continue to 4.8.8 Sharing Cache Folder or return to 4.8 Sharing of Models and Tins.
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8 Sharing Cache Folder

NOT YET IMPLEMENTED FOR V15

When models and tins are shared into your project, a copy of the models and tins are copied over
into your project. And each time one of the models or tins is modified in the original project, a new
copy is made in your project.

However when you exit a project, the next time you start the project the models and tins that are
shared into your project may not have changed. Rather than copying the models and tins again, it is
possible to have the models and tins saved in a special folder, called a Sharing Cache Folder, so
they do not have to be copied over again when ever a project is restarted.

There is an environment variable, SHARING_CACHE_4D, which gives the full path name to the
local folder to use as the Sharing Cache Folder.

In the Edit Environment Variables panel, it is the field Sharing cache folder in_Projects > Sharing

| Edit Environment Variables E" = '@
e £ if a folder is given here then local
o SRS caching will occur for sharing
- Files & Folders Auto sync models
[=- Projects
- General |
Macros |
Details | \
Reports
- Trash bin | i
L. Workspace |
- Dongles

Page 162

If Sharing cache folder is left blank then local caching does not occur.

Continue to 4.9 Enabling Long Paths in Windows or return to 4.8 Sharing of Models and Tins or 4_
Tools and Concepts.
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4.9 Enabling Long Paths in Windows

Starting in Windows 10, version 1607, MAX_PATH limitations have been removed from common

Win32 file and directory functions. However, you must opt-in to the new behaviour.

To enable the new long path behaviour, both of the following conditions must be met:

The registry key
Computer\HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Control\FileSystem\Long
PathsEnabled

must exist and be set to 1 (Type: REG_DWORD).

The key's value will be cached by the system (per process) after the first call to an affected Win32
file or directory function.

The registry key will not be reloaded during the lifetime of the process.

In order for all apps on the system to recognise the value of the key, a reboot might be required
because some processes may have started before the key was set.

See

https://docs.microsoft.com/en-us/windows/win32/fileio/maximum-file-path-limitation ?tabs=cmd

Enabling Long Paths in Windows
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Computer\HKEY_LOCAL_MACHINE SYSTEMACurrentControl Set\ Contral\File System

~v @ Cormputer
. HEEY_CLASSES ROCT

HEEY_CURREMNT_USER
v HEEY_LOCAL_MACHIME

.| | BCDODDODOOD

HARDW.ARE

A

SECURITY

SOFTWARE
v | | SYSTEM

. ActivationBroker

ControlSet00

v CurrentControlSet
v Cantral
{77A6DB0F-37EQ-A
AccessibilitySettin
ACPI
ApplD
AppReadiness
Arhiters
BackupRestore
BitLocker
Bitlockerstatus
Bluetooth
Cl
Citriz
Class
CloudDomainlain
ChF
CaDevicelnstallers
COM Mame Arbite
CommoniGloblze
Carnpatibility
CarnputerMarme

Contentindex
CrazhContral
Cryptography
DeviceClasses
DeviceContainerFn
DeviceContainers
DeviceGuard
DeviceMligration
DeviceOverrides
DevicePanels
Dewuery
Diagnostics
DrmaSecurity
EarlyLaunch
Els
Errata
C FileSystem )
lebysternUtilities

GraphicsDrivers

~

=\

Marme Type Data

ab) (Default) REG_SZ tvalue nat sef)
‘.’.'é\l DisableDeleteMaotification REG_DWORD (00000000 (O
‘-’-'cﬂFiIterSuppnrtedFeaturesMode REG_Dh'ORD (b 00000000 ()
‘.‘.'-%fLongPathsEnabled REG_DWORD (00000000 (0))
‘-’-'5] MifsfllowExtendedCharacter8dot3Rename REG_DORD (b 00000000 (T
‘.’.'-%\l MtfsBugcheckOnCorrupt REG_DW'ORD (00000000 (M
‘-’-'cﬂ MifsDisableBdotiMameCreation REG_DORD (00000002 {23
‘.’.'é\thstisableCDrnpression REG_DW'ORD (00000000 (M
‘.’.'.ﬂ MifsDisableEncryption REG_DWORD (00000000 0y
‘.’.'é\lNtstisabIeLast&.ccessUpdate REG_DWORD (xB0000003 (2147483651)
‘-’-'cﬂ MtfsDisablelfsDowngrade REG_DORD (b 00000000 (T
‘.’.'é\l MifsDizableWolsnapHints REG_DWORD (00000000 (O
‘.’.'.ﬂ MifsEncryptPagingFile REG_DWORD (00000000 0y
‘.’.'é\l Mifshemorylsage REG_DWORD (00000000 (O
‘-’-'cﬂ MifshAftZoneResersation REG_DW/ORD (00000000 (0
‘.’.'é\l MifsQuataMatifyRate REG_DWORD (0000010 (3600
‘-’-'cﬂ RefsDisableLasticcessUpdate REG_DORD (00000001 {13
‘.’.'é\l Scrubhode REG_DWORD (00000001 (13
‘-’-'cﬂ IymlinkLocalTolocalBvaluation REG_DORD (00000001 {13
‘.’.'-%\l SyrmlinkLocalToRemoteEvaluation REG_DW'ORD (00000007 (1)
‘-’-'cﬂ IymlinkRernoteToLocalBvaluation REG_DORD (b 00000000 (T
‘.’.'-%\l SyrmlinkRernote ToRernoteEvaluation REG_DW'ORD (00000000 (M
‘-’-'cﬂUdfsCInseSessionOnEject REG_DORD (00000003 {33
‘.’.'-%\l UdfsSoftwareDefectManagerment REG_DW'ORD (00000000 (M
‘.’.'.ﬂWin31 FileSystem REG_DWORD (00000000 0y
‘.’.'6\|WinQSTruncatedExtensions REG_DW'ORD (00000007 (1)

Continue to 4.10 Migration of Projects From Command Line or return to 4 Tools and Concepts.
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4.10 Migration of Projects From Command Line

Lets assume there is a project in
"c:\4d_test\projects\job 1234"

and the project folder is
emu_park.project

1st rename the folder to
emu_park_old.project

then run the command line

"c:\program files\12d\12dmodel\15.00\nt.x64\12d.exe" -create "c:\4d_test\projects\job
1234\emu_park.project" -migrate_offline "c:\4d_test\projects\job 1234\emu_park_old.project”

this will create the V15 project, from the old, and once the migration is finished, 12d will exit.

Note the command line:

"c:\program files\12d\12dmodel\15.00\nt.x64\12d.exe" -create "c:\4d_test\projects\job
1234\emu_park.project” -migrate "c:\4d_test\projects\job 1234\emu_park_old.project”

will also migrate the project, however 12d will continue to run.

Note:

A file called, emu_park_migration_output_window.xml will be created which is the contents of
the output window. This is handy if you are migrating many project as a single batch operation. So
as you can see, for the project folder "emu_park.project", the folder name minus.project is uses as
the stem for the file name. So for the project folder "fred_blogs.project”, the xml file name will be
"fred_blobs_migration_output_window.xml".

Continue to 4.11 Startup Information in Output Window or return to 4 Tools and Concepts.
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4.11 Startup Information in Output Window

The logline group Licensing contains information about the current licensing.

#-1 Important variables

- using PDF_HELP_VIEWER_4D = C:\Program Files\Adobe\Acrobat DC\Acrobat\icrobat.exe
w4 Other variables

- Auto updator skipped because running debug version or already check for update on startup scree
- ECW12d started as service

- using Registry Key "SOFTWARE\MicrosoftWindows\CurrentVersionVipp Paths\12d.exe\15\UserP:

-- Nodes file found <c\12dy15.00\nodes.4d>

-4 File found <d:\unicode.12d\12dmodel\15.004set_upsil2dModel.public.signature>
-4 File found <cA12d\15.00\useridongles.4d>

lngintamdanglo il ad AlAIE Clau s hL ya £
=4 Licensing A
= Current login details
Client 12D Solutions - AWS - NSW
Dongle number 12dc
Days remaining 92
: Network login
2! Special build details
Todays date 27-Sep-2022 23:15:14
Expiry date 01-Jan-2023 21:01:31

Days remaining 95 days 21 hours 46 minutes 16 seconds y
[mﬂm

7

Two sub groups are as below and contains the information:
1) Current login details

Client

Dongle number

Days remaining

Local login, or Network login
2) Special build details

Todays date

Expiry date

Continue to 4.12 Comparing Attribute Data or return to 4 Tools and Concepts.
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4.12 Comparing Attribute Data

The following images have been updated.

i ttribute Data -

P Attribute D x

+ [= Top] Group name |f|.;,wer @

D_l Attribute| Type | Value +

I'i'l 1| type Text rose ¥

| Text d

; 2 | colour X re > .i.

ttribute Data B

" Attribute D x

+ [= rrop] Group name  |flower @

o B | oyer Attribute | Type | Value +

I'i'l 1| type Text rose T
2 |colour  Text white) +

;‘ e

Continue to 4.13 Writing XSLT Files or return to 4 Tools and Concepts.
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4.13 Writing XSLT Files

Page 168

As of C1m, 3 parameters are passed into every XSLT file. These are:
Inbuilt_Parameter_Input_Filename
Inbuilt_Parameter_XSLT_Filename
Inbuilt_Parameter_Output_Filename

Input is the original XML file name to be transformed.

XSLT is the file name of the XSLT.

Output is the file name being output to.

All file names are full paths:

A sample XSLT file showing how to access these parameters follows below. If you did not add these
parameters, you will get errors when attempting to apply the XSLT.

<?xml version="1.0" encoding="utf-8"?>

<xsl:stylesheet xmins:xsl="http://www.w3.0rg/1999/XSL/Transform" version="1.0">
<xsl:output method="xml" indent="yes" />
<xsl:param name="Inbuilt_Parameter_Input_Filename"></xsl:param>
<xsl:param name="Inbuilt_Parameter_ XSLT_Filename"></xsl:param>
<xsl:param name="Inbuilt_Parameter_Output_Filename"></xsl:param>
<xsl:param name="User_Parameter_CEQ"></xsl:param>

<xsl:param name="User_Parameter_CTO"></xsl:param>

<xsl:template name="print_newline">
<xsl:text>&#xA;</xsl:text>

</xsl:template>

<xsl:template match="/">
<out>

<xsl:call-template name="print_newline" />

<xsl:text>Input file </xsl:text>

<xsl:value-of select="$Inbuilt_Parameter_Input_Filename" />
<xsl:call-template name="print_newline" />

<xsl:text>XSLT file </xsl:text>

<xsl:value-of select="$Inbuilt_Parameter XSLT Filename" />

<xsl:call-template name="print_newline" />

<xsl:text>Output file </xsl:text>

Writing XSLT Files

Ty ..;
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<xsl:value-of select="$Inbuilt_Parameter_Output_Filename" />

<xsl:call-template name="print_newline" />

<xsl:text>CEO is </xsl:text>
<xsl:value-of select="$User Parameter CEO" />

<xsl:call-template name="print_newline" />

<xsl:text>CTO is </xsl:text>
<xsl:value-of select="$User_Parameter CTO" />

<xsl:call-template name="print_newline" />

<|--
<xsl:text>CFO is </xsl:text>
<xsl:value-of select="$User_Parameter CFO" />

<xsl:call-template name="print_newline" />

>

</out>

</xsl:template>

</xsl:stylesheet>

Continue to 5 Menus on Views or return to 4 Tools and Concepts.
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5 Menus on Views

There has been changes to the View chapter in the 12d Model Reference manual.
See 5.1 Plan View Menu

See 5.2 Perspective View Menu
See 5.3 Section View Menu
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5.1 Plan View Menu

5.1.1 Single for Values Text, Crosses and Text on Plan Views

The option Draw string numbers has changed from a tick box to a choice box.

i@ Plan 3tring Marmes faor Plan VWiew —

Wiewy |-|

Drawe narmes

Drawy string numbers |Nn string numbers

Draw textstyle data "1 coapn 8

[ qlem ~

-

Plot textstyle data |z

[

Height max (w) |U

o

| default values retrieved

Set | Sizemax| Reset Finish‘ Help |

For Plan String Names

Draw string numbers choice box No strings No string numbers,
All string numbers
String numbers excluding
0 or blank

If No string numbers is selected, then the view does not display any objects assigned a string number.

If All string numbers is selected, then the view displays (?) after the string name, even if string number is
0 or blank.

If String numbers excluding 0 or blank, then the view on display (?) after the string name, but will not
display (?) if the string number is 0 or blank.

Continue to 5.2 Perspective View Menu or return to 4 Tools and Concepts.
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5.2 Perspective View Menu

See 5.2.1 Perspective/Perspective Opengl View Properties

See 5.2.2 Perspective View Settings

5.2.1 Perspective/Perspective Opengl View Properties

P Perspective OpenGL View Properties "1" — X
=] :
.52 Models Marne 1 kg
. Grids Background colour black .
-%¢ Toggle =
-4 Settings Minimurm x 5 e
@ Tin settings Maximum x 12.881 ek
-y Viewsize Minimurm y 2176 =
-4 Eye/Target Maximum y 0.2571 et
- P Sh-ade Minimum z 25 e
- @ Trimeshes Maximum z 28 e
Mumber of elements ] fiz3
MNumber of vertices 14
Number of null vertices ]
Smallest ID 100
Largest ID 100 fiz3

Finish Help

Continue to 5.2.2 Perspective View Settings or return to 5.2 Perspective View Menu or 4 Tools and
Concepts.
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5.2.2 Perspective View Settings

Position of menu:  Perspective View Menu View =>Settings

If the Settings option is clicked rather than moving onto the Settings walking right, then the Toggle menu
from the Toggle walk-right menu is displayed on the screen. The Toggle menu will be described in the
next section (see 5.2.2.1 Perspective Toggle).

The Settings walk-right menu for the perspective view is

Wiewy Settings "30" n S
ee

Crawing engine

Drawing density

Toggle » 5.2.2.1 Perspective Toggle

Culling

Faces

Hide
Continue to 5.2.2.1 Perspective Toggle or return to 5.2 Perspective View Menu or 4 Tools and
Concepts.
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5.2.2.1 Perspective Toggle

Position of menu:  Perspective View Menu =>Settings =>Toggle

Toggle button ﬂ on Perspective View buttons

The Toggle walk right brings up the Toggle perspective view menu with a number of new options:

[ Teggle *" n See
Orbit Toggles 5.2.2.1.1 Orbit Togales

3
Text [on] r
Vertices [off] +
Vertex indices [off] r
»
»
»

£ Values [off]
String names [off]
Attributes [off]
Tin contours [off]
Tin edges [off]
Tin flow [off]

Tin mesh [off]
Draw solid [yes - mixed] » 5.2.2.1.2 Toggle Draw Solid Coloured Faces
Draw edges [no] » 5.2.2.1.3 Toggle Draw Edges

Shade solids [yes - mixed] ¥ 5.2.2.1.4 Toggle Shade Solids

Shade edges [no] b 5.2.2.1.6 Togale Shade Edges

Height rendering [on]
Trimesh texture maps [on] 5.2.2.1.7 Toggle Displaying Trimeshes with Texture Mapping
Polymesh drawing b 5.2.2.1.8 Polymesh Drawing

Drawing density [global] » | 52 2 1.9 Drawing Density Toggle

Extrusions [on] 5.2.2.1.10 Togale Extrusions
1x

2x
Sac
Grid [off]
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5.2.2.1.1 Orbit Toggles

The options on the Orbit Toggles menu allows you to configure what elements are selected with
extrudes when using the perspective orbit option.

Orbit Toggles n

Point Snap [on]
Line Snap [on]
Face Snap [on]
Extrude Snap [on]

Point Snap - When on will allow the picking to snap to points generated by the extrude.

Line Snap - When on will allow the picking to snap to lines generated by the extrude.

Face Snap - When on will allow the picking to snap to faces generated by the extrude.
Extrude Snap - When on will allow the previous 3 options to work. When off all the previous 3
options will be treated as if they were turned off.

Continue to 5.2.2.1.2 Toggle Draw Solid Coloured Faces or return to 5.2.2.1 Perspective Toggle.
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5.2.2.1.2 Toggle Draw Solid Coloured Faces

On Open GL views, solid colour filled faces such as in super pipes, tins, trimeshes, water strings,
and super alignment pipes can be displayed or not displayed.

It is possible to separately define if super pipes, tins or trimeshes are drawn or not drawn.
So the Draw solid menu item has a walk-right menu as well:

e e

Tin mesh [off]

( Drawe solid [yes - mixed]) 3
Draw edges [na] p Drawe solids [yes - mixed] n

Shade solids [yes - mixed] ¥ Global [an]

shade edges [no] *Strings [inherit]
Height rendering [on] Tins [off]

Trirnesh texture maps [off] Trimeshes [inherit]
Polytriesh drawing 2

Crawing density [none]  »

Extrusions [on]

Clicking the Draw solid menu item itself toggles the displaying coloured faces on and off.

Note: This toggle is for the coloured faces but there is also a toggle for the edges of faces. So even
if the faces are not drawn, the edges of the faces can be drawn. See 5.2.2.1.3 Toggle Draw Edges
and 5.2.2.1.5 Drawing Solid Coloured Faces and/or Edges and/or Shade Solids.

Continue to 5.2.2.1.3 Toggle Draw Edges or return to 5.2.2.1 Perspective Togagle.
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5.2.2.1.3 Toggle Draw Edges

On Open GL views, the edges solid colour filled faces such as in super pipes, tins, trimeshes,
water strings, and super alignment pipes can be displayed or not displayed.

It is possible to separately define if the edges of super pipes, tins or trimeshes are drawn or not
drawn.

So the Draw edges menu item has a walk-right menu as well:

o o

Tin mesh [off]

Crawe solid [yes - mixed] »
( Draww edges [naol ) »

Shade solids [yes - mixed] ¥ Draw edges [yes - mixed)] n
Shade edges [no]

Height rendering [on]
Trirnesh texture maps [off]
Polytriesh drawing
Crawing density [none]  »

- .

' Global [on]
Strings [inherit]
Tins [on]
Trimeshes [inherit]

Clicking on Draw edges menu items itself toggles the displaying of edges on and off.

Note:
The colour of the edges can be a set colour, or the edges can be drawn in the colour of the object
that it is an edge for.

[] Perspective Opentl 30 = | = |[#23a] | ] Perspective OpenGL 2D = EER=
=]+ =] ¢ Fla| a2 2 @& 4| 2| @] c| & ® £ éﬂj&ﬂﬂﬂﬂﬂﬂﬂﬂ#ﬂ@%ﬂﬂj

gian!
%‘ Draw solids No
Draw solids No Draw edges Yes

Draw edges Yes Edge colour object colour
Edge colour shade 64 '

The edge colour is set in the file Settings > Edge colour in the view Properties.
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P Perspective OpenGL View Properties "2" - x
=8 2 = -l
e Maodels Drawv face fill wes

Draw face edges WS
Shade face fill no O
= ] ings Shade face edges no O
<@ Tin settings Draw face hatch no [
? Trimesh settings ( Edge coloLLr shade B4 D
3 Wiewwsize =]
L% ByefTarqet Fllin . —
Select
['iew colour]
(Mo colour] )
[Edit]
[Sameas]
[Browse]
il Perspective OpenGL View Properties "30" - s
=-E b B =1
= Models Ciraw face fill no O
HE Grids Drav face edges yes
¥z Toggle Shade face fill wes
qs Shade face edges WEeS
.~/ String settings Draw face hatch no 0
- Tin settings ( Edge colour
=]

This toggle is for the edges of faces but there is also a toggle for drawing the coloured faces.So
even if the edges are not drawn, the solid faces can be drawn. See 5.2.2.1.2 Toggle Draw Solid
Coloured Faces. and 5.2.2.1.5 Drawing Solid Coloured Faces and/or Edges and/or Shade Solids.

For situations where the edges and the solid coloured faces are both drawn, a very dark grey edge
colour works well.

1 [o @ ][=]

=+l el Alaja=lsls &l s 2l elcl8luls
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Continue to 5.2.2.1.4 Toggle Shade Solids or return to 5.2.2.1 Perspective Toggle or 5.2.2
Perspective View Settings.

5.2.2.1.4 Toggle Shade Solids

On Open GL views, solid colour filled faces such as in super pipes, tins, trimeshes, water strings,
and super alignment pipes can be displayed as if there was a sun at a certain angle or position in the
sky.

It is possible to separately define if super pipes, tins or trimeshes are shaded or not shaded.

So the Shade solids menu item has a walk-right menu as well:

e i Crenerm

Draw edges [no] r
@hade solids [yes - mixe@r . .
Shade edges [no] p =hade solids [yes - mixed] n
Height rendering [on] Global [on

Tritnesh texture maps [off] Strings [inherit]

Palyresh drawing ¥ Tins [on]

Drawing density [none] ¥ finaches [inherit]
Extrusions [on]

Tx

Clicking on Shade solids menu items itself toggles the drawing with shading on and off.

Continue to 5.2.2.1.5 Drawing Solid Coloured Faces and/or Edges and/or Shade Solids or return to
5.2.2.1 Perspective Toggle or 5.2.2 Perspective View Settings.
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5.2.2.1.5 Drawing Solid Coloured Faces and/or Edges and/or Shade Solids

There are two important represent.tions of objects that can be displayed, or not displayed, in an
Perspective OpenGL view:

1. objects with solid colour filled faces (super pipes, extrusions, tins, trimeshes, water strings and
super alignment pipes) can have their faces drawn or not drawn.

2. objects can have their edges drawn or not drawn

Often when solid filled faces and edges are both drawn, Shading can be off and the objects are still
very well defined.

Perspective OpenGL Closer =2 | ‘ [7] Perspective OpenGL Closer E@
gﬂj&ﬂﬂﬂﬂﬂgglg "Clolser" I I n gﬂjﬂﬂﬁjﬂgﬁggle "Closer" n

- Text [on] . .
e rtice s [off] Shade solid Yes g Vertices [off]
Wertex indices [off] Draw solids Yes \ Wertex indices [off]
ZWalues [off]
Draw edges Yes

Shade solid Yes
Draw solids Yes
Draw edges No

ZWalues [off] :

String narnes [off] _‘Stnr?g names [off]

Attributes [off] .]'_::Attnbutes [off]

Tin contours [off] Tin contours [off]
Tin edges [on]

Tin edges [on] Tin flow [off]
Tin flow [aff] T'” D“"h? o
[la T [w}

Tipaech [off]

* v rvF v v w
- rF v v w r

Drawy solid [yes - mized] »

Dravy edges [yes - mixed] »

N hade solids [yes - mixed] ¥
| Shade edges [no] 3

| Height rendering [on]

| Trirmesh texture maps [on]

Drawy solid [yes - mixed] #
Drawy edges [no - mixed] »
Shade solids [yes - mixed]
A0 EUOQES [yES
Height rendering [on]
Trimesh texture maps [on]

Palyrresh drawing 3 | Polymesh drawing »
“ Drawing density [nane]  » .E"tawmg density [none]  »
R Extrusions [on] |Extrusions [on]
\\ 1x Tx
.
N 2%
S Ox

Grid [off]

Perspective OpenGL Clozer E\@

I I : : : Perspective OpenGL Closer EI
=\ e | =
. = Toggle "Claser n __" Toggle "Closer”
]S)hade 5011.1(;1 1;1{0 St [on] » Shade solid No R T..:t [o11]
raw solids Yes Vertices [off] v Draw solids Yes Vertices [off]
Draw edges Yes Wertew indices [off] 4 Draw edges Yes Yertex indices [off]
Z‘uf'a|ues [off] 4 Z Walues [off]
=\ String narmes [off] L4 String names [off]
~ Ty Attributes [off] 4

e Attributes [off]
Tirn contaurs [off]
Tin edges [on]
Tir flowe [off]
Tirgre sh [offl
Draw solid [ho - mixed]

N Tin cantaurs [off]
[ Tin edges [on]

~ Tin flow [off]

L Tinumesh [affl
Dravy solid [yes - mixed] ¥
Drawy edges [yes - mixed] ¥
Shade solids [no - mixed] »

SIS Draur edges [yes - mixed] ¥
Shade solids [no - mixed] »

Height rendering [on]
Trimesh texture maps [on]
Palyrmesh drawing »
Drawing density [none]
Extrusions [on]

Height rendering [on]

Trirnesh texture maps [on]
Polyrmesh drawing »
Drawing density [none] »

Extrusions [on]
1x

s
%
Grid [off]
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In the given example, the colour for drawing of the edges was set to a grey colour (pen 018). This
stands out fairly well on most coloured solid faces.

However, it is possible to change the colour that the edges are drawn in and when only the edges
are drawn, it is useful to set the colour to draw the edges as the colour of faces themselves.

Which combination of toggles is best to use depends on what the view is for, the type of objects in
the view, the viewing angle etc.

Examples of the effect of the different settings for a round and rectangular super pipe are:

ctive OpenGL Per super pipes 5 Sh d ld Y EI@ @Per;pedwe OpenGL Per s EE
=[3] 4] 2| 2] af[=] f 212 5O TES TES ]

Draw solid Yes
Draw edges No

Draw solid Yes
Draw edges Yes

o || =]

Perspective OpenGL Per sups E"E

¢| =| 3¢ | #| 2] =1 =]/ Shade solids No

Draw solids No
Draw edges Yes

Draw solids Yes
Draw edges Yes

@ Perspective OpenGL Per sup \EI@

Draw solids Yes
Draw edges Yes
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Note that for edges, the colour of the edges can be a set colour, or the edges are drawn in the colour
of the object that it is an edge for.

For situations where the edges and the solid coloured faces are both drawn, a dark grey edge
colour works well.

o || =

cl8l

o

5
I e P P RV TR A

If only the edges are drawn, then have the edges drawn in the colour of the objects allows different
coloured objects to be more easily differentiated.

[] Perspective Opendl 3D [-=-][ &3] | (] Perspective OpentL 3D ===
Eﬂj&ﬂﬂjﬂa@ﬂﬁgﬁ@gﬂﬂs5ﬂj&ﬂﬂjﬂﬂﬂﬂﬁ%ﬂ@%ﬂy:

Continue to 5.2.2.1.6 Toggle Shade Edges or return to 5.2.2.1 Perspective Toggle or 5.2.2
Perspective View Settings.
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5.2.2.1.6 Toggle Shade Edges

On Open GL views, edges if solid colour filled faces such as in super pipes, tins, trimeshes, water
strings, and super alignment pipes can be displayed as if there was a sun at a certain angle or
position in the sky.

It is possible to separately define if the edges of super pipes, tins or trimeshes are shaded or not
shaded.

So the Shade edges menu item has a walk-right menu as well:

e i | e IERITa e

Draw edges [no] 3

Shade solids [yes - mixed] ¥

“Shade edges [no] k

Height rendering [on] shade edges [no] n
Trirnesh texture maps [0ff] gjopa) [off]

Polyrmesh drawing » Strings [inherit]

Drawing density [none] k... linherit]
Extrusions [on]
1x

Trirneshes [inherit]

Clicking on the Shade edges menu item itself toggles the drawing edges with shading on and off.

Continue to 5.2.2.1.6 Toggle Shade Edges or return to 5.2.2.1 Perspective Toggle or 5.2.2
Perspective View Settings.
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5.2.2.1.6.1 Toggle Height Rendering

When Height rendering is toggled ON (the default), the height map texture is applied to the data on
the view. This will not apply to a tin if the tin has its own tin render settings. In that case, the tin’s
height render settings are used. See 11.6.3 Tin Height Render Settings

When Height rendering is toggled OFF, the height map texture is NOT applied to the data on the view.

For information on setting the view height render settings for a view, see 11.6.4 View Height Render
Settings.

In the example below, the height map texture $Lib\height rainbow.png is used for each view.

[7] Perspective OpenGL 11 [[= |F= |[@3a 7] Perspective OpenGL 11 [r=e] =3
=]+ =[] 4] 2] 9[=] 2| | &] ] 2] S | & Wl & x| (=] + =] 2] ¢] 22| | =] (] &| 3] 3| 9| c| o] @ B x|

Height rendering ON and
no tin height renderings

For an example with view height rendering ON but with a Tin with its own tin height rendering, see _
More Height Rendering Examples.

Continue to 5.2.2.1.7 Togale Displaying Trimeshes with Texture Mapping or return to 5.2.2.1
Perspective Togale or 5.2.2 Perspective View Settings.
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5.2.2.1.7 Toggle Displaying Trimeshes with Texture Mapping

When Trimesh texture maps is toggled ON (the default), the mapping of colours to textures is applied
to the faces of the trimeshes.

When Trimesh texture maps is toggled OFF, the mapping of colours to textures is NOT applied to the
faces of the trimeshes.

In the example below, the colour cyan is mapped to the texture Grass1

@ Perspective OpenGL 3D EI@
=]+ =3 o] 2|~ e ol el mlal o] «

Wertex indices [off]
ZValues [off]
String narnes [off]
Attributes [off]
Tin cantours [off]
Tin edges [off]

: Tin flowe [off]
Trimesh texture maps ON AN

Drawe salid [yes - mixed] »
Draw edges [no] 3
g chade solids [yes] 3
Shade edges [no] 3

Trimesh texture maps [on i

Palyrmesh drawing 3
Drawing density [none] »
Extrusions [on]

@ Perspective OpenGL 3D EI@
=+ =l elmlaalm e v = elc8lnlolx

Text [on]

Wertices [off]
Wertex indices [off]
ZValues [off]
String narnes [off]
Attributes [off]
Tin cantours [off]
Tin edges [off]
Tin flowe [off]

Tin mesh [off]
Drawe salid [yes - mixed] »
Draw edges [no] 3
I Shade solids [yes] 3
2 Shade edges [no] 3

Trirnesh texture rmaps [off] -

Polyrmesh drawing 3
Drawing density [none] »
Extrusions [on]

v T vrowow

Trimesh texture maps OFF

Grid [off]

Continue to 5.2.2.1.8 Polymesh Drawing or return to 5.2.2.1 Perspective Toggle or 5.2.2 Perspective
View Settings.
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5.2.2.1.8 Polymesh Drawing

Palymesh Drawing Toggle n

Polyfaces [an]
Man-Planar Triangles [off]
Triangles [on]

Marred Edges [off]

The three toggles on the Polymesh drawing walk-right menu Polymesh Drawing Toggle are:

Polyfaces - when toggled on, the boundary polygon of any planar polyfaces are drawn on the view.
This probably should say Planar polyfaces.

Non-Planar Triangles - when toggled on, the boundary polygon of any non-planar polyface, plus
the enclosed triangles of the non-planar polyfaces, are drawn on the view. This probably should be
Non-planar polyfaces and internal triangles.

Triangles - when toggled on, the triangles that are not polyfaces are drawn on the view.

So to see all the components that are contained in a polymesh, you need all three toggled on.

In the image below, the polymesh in view 3 consists of a non-planar face on the top (cyan) and a
planar face on the bottom.

o || == - = 3 = = 2

JJJJJJJJIJJEJ

JJJJJJJJJJJEJJJJJJE JJJJJJJJIJJEJ

Polyfaces [on] Palyfaces [off]

Nen-Planar Triangles [on]
Triangles [off]

Non-Planar Triangles [off]
Triangles [off]

o [=@ =

JJJJJJJJIJJ&JJ

o [@ =

JJJJJJJJIJJ&JJ

[7] Perspective Openal 6

JJJJ.JJﬂ ;nlyfa:as on]

on-Planar Triangles [off]
Triangles [off]

Polyfaces [off]
Non-Planar Triangles [off]
Triangles [on]

Polyfaces [on]
Non-Planar Triangles [on]
Triangles [on]

¥ Trimesh from 30 Planar Polygons ~ —

Data to create from

(2] | @ | o] o] 9|2
A==

Model

Use point id as vertex name

Use segment text as edge name

Use string colour as face colour

Create polymesh
—

Timesh colour [oan

Timesh model [

So in view 3 Copy 2 which has only Polyfaces turned on, you only see the bounding polygons of
the top and the bottom of the object.

In view 3 Copy which has only Non-Planar triangles turned on, you only see the bounding
polygon of the top and its triangle decomposition.

In view 3 Copy 3 with only Triangles turned on, you only see the triangles that are not polyfaces
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which is how the sides of the object were constructed.

In view 3 Copy 4, Polyfaces, Non-Planar triangles and Triangles are all turned on so you can
see all the triangles that make up all the polyfaces of the polymesh.

For the definition of a polymesh, see 3.7.3.2 Polymesh.

Continue to 5.2.2.1.9 Drawing Density Toggle or return to 5.2.2.1 Perspective Togale or 5.2.2
Perspective View Settings.
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5.2.2.1.9 Drawing Density Toggle

When Drawing density is set to None, Drawing Density is not used for the view.

When Drawing density is set to View the values from the View Drawing Density panel for the view are
used. See 8.8 View Drawing Density.

When Drawing density is set to Global, the Drawing Density is taken from the environment variables
used when the project is opened.

Changing the Drawing Density toggle also updates the Mode on the View Drawing Density panel
(8.8 View Drawing Density).

@ Perspective OpenGL 2 EIE
B | =] & %] % @] A& & 2] wlolalalvlalalml =] % o]

Drawing Density [View]
Wertex indices [off]
Zalues [off]

String narnes [off]

[ —
E-
ﬁ Dravy solid [yes - mized] »
Draw edges [no] 3
Shade solids [yes - mixed]
.IShade edges [no] 4
r

;nght rendering [on]

ﬁr} ___.,..W | ”‘IlTrlmesh texture maps [on]

* T rF v v w

| JPonmesh drawing 3

(Drawmg density [global] D = ) )
Extrusmns [on] Drawing Density Toggle n

Glabal [an]
Wi

/SX
Grid [off]

Mane

@ Perspective OpenGL 2

Bl 2| =@ < % & 4| %| & #) & &) 2] @] <| 2|2 H] 71| |2

Continue to 5.2.2.1.10 Toggle Extrusions or return to 5.2.2.1 Perspective Toggle or 5.2.2
Perspective View Settings.
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5.2.2.1.10 Toggle Extrusions

12d Model super string extrusions are created in a number of ways:

(a) super string as a round pipe

(b) super string as a rectangular pipe
(c) super string with a 2D super string (with and without holes) swept along the super string
(d) super string with multiple extrusions

Round and rectangular pipes are special cases of (c) but because they are easily defined with a few
parameters, they exist as special cases of the super string. Similarly multiple extrusions includes (c).

In each case there is only one super string which is called the spine of the extrusion.

When the Extrusions toggle is set to on, the extrusion is drawn on the view

When the Extrusions toggle is set to off, only the super string spine of the extrusion is drawn on the
view

B e BisElL =l == | 7
B¢ =@l %@ 2 k| e g8 3 4]0 <|a|o| B x[2| | B £ =% a2 el g E .

Extrusions toggle ON

. ) round super string pipe
rectangular super string pipe

super string with multiple extrusions

B¢ =@ ¢ & ald] &) 56 3] 20| <|sla@| | *|2] |IBE 2 =|alwx|aalx el s)§ s

Extrusions toggle OFF
rectangular super string pipe spine

round super string pipe spine

spine of super string with multiple extrusions

Continue to 5.3 Section View Menu or return to 5.2.2.1 Perspective Toggle or 5.2.2 Perspective

View Settings.
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5.3 Section View Menu

5.3.1 Section View Properties

There are now more choices on the Annotations tab on the Section View Properties panel for setting
what is displayed in the Section View for the Horizontal and Vertical geometry.

P Section View Properties "3" - X
=-B8 3 =
g Models Show super alignment geormetry horizontal and wertical -
- H Grids Text style 1 T
-4 Settings Wiew text height (pixel) 1Q e
Annotations Plat text height (ram) 2.5 e
(] Corridar Text colaur cyan
(] Profile extend Arrowe colour green .
0 Profile HG view arrow height (pixel) 3 e
= ‘Jiewsize HiE plot arrow height (ram) 1.5 e
a Viewpart HG draw tangent length no O
HG draw arc length no O
HG draw tangent bearing no ]
WG e arrow height (pixel) 3 e
W& plot arrow height (mm) 1.5 e
WG drawr grades as ane in no O
WG drawe tangent length no ]
WG drawe curee radiusfbvalue no annotations i
=]
Showw super string grade no O
=]
Show HGL wes
HGL colour cyan
Show surface HGL wes
Surface HGL colour wellow
Finish Help |

Continue to 6 Project or return to 5.3 Section View Menu.
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6 Project

There has been changes to the Project chapter in the 12d Model Reference manual.
The V14 menu pinned menu was called Projects and in V15 this has been renamed to Project.

Project n

Managers 3 The Managers menu from Management
Recent projects 3 6.1 Recent Projects - New Instance
Recent project (hew instance)

Open

Mew

12d Synergy 2

Check base points

Details r

hanagerment 3 6.3 Management
harkup 6.4 12d Markup
Restart

Settings 6.5 Project Settings
Sharing 3 6.6 Project Sharing
Sawve

Tree

Utilities 3

Themes 3 6.2 Themes

Delete

12d Model 3

User »

Exit

See 6.1 Recent Projects - New Instance
See 6.2 Themes
See 6.3 Management

6.3.1 Create/Edit env.4d

6.3.2 Projections

6.3.3 Create/Edit N-Value Definitions
See 6.4 12d Markup
See 6.5 Project Settings
See 6.6 Project Sharing
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6.1 Recent Projects - New Instance

Position of option on menu: Project =>Recent projects (new instance)

Walking right on the Project =>Recent project (new instance) lists the projects recently accessed
by 12d Model.

“f 12d Model 15 "tanks"

Project | File View Medel String EBIM  CAD Tin Survey Design  Water VDVC”CKOI"I here to bring upthe
[FE sl ﬂ| red ﬂw ﬂ“ KOpenaRecent Project paneD

EEHHBEH: EB0rLEXDEPFEL
DT AR M 7 Al

| Recent project (new instance) D| Recent project (new instance)

-

Managers

-

Recent projects

@ Open CA12d415.000 courses\test\tanks.project

C:A12d\15.00 courses\test\dam.project

12d Synergy ' C\12d\15.000 courses\drainage\stormwater_part_T.project —|— Clickon a project
Check base points name to open the

Details project

5 MNew |

CA12d\Project\Survey Survey.project

= % w8

Management
Markup
Restart
Settings

[ T w— S, |
&6

Sharing
L Save

Clicking on a project in the list will start a new instance 72d Model and open the project selected
project. The existing instance of 712d Model with the current project will still be left open.

Clicking on the Recent Projects heading on the Main Menu or on the Recent projects item when
the Projects menu is pinned up, brings up the Open a Recent Project panel which shows the recent
project list.

The list of recent projects is shared between all versions of 72d Model.and is recorded in the file
"Recent Projects.4d" stored in the folder %APPDATA%. See 3.2.7 Recent Projects List.

Continue to 6.2 Themes or return to 6 Project.

Page 192




What’s New in 12d Model 15

6.2 Themes

Position of option on menu:  Project =>Themes

The Themes option changes the Theme being used for 12d Model.

Selecting a new Theme from the Themes menu removes all the menus and toolbars for the current
Theme and replaces them with the selected Theme.

2@ 12d Model 15 "tanks" Volumes Plot Report Utilities User Help
Project | File View Model String BIM  CAD Tin | Survey Design  Watel = | §| [Meo]
[ Project ] ﬂ| red !| 0 ﬂ[_v B oA s R wmP éal €8 Standard Theme
Managers vE =, 5, [, =, ‘E. RS 'g\ [F5 d | | @@ Design Theme
Recent projects P'ﬂ’?ﬂ’TM | & Survey Theme
Recent project (new instance) 4 ~ 1 = 2 WaterTheme
- jﬂmﬁﬂ & 12dField Theme
e DEREEOORY | € coner
‘ ‘E ’ =] @ BIM Theme
¢ 12d Synergy 4 . # Tin Theme
f Check base points -
i 1 Classic Theme
i Details 3
Management >
e Markup
@ Restart Clicking on existing Theme name
&y settings n the Main menu
é Sharing ¥ Plan 1
[ b Save
Tree
FI Utilities 3
| Themes Y| [Themes] Project =>Themes =>Load themes
Delete IM [ Load Themes ]
1 [i2dMocs ' ip Classic Theme
E ::i:r i’ wp Meo Theme
= £ Standard Theme
5, I @ Design Theme
o‘ E4l Survey Theme
i, & Water Theme
v &% 12d Field Theme
e, & Cad Theme
e & BIM Theme
'y G Tin Theme

Continue to 6.3 Management or return to 6 Project.
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6.3 Management

There has been the following additions to the Project Management menu:

Project Managernent n

Details editar

e dd .
Project settings file editor ~ 6.3.1 Create/Edit env.4d

Erv configuration
Dangles
Projections

M walues

T pararneters
Workspace

6.3.2 Projections
6.3.3 Create/Edit N-Value Definitions

v T v v v w

Custom menus
Tags

Tree

Managers r
Forest files

Trash hin

Project prewiew

Show startup loglines
Toggle drawing density
Toggle toprnost buttons
12d cloud usage

12d usage

Enable all widgets
Delete aptions log files
Old 3
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6.3.1 Create/Edit env.4d

Position of option on menu:  Project =>Management =>env.4d

Selecting env.4d displays the Edit Environmental Variables panel.

il Edit Environment Variahles

- Eneedd

... General

H- Files & Falders
- Projects

i- Dongles

f]- Elernents

7 CAD

/- Plotting

- BUpEy

.. Drainage

@.. MTF & Boxing
- Tunnel

[ Wiews

- GUI

- W¥arnings and Error Reporting
GBS

- External &pps
- 12d Synergy

- Wariables

(OO e IO e OO s O o O

Show convert chainages to dropped xy in ’Edit now’ menu tick box ticked

If ticked, when RB on the row number column in the template modifiers edit panel the option to convert the
highlighted chainage/s to Drop Point to Reference String smart chainages will be shown.

il Edit Ervvironment Variables

= Ereedd

- General

i Files & Folders
i Projects

H- Elernents
/- CAD

- Plotting
L Survey

E
[
- Dongles
[#
[#
E

- Drainage

- MTF & Boxing
- Tunnel

[+ Wiews

( - GUI >
- Wfarnings and Error Reporting

. (315

[+ External &pps
- 12d Synergy
- Wariables

GUI > Topmost buttons

Use topmost buttons tick box
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If ticked, topmost buttons will be displayed.

Visible buttons/text input default blank
The list of buttons and screen text for the buttons to display.

Position choice box

What’s New in 12d Model 15

If basic orientation of the buttons, vertical left/right or horizontal from top of screen.

Side offset integer box
If not blank, the offset from the left/right of the screen.

Top offset integer box
If not blank, the offset from the top of the screen.

Button width integer box
If not blank, the width of the button.

Button height integer box
If not blank, the height of the button.

Gap between buttons integer box
If not blank, the gap between buttons.

Transparency (0-255) integer box
If not blank, the transparency applied to the buttons.

Continue to 6.3.2 Projections or return to 6.3 Management or 6 Project.
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6.3.2 Projections

Position of option on menu:  Project =>Management =>Projections

In 12d Model 14, the list of projections that could be selected were defined in the one file carto.4d
which was searched for in the standard user search order Working folder, Customer User folder
(if it exists), User folder and finally set_ups folder. As soon as a carto.4d was found, that one file
was used and the search stopped.

This meant that if users wanted to add their own projections, or not include some that are in the
shipped carto.4d in set_ups, users had to create their own carto.4d and place it in one of Working
folder, Customer User folder (if it exists), or User folder.

This has been changed for 12d Model 15.

In 12d Model 15, carto.4d has been replaced by a new file carto.12dcarto which has more
information about the projections than in carto.4d.

However the major difference is that the projection list is no longer coming from just the one file, but
is accumulated from the carto.12dcarto files in Working folder, Customer User folder (if it exists),
User folder and set_ups folder.

And if there is a projection of the same name, the one in Working folder takes priority over the one
in Customer User folder, which takes priority over the one in User folder, which takes priority over
the one in Set_ups folder.

Finally because of the accumulation, the projections in set_ups are always be included and so to
limit the projections from set_ups appearing in the projection list, there are filters to restrict the ones
that are included.

Consequently you no longer need to touch the carto.12dcarto file in set_ups.

Similarly there are filters for the ones from the Working folder, Customer User folder and User

folder.

Projections n See
Projection editor 6.3.2.1 Projection Editor
Set projection 6.3.2.2 Set Projection
Clear projection 6.3.2.3 Clear Projection

Convert projection 4d to 12dcarto . 6.3.2.4 4 Convert projection 4d to 12dcarto
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6.3.2.1 Projection Editor

Position of option on menu: Project => Management => Projections => Projection editor

The Projection File Editor edits the 12dcarto files in either the Working folder, Customer User
folder (if it exists) or the User folder. No file can be edited in the set_ups folder.

However in the editor, projections in the set_ups folder can be copied into files in the other folders.

Selecting Projection editor brings up the Projection File Editor panel.

P Projection File Editar - *

«Working folder - NO FILE
- User - MO FILE
- Setups (read-only)

| | R
Set Wirite Preview: Finish Help
The fields and buttons used in this panel have the following functions.
Field Description Type Defaults Pop-Up

Custom projection .12dcarto file box *.12dcarto files

A custom 12dcarto file can be imported for editing by using this file box.
Read button

Read in the custom projection file.
See 6.3.2.1.1 Root Folder.
See 6.3.2.1.2 Group of Projections.

See 6.3.2.1.3 Projection.
See 6.3.2.1.4 Special Functionality.

6.3.2.1.1 Root Folder

If any folder is selected, the panel will display as:

The fields and buttons used in this panel have the following functions.
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b Working folder Details and Includes
- MGAS4 = e
™ E| MGA2020 File name Ui\projects\15.04TD-2251%\data\... [ap]
5 - MGA2020 Zone 47 B
- MGAZ2020 Zone 43 Enable Working Folder yes [ ]
- MGA2020 Zone 49 Enable Customer Folder yES a
- MGA2020 Zone 50 Enable User Folder yes -]
- MGA2020 Zone 51 Enable Setups Folder yes -]
- MGA2020 Zone 52 j
. MGA2020 Zone 53 Included 12dcarto files ﬂ
.- MGA2020 Zone 54 1 ﬂ
.. MGA2020 Zone 55
- MGA2020 Zone 56 E
.. MGA2020 Zone 57 3
- MGA2020 Zone 58 = |
- Customer (User)
.. User Inclusion filters
=g S:Et ups (read-only) Customerl User l Setups l
Filters - Working folder |
MGA2020 Zone 47
MGA2020 Zone 48
Western Australia Project Grid
Western Australia Project Grid MGAZIAN Zane 29
- Western Australia Project Grid MGA2020 Zone 50

| 5] Read|
Set Write Preview Finish Help

Field Description Type Defaults Pop-Up
Details and Includes

File name text box

Showing the path to the file's location.

Enable Working Folder tick box ticked
If'ticked, all Projection from Working folder will be included in Projection choice box pop-up (Projection
Box).

Enable Customer Folder Folder tick box ticked
If ticked, all Projection from User folder will be included in Projection choice box pop-up (Projection
Box).

Enable User Folder tick box ticked
If ticked, all Projection from User folder will be included in Projection choice box pop-up (Projection
Box).

Enable Setups Folder tick box ticked

If ticked, all Projection from Setups folder will be included in Projection choice box pop-up (Projection
Box).

Note: See 6.3.2.1.4 Special Functionality for more detail on Enable/disable each folder.

Inclusion Filter

Filter - Working folder search box

If filled, Projection Box will only include those projection from Working Folder that contain the filled
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content.

Filter - User folder search box
If filled, Projection Box will only include those projection from User Folder that contain the filled content.
Filter - Setups folder search box

If filled, Projection Box will only include those projection from Setups Folder that contain the filled
content.

Filter - Customer folder  search box
If filled, Projection Box will only include those projection from User Folder that contain the filled content.
Buttons
Set button
Select this button after any change to the panel so set change.
Write button
Permanently saves all changes to the file.
Preview button

Bring up Preview Projection Choices panel to check the origin of each projection in the choice box pop up
Projection Box.

Note: see 6.3.2.1.4 Special Functionality for more detail on Preview Projection Choices panel.

Finish button

Finish editing, close down the panel.

Note: The file is structured as a tree where the top node is the file itself. The top node can have 2
types of children as 6.3.2.1.3 Projection and/or 6.3.2.1.2 Group of Projections.

Continue to 6.3.2.1.2 Group of Projections or return to 6.3.2.1 Projection Editor or 6.3.2 Projections.
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6.3.2.1.2 Group of Projections

When selecting a group the panel will display:

El Working folder E

i Narme MGA2020 b
28 MGA2020

.. MGA2020 Zone 47

- MGA2020 Zone 48
.. MGA2020 Zone 49
- MGAZ2020 Zone 50
- MGA2020 Zone 51
- MGA2020 Zone 52
- MGA2020 Zone 53
.. MGA2020 Zone 54
- MGA2020 Zone 55
- MGA2020 Zone 56
- MGAZ2020 Zone 57
.. MGA2020 Zone 58
- Customer (Uszer)
- User
(- Set ups (read-only)

X o J B o4

The fields and buttons used in this panel have the following functions.

Field Description Type Defaults Pop-Up
Name text box
The name of the group.

Note: Each of the group of projections node also has 1 or many 6.3.2.1.3 Projection.

Continue to 6.3.2.1.3 Projection or return to 6.3.2.1 Projection Editor or 6.3.2 Projections.
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6.3.2.1.3 Projection

Selecting Projection displays the Project Flle Editor panel:

What’s New in 12d Model 15

» E E=E=T
h E--Workingfolder | =]
- MGAGS Group MGAZ020 [akd
G| @ & mcaz020 Name MGA2020 Zone 56 ]
By - MGA2020 Zone 47 Description [abd
. MGA2020 Zone 48 EPSG code 7856 e
X - MGA2020 Zone 49 ESRI WKT PROJCS["GDA2020_MGA_Zone_36",... [Bd
- .. MGA2020 Zone 50 150 code =]
- MGA2020 Zone 51 IFC code [abd
& - MGA2020 Zone 52 Maplinfo 8, 1028, 7, 153, 0, 0.9996, 500000, 10... [h]
e . MGA2020 Zone 53
o emozeness M I =
D es.mp.ﬁorl e
- MGA2020 Zone 57 Projection zone 56
 MGAZ020 Zone 58 Projection hemisphere south k4
& Custorner (User] Scale factor - optional 0.8996 Jef
& User EPSG code 7836 [ahd
G- Set ups (read-only) ESRI WKT PROJCS["GDA2020_ MGA _Zone_56",.. 8]
150 code [abd
IFC code e
Mapinfo aq
Type k4
Semi-major axis Jut
Reciprocal flattening(1/f) Jef
Description [ad
b
fsbg
b
b
ST
Name [abd
Description [ad
M Value interpolation method Mone -
EPSG code [abd
£ )
150 code [abq
IFC code B
Mapinfo [ad
|
| G| Rex
| is valid

=1

Preview

Finish

Help

When clicking on a projection on the left hand side, information about the selected projection is

displayed on the right hand side of the panel.

The area on the right hand side are:

(a)

(b)

General

General information about the projection. See _General for more information.

Map Projection
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Information about map projection type used in this projection. See Map Projection for more
information.

(c) Horizontal Datum

Information about ellipsoid used in this projection. See_Horizontal Datum for more information.
(d) Vertical Datum

N value interpolation method used in this projection. See Vertical Datum for more information.

Depending on the type of ellipsoid and map projection, different fields need to be filled in.

General

=
Group MGA 2020 =]
Name MGAZ020 Zone 55 H
Description [abq
EPSG code 7855 [abid
ESRI'WKT PROJCS["GDA2020_MGA_Zone_35",.. [bd
150 code [abd
IFC code [abq
Maplnfo 8, 1028, 7, 147, 0, 0.9996, 500000, 10... @&
The fields and buttons used in this panel have the following functions.
Field Description Type Defaults Pop-Up

Group name box optional
Name of group where this projection belongs to.

Name name box
Name of projection (must be unique).

Description text box optional
Description of the projection.

EPSG code text box optional
The EPSG code for this projection.

ISO code text box optional
The ISO code for this projection.

ESRI WKT text box optional
The ESRI WKT format for this projection.

IFC code text box optional
The IFC code for this projection.

Map Info text box optional

Maplnfo for this projection.
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p Projection
There are 4 supported types, 1 General type to support manual input of proj strings and 1 None
type to show all available supported parameters.

4 supported types are:
Transverse Mercator - see Transverse Mercator
UTM - see UTM
RSO - see RSO
Lambert Conformal - see Lambert Conformal

See Generals for information on General type.
See None Type for information on None type.

Transverse Mercator
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=
Map projection type Transverse Mercator

Description

a
=
m
m
o
Lny
3]

The fields and buttons used in this panel have the following functions.
Field Description Type Defaults Pop-Up

Origin latitude (dms) angle box optional

Latitude of projection centre (+lat_0). If blank, default to 0.0

Origin longitude (dms) angle box optional
Longitude of projection centre (+lon_0). If blank, default to 0.0

False Easting double box optional
False easting (+x_0). If blank, default to 0.0

False Northing double box optional
False northing (+y_0). If blank, default to 0.0

Scale factor double box optional

Scale factor used in the projection (+k_0).
If blank, default to 1.0

EPSG code text box optional

Management

What’s New in 12d Model 15

EEEEETEE & E <




What’s New in 12d Model 15

The EPSG code of the projection.

ESRI WKT text box optional
The ESRI WKT format of proj for this projection.

ISO code text box optional
The ISO code of the projection.

IFC code text box optional
The IFC code of the projection.

Mapinfo text box optional
Maplnfo of the projection.

For more information about Transverse Mercator, see https://proj.ora/operations/projections/
tmerc.html.

UTM

Map projection type UTM
Description

Projection zone 56
Projecticn hemisphere north

EEEEET 4 EE 4

The fields and buttons used in this panel have the following functions.
Field Description Type Defaults Pop-Up
Projection zone angle box optional
The UTM zone (+zone). Value can be from 1 to 60.
Projection hemisphere choice box north North, South
The hemisphere of which the projection is on.
Scale factor double box optional

Scale factor used in the projection (+k_0).
If blank, default to 0.9996.

EPSG code text box optional
The EPSG code of the projection.

ESRI WKT text box optional
The ESRI WKT format of proj for this projection.

ISO code text box optional
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The ISO code of the projection.

IFC code text box optional
The IFC code of the projection.

Mapinfo text box optional

Maplinfo of the projection.

For more information about UTM projection, see htips://proj.org/operations/projections/utm.html.

RSO
The editor can only handle Central point and azimuth method. For the use of Two point method,

please use General type to manually input required parameters.

]
Map projection type RS0 7
Description labq
Origin latitude{dms) 4 .
Origin lengitude(dms) 115° S
Rectified skew azimuth(dms) 33° ﬁg;
Projection centre longitude(dms) .
False easting Jef
False northing J;
Scale factor e
EPSG code labq
ESRIWKT labg
150 code labq
IFC code labd
Mapinfo kg

The fields and buttons used in this panel have the following functions.
Field Description Type Defaults Pop-Up
Original latitude (dms) angle box optional
Latitude of central point (+lat_0).
Original longitude (dms) angle box optional
Longitude of central point (+lonc).
Rectified skew azimuth (dms) angle box optional
Azimuth of centreline clockwise from north at the centre point of the line (+alpha).
False Easting double box optional
False easting (+x_0). If blank, default to 0.0
False Northing double box optional
False northing (+y_0). If blank, default to 0.0

Scale factor double box optional

Scale factor used in the projection (+k_0).
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If blank, default to 1.0

EPSG code text box optional
The EPSG code of the projection.

ESRI WKT text box optional
The ESRI WKT format of proj for this projection.

ISO code text box optional
The ISO code of the projection.

IFC code text box optional
The IFC code of the projection.

Mapinfo text box optional

Maplnfo of the projection.

For more information about RSO, see https://proj.ora/operations/projections/omerc.html.

Lambert Conformal

B
Map projection type Lambert Conformal
Description
First standard parallel{dms) 33°

Second standard parallel{dms)

Origin lotitude(dms)

m

Origin longitude(dms)

=]

L
[5€ easTIng

EEEEETT M bbb E

The fields and buttons used in this panel have the following functions.
Field Description Type Defaults Pop-Up
First standard parallel (dms) angle box optional
First standard parallel (+lat_1).
Second standard parallel (dms) angle box optional
Second standard parallel (+lat_2). If blank, default to 0.0.
Origin latitude (dms) angle box optional
Latitude of projection centre (+lat_0). If blank, default to 0.0
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Origin longitude (dms) angle box optional

Longitude of projection centre (+lon_0). If blank, default to 0.0

False Easting double box optional
False easting (+x_0). If blank, default to 0.0

False Northing double box optional
False northing (+y_0). If blank, default to 0.0

Scale factor double box optional
Scale factor used in the projection (+k_0). If blank, default to 1.0

EPSG code text box optional
The EPSG code of the projection.

ESRI WKT text box optional
The ESRI WKT format of proj for this projection.

ISO code text box optional
The ISO code of the projection.

IFC code text box optional
The IFC code of the projection.

Mapinfo text box optional

MaplInfo of the projection.

For more information about Lambert Conformal, see https://proj.org/operations/projections/lcc.html.

Generals

B
Map projection type General
Description
Projection parameters +proj=omerc +lat_1=45 +lat_2=55
EPSG code
ESRI WKT
IS0 code

I ]
IFC code

EEEEEEEJ

Mapinfo

The fields and buttons used in this panel have the following functions.
Field Description Type Defaults Pop-Up
Projection parameter text box optional

Contains the proj string for any unavailable projections in 12d Model.

EPSG code text box optional
The EPSG code of the projection.
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ESRI WKT text box optional
The ESRI WKT format of proj for this projection.

ISO code text box optional

The ISO code of the projection.

IFC code text box optional

The IFC code of the projection.

Mapinfo text box optional

Maplnfo of the projection.

None Type
None type shows all available parameters within 72d Model. However, if None type is used, 12d
won't be able to generate proj string from input parameters. Please use General type for any
unavailable types.

Map projection type Mone

Description

olse northing
Projection zone

projection hemisphere undefined

EEEEET 4 BT S5 085%EEJ
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Horizontal Datum

B
Type GRS580 4
Semi-major axis 6378137 Jaf
Reciprocal flattening(1/f) 298.257222101 Jef
Description labd
EPSG code [abd
ESRI WKT )
150 code [abd
IFC code abq
Mapinfo hd
The fields and buttons used in this panel have the following functions.
Field Description Type Defaults Pop-Up
Type choice box Airy1830,
Airy1839(Modified)
ANS, GRS80

International 1924(aka Hayford 1909)
NZ Geodetic 1949(Adjusted)
Timbalai Everest 1830(Modified)
Everest 1830(1967 Definition)
WGS72, WGS84, Custom

if Custom is chosen, Semi-major axis and Reciprocal flattening can be defined by user.

If other ellipsoids are chosen, the parameters for that ellipsoid are displayed in Semi-major axis and
Reciprocal flattening.

Semi-major axis double box read only
If Custom is selected, read-write is enabled.

Reciprocal flattening (1/f) double box read only
If Custom is selected, read-write is enabled.

EPSG code text box optional
EPSG code of the ellipsoid.

ISO code text box optional
ISO code of the ellipsoid.

ESRI code text box optional
ESRI WKT of the ellipsoid.

IFC code text box optional

IFC code of the ellipsoid.

Map Info text box optional
Mapinfo of the ellipsoid.
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Vertical Datum

=
Name @
Description [ad
N Value interpolation method Maone e
EPSG code [abq
ESRIWKT g
IS0 code [ad
IFC rode aiag
Mapinfo [abd
The fields and buttons used in this panel have the following functions.
Field Description Type Defaults Pop-Up
N value interpolation method choice box optional all defined N values

N value interpolation method for projection. The choices can be setup using N value settings.
EPSG code text box optional EPSG code
The EPSG code of the vertical datum.

ISO code text box optional ISO code
The ISO code of the vertical datum.

ESRI code text box optional ESRI code
The ESRI WKT format of proj for this vertical datum.

IFC code text box optional IFC code
The IFC code of the vertical datum.

Map Info text box optional Map Info

Maplnfo of the vertical datum.

Continue to 6.3.2.1.4 Special Functionality or return to 6.3.2.1 Projection Editor or 6.3.2 Projections.
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6.3.2.1.4 Special Functionality

Note: the priority of execution is from top to bottom.

That is, Working folder takes priority over User folder which takes priority over Setups folder.
The Projection choice box displays all the projections from the Working folder, User Folder and
Setups folder subject to:

(a) If there are projections with the same name, the choice box will only display the one with higher
priority.

(b) If a folder is disabled via the enable/disable functionality in the Projection editor, the choice box
will ignore that folder.

(c) IfanInclusion filter is used for a specific folder, the choice box will only include those from the
folder which contain the inclusion filter content.

See Enable/Disable a Folder.

See Inclusion Filter.

See Preview Projection Choices Panel.

Enable/Disable a Folder

=
Enable Working Felder yes
Enable User Folder yes
Enable Setups Folder yes

The enable/disable setting will be used from the top priority folder that is available. For example, if
Working folder exists, enable/disable will use the setting from working folder. If there is no Working
Folder (indicate with "NO FILE", shown in image below), enable/disable functionality will use the setting
from User folder.

carto.12dcartofile exist Mo carto.12dcarto file
inwWorkingfolder from workingfolder
‘Wiorking folder - NOFILE

- User
B Setups (read-only)

B Werking folder
- User

[ Set ups (read-only)
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Inclusion Filter

%P Projection File Edito |—':' | C |_§:§ |

ol s

dh Details and Includes
- User =
] -- Set ups (read-only) File name D:\Harry.Ha\Projects\153\General\cart... BB
S|
Enable Warking Folder yes
Enable User Folder yes
Enable Setups Folder yes

Included 12dcarte files

Y~ Inclusion filters
< Filters - Working folder {nGA2020

A ERxEE

MGAZ020 Zone 47
MGAZ2020 Zone 48
MGAZ2020 Zone 49
MGAZ2020 Zone 50

/<

Filters - User folder |ACT

ACT Standard Grid

‘ Filters - Setups felder | )
Latitude )
Latitude (Adindan)\p4201
Latitude (Afgooye)\pd205
Latitude (AGD 66)\p4202 o

Set Write Preview Finish Help

The Inclusion filter will get the filter from the top priority folder that is available first. In this case, the top
priority is Working Folder. How text typed into the Filters field is interpreted is described in 6.3.2.1.5
Inclusion Filters Syntax.

In the example above, the Inclusion Filters mean that

Working Folder: only include projections in the cartol2d file in the Working folder that contain the
text "mga2020" in the projection name

User Folder: only include projections in the cartol2d file in the User folder that contain the text "ACT"
in the projection name

The filter for Setups Folder is empty.

If there is an empty filter (Setups Folder in this example), the projection choice box will look for the filter
in the next priority location that is available (in this case, User).
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== ]=]

B Warking folder

User

B]- Set ups (read-only)

Details and Includes

El
File name

B
Enable User Folder
Enable Setups Folder

e\ 12d\15.000user\carto. 12dcarto [abd
yes
yes

Included 12dcarto files

et [x [¢ &

Inclusion filters

Filters - User folder [|K

UK Mational Grid
UK UTM zone 29
UK UTM zone 30
UK UTM zone 31

Filters - Setups folder |Fiji

Fiji Geodetic Datum 1936

In User (next priority location), there are 2 filters:

User Folder has "UK" filter. However, this filter will be ignored because User Folder filter has been
used by the higher priority folder
Setups Folder has "Fiji" filter. The Projection choice box will use this filter because Setups Folder
filter was not used in the higher priority location. The Projection choice box will take those Setups
folder that contain the keyword "Fiji"

The results of applying the filters in the example above are:

Management




S MGA2020 Prem—saciony

') MGA2020 Zone 47
H[') MGA2020 Zone 48
') MGA2020 Zone 49
') MGA2020 Zone 50
[ MGA2020 Zone 51
') MGA2020 Zone 52
[ MGA2020 Zone 53
[ MGA2020 Zone 54
') MGA2020 Zone 55
') MGA2020 Zone 56
') MGA2020 Zone 57

L[ MGAZD20 Zoness

—[['j ACT Standard Grid
—['j Fiji Geodetic Daturm 1986

Select

[Edit]

Management
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Projectionfrom
Working Folder

Projectionfrom User Folder |

Projectionfrom Setups Folder |
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#¥ Previe Projection (

Final Projection pop-up

Origin of items in Projection pop-up |

I
Reload

Finish

Help |

The fields and buttons used in this panel have the following functions.

Field Description

Final Projection pop-up

Type

choice box

Defaults

Pop-Up

Show all projection with applied enable/disable setting, and filters.

Origin of items in Projection pop-up choice box

Show all projection same as Final Projection pop-up, with extra information about the origin of each

projection.
Buttons at Bottom

Reload

button

To reload after changes/updates to projection editor settings.

Final Projection pop-up

[

MGAZ020/MGAZ020 Zone 47
MGAZ020/MGAZ020 Zone 48
MGA2020/MGA2020 Zone 49
MGA2020/MGA2020 Zone 50
MGA2020/MGA2020 Zone 51
MGA2020/MGA2020 Zone 52
MGA2020/MGA2020 Zone 53
MGAZ2020/MGA2020 Zone 54
MGAZ020/MGA2020 Zone 53
MGAZ020/MGAZ020 Zone 56
MGAZ2020/MGA2020 Zone 57
MGAZ2020/MGA2020 Zone 58
ACT Standard Grid

Fiji Geodetic Datum 19356

Select

[Edit]

Continue to 6.3.2.1.5 Inclusion Filters Syntax or return to 6.3.2.1 Projection Editor or 6.3.2

Projections.
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Final Projection pop-up
with origin of items

I
Werking/MGA2020/MGA2020 Zone 47
Working/MGA2020/MGAZ020 Zone 48
Working/MGA2020/MGAZN20 Zone 45
Werking/MGA2020/MGAZ020 Zone 50
Working/MGA2020/MGA2020 Zone 51
Worlang/MGA2020/MGA2020 Zone 52
Working/MGA2020/MGA2020 Zone 53
Working/MGA2020/MGAZ020 Zone 54
Working/MGAZ020/MGAZNZ0 Zone 35
Working/MGA2020/MGA2020 Zone 56
Werlang/MGA2020/MGA2020 Zone 57
Weorking/MGA2020/MGAZ020 Zone 38
User/ACT Standard Grid

Setups/Fiji Geodetic Datum 1935

Select

[Edit]
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6.3.2.1.5 Inclusion Filters Syntax

The text in the fields for the Inclusion Filters determine what projections are selected from the
carto12d file that is in the corresponding folder Working, Custom, User or Setups.

| | =1
nclusion fiters
Filters - Working folder ||\.-1(3A2[)2[)
MGA2020 Zone 47 2
MGAZ2020 Zone 48
MGA2020 Zone 49
MGAZ2020 Zone 50 v
‘f Filters - User folder |ACT ‘)

ACT Standard Grid

Filters - Setups folder |

Latitude ~
Latitude (Adindan)p4201

Latitude (Afgooye)\pd205

Latitude (AGD 66)\p4202

The Filters fields uses key text separated by the logic operators comma",", plus "+" or minus "-",
to determine a subset of matches amongst all the projections in the particular folder.

The matches for the key text are case insensitive and partial.
The key text can included spaces which must then be part of the match.
For example MGA Zone 47 will MGA Zone 47 (GDA 94) but not MGA Zone 48.

The logic operations are interpreted as follows:
AND use plus '+
For example:
X+Y will also search for text that contain BOTH X and Y.
That is, the search will return only results that have both X and Y in them.

OR use comma '’
For example:
X,Y will search for text that contain EITHER X or Y or BOTH X and Y.
That is, the search will return results that have X or Y, or both X and Y in them.

NOT use minus '-'
For example:
-X will exclude text that has X in them
That is, the search will return results that don’t contain X.

The syntax is evaluated from left to right.
That is, you can have things like:

XY,Z-A
which means the search will find text with
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(X space Y) or Z, but none of them containing A

For example, the text
circuit 2000-wellington
will select the New Zealand Circuits for 2000 but leave out the one for Wellington.

Select Projection n
| o

EHaw NZG02000 CIRCUIT

L' Mount Eden Circuit 2000
[ Bay of Plenty Circuit 2000
L'} Hauvkes Bay Circuit 2000
L'} Taranaki Circuit 2000

LY Tuhirangi Circuit 2000

L' Wanganui Circuit 2000

L' wairarapa Circuit 2000

L' Wellington Circuit 2000
L' Collingwood Circuit 2000
L' Melson Circuit 2000

L'} Karamea Circuit 2000

L' Buller Circuit 2000

L Grey Circuit 2000

LY Amuri Circuit 2000

L' Marlborough Circuit 2000
L'} Hokitika Circuit 2000

L' Okarito Circuit 2000

L'} Jacksons Bay Circuit 2000
L' Maount Pleasant Circuit 2000
L' Gawler Circuit 2000

L' Timaru Circuit 2000

L' Lindis Peak Circuit 2000
L' Mount Micholas Circuit 2000
L' Mount York Circuit 2000
L' Observation Pt Circuit 2000
L' Morth Taieri Circuit 2000
L' Bluff Circuit 2000

L[} Chatham Islands Circuit 2000

Select

[Edit]

Important Notes
1. The match is case insensitive and partial.
2. ltis key text and not key words as used in the Options Search Bar.

The difference is crucial because key text can include spaces which must be part of the match
whereas in the Options Search Bar, the space between key words is an AND logic operation.

3. XY (thatis X space Y) is different to X+Y
XY looks for projection names containing X space Y somewhere in the name
X+Y looks for projection names that contain X somewhere in the names and also Y somewhere
in the name.

Continue to 6.3.2.2 Set Projection or return to 6.3.2.1 Projection Editor or 6.3.2 Projections.
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6.3.2.2 Set Projection

Position of option on menu: Project => Management => Projections => Set projections
This option is used to set the projection for the project.

Selecting Set projection brings up the Set project projection panel.

W Set Project Projection _ il Set Project Projection - d
Prajection name | Projection name  |[MGA2020 Zone 56 j

=] -

Group MGAZ.. [H]

Narme MGAZ... [H]

Description [abd

EPSG code 7856 g

ESRI WKT PROJC... [bd

IS0 code labd

IFC code [abd

Maplinfo 8, 1028... }ahd

B

Map projection type Ut -

Description [abd

Projection zone 56

Projection hemisphere south -

Scale factor 0.9996 i
EPSG code 7856 Gl

| is valid
et Finish| Help | _set | Finish| Help |
I

The fields and buttons used in this panel have the following functions.
Field Description Type Defaults Pop-Up

Projection name choice box all defined projections

The projection that is to be saved at the projection for the project.

When a projection is selected from the pop-up of available projections, the information about the selected
projection is displayed on the panel. See the above example for MGA2020 Zone 56

Buttons at Bottom
Set button

Set the projection for the project.

Continue to 6.3.2.3 Clear Projection or return to 6.3.2 Projections or 6.3 Management.
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6.3.2.3 Clear Projection

Position of option on menu: Project => Management => Projections => Clear projection
This option removes the Project Projection.

Selecting Clear projection brings up the Clear project projection panel.

i@ Clear Project Prajection — *

| 5
Clear| Finish Help

The fields and buttons used in this panel have the following functions.

Field Description Type Defaults Pop-Up
Current projection choice box
Name of the current projection set for the project.
Buttons at Bottom
Clear button

Remove the current projection from the project.

Continue to 6.3.2.4 4 Convert projection 4d to 12dcarto or return to 6.3.2 Projections or 6.3
Management.
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6.3.2.4 4 Convert projection 4d to 12dcarto
Position of option on menu: Project => Management => Projections => Convert projection 4d to 12dcarto
This option converts your custom file carto.4d to the XML file carto.12dcarto

Selecting Convert projection 4d to 12dcarto brings up the Convert carto File from 4d to XML Format
panel.

PP Corvert cartodd File to 12dcarto File -

x
Existing carto.dd file | u
1

Mew 12dcarta file ||:artu:|.'|2d|:artl:l

I
F'ru:u:ess| Finish Help

The fields and buttons used in this panel have the following functions.

Field Description Type Defaults Pop-Up
Existing carto.4d file file box *.4d files
Choose old carto file (4d format) to convert into new carto file (12dcarto format).
New 12dcarto file file box *.12dcarto files
New name for the converted carto file. New carto file will have format 12dcarto.
Buttons at Bottom
Process button

On process, the old carto file will be converted into 12dcarto file with the XML format.

Continue to 6.3.3 Create/Edit N-Value Definitions or return to 6.3.2 Projections or 6.3 Management.
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6.3.3 Create/Edit N-Value Definitions

Position of option on menu:  Project =>Management =>N values =>Create/Edit

On selecting the Create/edit option, the Create/edit N value settings panel is displayed.

il Create/Edit M walue settings —

M wvalue setting narme

I
M value setting type |
I
I

Add correction

1 Bl fefe X

LongfLat
|
AddModify| Finish Help
Field Description Type Defaults Pop-Up
N value setting name choice box all defined N value settings

Name of the n value setting to be set as the Project N value setting.

N value setting type choice box defined N value types

There are various methods for the determination of the N values. These are given in the choice box.

Mo M values required No N values required
Constant M value Constant N value

Winter Winter

MGS NGS

Plane Plane

Difference tin Difference tin

Mew Caledonia RANCO0 | New Caledonia RANCO00
G5E file GSB file

Geotiff file Geotiff file

Depending on the setting type chosen, the panel will display the appropriate fields. See 6.3.3.1 N value
Setting Types.

Projection name choice box

The projection as selected from carto.12dcarto

Projection data input box
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If not blank, this field is in the format of +proj4 data.
Note: both Project name and Project data cannot be both defined. It is an error to attempt.

Note: both Project name and Project data may be blank, but may result in errors when the N value
definition is used. Depending on the context of use, 12d needs to know how to transform between map
coordinate and long lat.

Add correction tick box ticked
If ticked, N value is added to the height.

If not ticked, the N value is subtracted from the height.
Long/Lat tick box not ticked
If ticked, the expected coordination to be used with this setting is in longitude, latitude.
Buttons at Bottom

Add/Modify button

After selecting this button, the user defined N value settings are added to the current list or the existing N
value settings is modified. using the entered values. A number of new settings can be added by simply
entering the relevant data and selecting the add/modify button.

Write button

After selecting this button, all the defined N value settings are written out to the file nvalues.4d in a user
selected folder. This means that the defined N value settings will be available after a restart is done and
when opening other projects. For more information on the Write button, go to the section 32.2.6 \Writing
Out Setup Files in the Appendix 32 Setting Up and Configuring 12d.

Continue t0 6.3.3.1 N value Setting Types or return to 6.3.3 Create/Edit N-Value Definitions or 6.3
Management.
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6.3.3.1 N value Setting Types
No N values required

Page 224

—

Mwvalue settingtype [N M values required “7

This is for data that already has ellipsoid heights and requires no interpolation for N values so no extra
information is required.

Constant N value

Constant M walue | ﬂ ‘
Field Description Type Defaults Pop-Up
Constant N value input box

This N value will be used for the entire n value interpolation process. (i.e. it will not change).

Winter

This method uses the same method as the Winter interpolation software supplied by Auslig. The data files
used should be winter compatible and reside in a folder that is pointed to by the WINTER _DATA 4D
parameter in the env.4d file. The data files can be downloaded from the Auslig website.

Select Ausgeoid file map scale 1:250,000 ﬂ
Use bicubic interpolation if possible |+
I |
Field Description Type Defaults Pop-Up
Select Ausgeoid file map scale choice box 1:100,000
1:250,000
1:1,000,000

This value will be dependant on the type of files to be used by winter. The files themselves should be in a
folder that is pointed to by the WINTER _DATA_4D parameter in the setup area of the env.4d file.

Use bicubic interpolation if possible tick box ticked
If ticked, the bicubic interpolation method will be used if possible.
Environment variable for Winter path text box
The environment variable name containing the path to where the custom Winter files reside.

This means now you can have multiple sets of Winter files used in 12d Model at the same time.

As an example: you may have a variable name of WINTER 2020 _FILES 4D where the value of this
variable is ¢:\12d\14.00\user\winter 2020 _data.
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NGS

This method is currently under development.

NGS farmat binary file | Q

Plane

This method allows a plane to be defined allowing N values to be derived from that plane.

|
|
Caorrection constant | ﬂ
|
|

Origin easting

Origin northing

Correction per unit easting

Field Description Type Defaults Pop-Up

Correction per unit northing

Origin easting input box
Origin easting value.

Origin northing input box
Origin northern value.

Correction constant input box
Constant Z value of the plane.

Correction per unit easting input box
Z value correction per unit easting.

Correction per unit northing input box

Z value correction per unit nothing.

Difference tin

This method allows value to be interpolated from a difference tin. A difference tin is simply a tin of
difference values (N values). This tin can be re-triangulated as new points become available, thus
introducing more points than a regular grid.

Difference tin | ﬂ‘

Field Description Type Defaults Pop-Up

Difference tin tin box Available tins

The difference tin from which the N values will be interpolated.
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New Caledonia RANCO00

i Create/Edit M value settings — x
M wvalue setting narme | -
Mwvalue setting type  |Mew Caledonia RANCO0 -

GSB file
3B file | Q
Interpalation method Bi_Cyhic ﬂ
Field Description Type Defaults Pop-Up
GSB file file box *.gsb

A gsb file to find N value according to provided longitude/latitude or easting/northing.

Interpolation method choice box Bi-Cubic Bi-Linear, Bi-Cubic

If Bi-Linear is chosen, a 4-point-calculation is used to calculate the element's N value.

If Bi-Cubic is chosen, a 16-point-calculation is used to calculate the element's N value.

Geotiff file

Geotiff file | Q
Field Description Type Defaults Pop-Up
Geotiff file file box * tif

A geotiff file to find N value according to the provided coordinates. The calculation is to be done with bi-
linear method (4-point-calculation).

Continue to 6.4 12d Markup or return to 6.3.3 Create/Edit N-Value Definitions or 6.3 Management.
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6.4 12d Markup

Position of menu:  Project =>Markup

The purpose of 12d Markup is to provide users with functionality to digitally Markup/Review
12d Model information and to track and store the history of these markups.

The digital tracking of these markups and reviews include.
Who issued the markup/review?
When did they issue it?
Who has been assigned to undertake the changes to the data?
When did they do this?
Has the change been completed?
Has the completed change been verified?
Was the verified change plotted on a drawing?

The tracking of these gateways is done digitally and remains on the markup/review to enable digital
transfer from both 72d Model Projects, as well as outside 12d in other BIM systems.

The 12d Markup option works within 72d Model and 12d View.

Markups versus Reviews
Markups

Markups are intended to follow historical markup procedures that users may be familiar with.

Traditionally these markups are created to present on a final submitted plan drawing as tracked
Revisions.

The Markup option reflects these traditional practices but aims to store the usual hard copy tracking
in a digital realm.

Reviews

Reviews are like markups with regards to tracking and status gateways but are aimed more for
digital storage transfer rather than hard copy plotting.

Selecting Markup brings up the Mark-up panel

|
"B Mark-Up - X | _Setup tab
. . p
| Mark Ups l Status l Rewieuys l Fublish l Mark Ups tab
Status tab
_r) & o ﬂ ﬂ ﬁ Reviews tab
oo I ‘ Publish tab
' |

-

12d Markup ~ Page 227




What’s New in 12d Model 15

Setup tab
Import Settings Create Markup View Create Review View
g Mark-Up — >
| hA Llpsl Status F{eviewsl Publish Setup tab
= l';" Mark Ups tab
o &) OB Sausia
'y Reviews tab
| \ Publish tab
\
Mark-up Settings String Inquire Create 3D Markup View

Mark-up Settings

ped

i Mark-Up Settings —

Model Postfix |MARKUF‘

T
Colour |rE|:| 248 E
Weight |2 _
Z value ||j ﬂ
Textstyle |"1" left bottom cyan 100 A"
30 to 20 Width |3 i@
30 Marker Size |-|.5 g

|
Set | Finish|

The fields and buttons used in this panel have the following functions.

Field Description Type Defaults Pop-Up

Model postfix model box available models
This text is added as a Model postfix to the automatic markup Model name.

Colour colour box red available colours
Initial colour for the markup objects.

Weight real box 2
Line weight for the markup objects.

Z value real box 0

A constant Z value (height value) for the markup and review objects. This is especially helpful for viewing
the markups in a 3D perspective view or when exporting out to other BIM systems.

Textstyle textstyle box

Default text properties used when creating Markup text or Review automatic labelling.

3D to 2D width real box

Size in metres of the side of the square around the 3D marker. The square has the (x,y,z) coordinates of the
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picked point.

3D marker size real box

Height in metres of the pyramid for the 3D marker. The inverted pyramid is placed with its vertex on the
picked point.

Continue to _Import Settings or return to _Setup tab or 6.4 12d Markup.

Import Settings

il lmport Settings —

File name |dncumentatinn_.12da

Wienr |SURWEY
Irport Loy

Delete file after import

g T« \lE X

Clearwiew of current rmark ups

Irmpart Finish | Help

File name file box

Selection of a previously published 12d Markup file to import into the Project (see publishing).
View real box
The View to import the published markup Model data in to.

Import choice box All All, Started Reviews,
Reviews in Progress,
Completed Reviews,
Verified Reviews,
Reviews, Mark Ups,
Revisions

The status of the markups/reviews to be imported. Default is All.

Delete file after import tick box not ticked
If'ticked, the originall2d markup file will be deleted.

Clear view of current mark ups  tick box ticked

This will remove all markup Models currently on the selected import View.

Import button
When clicked, read in the 12d Markup file given in File name.

Continue to _String Inquire or return to _Setup tab or 6.4 12d Markup.
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String Inquire
This brings up the 10.10 String Inquire option.

P String Inquire - *

Inquire style W ﬂ

Copy to clipboard I
Advanced settings v
®|

Heads-up display v

[ Inquire style set
Pick | Finish| Help |

Continue to Create Markup View or return to _Setup tab or 6.4 12d Markup.

Create Markup View

iP Create Mark Up View — — by
Addto View |Unassigned ﬂ
I
Create‘u‘iew| Cancel | Help |
Add to view choice box

Select Choice n

Unassigned
In Progress
Completed
Verified

All

Haold

The type of Markup information to automatically add to the created view.

Create View button
When clicked, if it does not exist, a plan view called by the choice from Add to View followed by '
Mark Ups View". For example, "Unassigned Mark Ups View".

’

Continue to _Create 3D Markup View or return to _Setup tab or 6.4 12d Markup.

Create 3D Markup View
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i Create Mark Up View - =
Add to View ||nassigned ﬂ
Create‘u‘iew| Cancel | Help |
Add to view choice box

Select Choice n

Unassigned
In Progress
Completed
Verified

All

Haold

The type of 3D Markup information to automatically add to the created view.

Create View button

When clicked, if it does not exist, a plan view called by the choice from Add to View followed by "
3D View". For example, "In Progress 3D View".

Continue to _Create Review View or return to _Setup tab or 6.4 12d Markup.

Create Review View

i Create Mark Up View — — et
Add to View |Unassigned ﬂ
Create‘u‘iew| Cancel | Help |
Add to view choice box

Select Choice n

Unassigned
In Progress
Completed
Verified

All

Hold

The type of Review information to automatically add to the created view.

Create View button

When clicked, if it does not exist, a plan view called by the choice from Add to View followed by '
Review View". For example, "Completed Review View".

’

Continue to _Mark Ups tab or return to _Setup tab or 6.4 12d Markup.
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Mark Ups tab
This panel provides various markup display tools to be created on the currently active View.

Rectangle Cloud Anticlockwise Cloud
| | Mark Ups Bin
P Mark-Up — X
el Iark Ups | Statu l R eunrs l F'uhlish] / Setup tab
. Mark Ups tab
TIOE /D C| A T||| | seusw
L L n - Reviews tab
| f N \ ? ? ﬁ 1‘ Publish tab
| ’ | l
Rectangle Arrow Line
Cloud
Text
Fast Cloud
Polyline

Markup Model Naming
When a markup is created, an automated Model name will be produced to assist in tracking the
author of the markup. The Model name is in 3.10 Object Tree format and will be.

Mark Up/Mark Ups/Automatic Date/Automatic Author postfix

Models to Remowve from 2" x
- [ @ Mark Up
=[] @ Mark Ups
<[] '@ Automatic Date
[ * author 1

A separate model postfix will be created for each markup type unless a Model other then MARKUP
has been specified in the Mark-Up Settings panel. In this case, the postfix in the Model name will be
as entered in this panel.

Rectangle

Creating a rectangle requires three cursor picks. The first two pick and accepts define the side of the
rectangle and the third pick and accept creates the final side of the markup rectangle. So the created
rectangle can be a rotated rectangle

Continue to _Text or return to _Mark Ups tab or 6.4 12d Markup.
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Text

Pick and accept on a View the location for markup text to be created.

This will then pop up a text entry panel to enter the text to be displayed.

ﬁ‘—f Enter Text

Mark Up Information

Text Style | Text 3.5mm ﬂ
|

Enter| Reset Help |

d

Continue to _Fast Cloud or return to _Mark Ups tab or 6.4 12d Markup.

Fast Cloud

Pick and accept the left-hand cloud extent, the pick and accept the right-hand extent to complete the
creation of a fast cloud markup.

Continue to _Rectangle Cloud or return to _Mark Ups tab or 6.4 12d Markup.

Rectangle Cloud

Pick and accept the left-hand cloud extent, the pick and accept the right-hand extent to complete the
creation of a rectangular cloud markup.

Continue to _Arrow or return to _Mark Ups tab or 6.4 12d Markup.

Arrow

Pick and accept on the far end (non-arrow) location for the arrow, then pick and accept the location for the
arrow end to be created.

Note: If the line of the arrow cannot be seen on the View, make sure the "Draw edges" in the View settings

g
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is active

-

Continue to Polyline or return to Mark Ups tab or 6.4 12d Markup.

Polyline

Pick and accept on multiple vertex locations for the creation of a polyline object. Choose the ESC key on
the keyboard to finish the creation.

ENYARN

Continue to _Cloud or return to _Mark Ups tab or 6.4 12d Markup.

Cloud

Pick and accept on multiple vertex locations in a clockwise direction for the creation of a user defined
cloud shape. Choose the ESC key on the keyboard to close the cloud shape and finish the creation.

C

Continue to _Anticlockwise Cloud or return to _Mark Ups tab or 6.4 12d Markup.

Anticlockwise Cloud

Pick and accept on multiple vertex locations in an anticlockwise direction for the creation of a user
defined cloud shape. Choose the ESC key on the keyboard to close the cloud shape and finish the creation.

C

Continue to _Line or return to _Mark Ups tab or 6.4 12d Markup.

Line

Pick and accept on a start location and then pick and accept on the final location for the creation of a line

Page 234 12d Markup




What’s New in 12d Model 15

object.

Continue to _Mark Ups Bin or return to _‘Mark Ups tab or 6.4 12d Markup.

Mark Ups Bin

Select and then pick and accept on a markup object to delete the object. Choose the ESC key on the
keyboard to finish the selection(s).

Continue to _Status tab or return to _Mark Ups tab or 6.4 12d Markup.
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Status tab
Status Complete
W Mark-Up - X
Setup l hark Ups F{eviewsl F'uhlish] Setup tab
Mark Ups tab
i\@ 1K J\A ] Sasn
X ‘ Reviews tab
K Publish tab
_Status Hold Hold
Status Progress Status Revision

Status Options

The purpose of the status panel is to send the markup objects through defined gateways to enable
Users to ascertain the progress status of a markup.

This will provide an inbuilt quality control system to capture whether required changes have been
done and completed changes captured. These Status Gateways are.

Inassigned,

Created InProgress Completed werified

L gr
[For plotting)

These Status Gateways are sequential, so for example a markup or review cannot be set to
Completed status unless it has already been through the In Progress status.

Digital attribution of Markup status

When assigning the status of the markups, attributes will be automatically added to the object itself.
This provides digital tracking of the status and answers the questions posed at the start of this help.

Who issued the markup/review?

When did they issue it?

Who has been assigned to undertake the changes to the data?
When did they do this?

Has the change been completed?

Has the completed change been verified?

Was the verified change plotted on a drawing?

The status attributes of a markup can be viewed at any time using String=> Properties=> Attributes.
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Ver‘tex l Segmentl

Name |Mark Up/Mark Ups/Mon Sep 25 2023/DylanRevell User-» ﬂﬂﬂ
+ = [Top] Group name | pMark Up Information @
O Aftribute Type Value +
= 1 | Status Integer 3 -
1 2 | Status Text Text Verified X
~ 3 | Date Created Text Mon Sep 25 2023 S
: 4 | Created By Text Mame of Creator 4
o 5 | Hold Date Text Mon Sep 25 2023 0O

6 | Hold By Text Mame of Creator E]
0 7| In Progress Date Text Mon Sep 25 2023 =
4 & |InProgress By  Text Name of person who marked status Q
E3| g | Date Completed Text Mon Sep 25 2023 5

10| Completed By Text Mame of person who marked status

11| Date Verified Text Mon Sep 25 2023

12| Verified By Text Name of person who marked status

13| Revision 1D Text A

14| Revision By Text Name of persan who assigned Revison

Status Complete
|
P Mark-Up — by
Setup l Mark Ups Rewiews l Publish ] Setup tab
abe - Mark Ups tab
_‘i ‘ @ J ‘ A ‘ Status tab
Reviews tab
x f ¥ ¢
/
_Status Regress M}L Status Bin
_Status Hold HoId
Status Progress _Status Revision

Status Regress

When the regress option is selected, the User will select a markup, and this will regress the Gateway status
of the markup back one step. E.g., Regress status from Completed back to In Progress.

Continue to _Status Hold or return to _Status tab or 6.4 12d Markup.

Status Hold

This option will create an inverted cloud with the text hold within the cloud.

Pick and accept the left-hand cloud extent, the pick and accept the right-hand extent to complete the
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creation of an inverted hold cloud.

<

Continue to _Status Progress or return to _Status tab or 6.4 12d Markup.

Status Progress

Choose and select markup which has been created/unassigned. Selecting the markup will:
Change the colour of the markup to Orange.

Automatically add attributes to the object with the User name and Date that the status was assigned.

-

Continue to _Status Complete or return to _Status tab or 6.4 12d Markup.

Status Complete

Choose and select markup which has been marked as In Progress. Selecting the markup will
Change the colour of the markup to Green.

Automatically add attributes to the object with the User name and Date that the status was assigned.

(

Continue to _Status Verify or return to _Status tab or 6.4 12d Markup.

Status Verify

Choose and select markup which has been marked as Complete. Selecting the markup will

Fill the markup with a green transparent fill.
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Automatically add attributes to the object with the User name and Date that the status was assigned.

Continue to _Status Revision or return to _Status tab or 6.4 12d Markup.

Status Revision
This option is for creating a drawing plot capable version of the markup to match the assigned drawing
revision to be plotted.

Note: This option should not be run in 12d View as the Revision data Model will not be saved!

The User will be presented with the Revision letter/numbers option.

h‘: Revision Panel

Revision type |Letter5

hd
Revision name |A v|

|ch0ice ok

pick | Finish| Help

Choose the Pick button and then select a markup which has been marked as Verified. This will

Copy the verified markup object into a new Model with a vertex symbol matching the Revision letter/

number.

Automatically add attributes to the object with the User name and Revision ID for tracking purposes

A

Moving the Revision vertex symbol

If the vertex symbol created by the Revision tool is not in the ideal location, the User can reposition this
symbol by using the Cad > Symbol > Edit option in 12d Model.

Type V' for vertex
Select the vertex on the markup object nearest to the symbol.

Adjust the position of the symbol via the edit grips.

Continue to _Status Bin or return to _Status tab or 6.4 12d Markup.
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Status Bin

Select and then pick and accept on a markup object to delete the object. Choose the ESC key on the
keyboard to finish the selection(s).

Continue to Reviews tab or return to Status tab or 6.4 12d Markup.
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Reviews tab

Reviews\ 3D Reviews Progress Reviews Verify
/
W MarkUp — *
Setup l tk Ups l Statys sh l Setup tab
E E-‘-r:.: E-r.-ﬂ abc i — Mark Ups tab
- L] L] Status tab
Reviews tab
| Publish tab
|

Reviews Regress Reviews Review Reviews Complete Reviews Bin

As mentioned in the Markups versus Reviews area, Reviews are like markups with regards to

tracking and status gateways but are aimed more for digital storage transfer rather than hard copy
plotting.

Reviews follow the same Gateway Status workflow as Markups. This provides an inbuilt quality
control system to capture whether required changes have been done and completed changes
captured. These Status Gateways are.

Completed

When assigning the status of the reviews, attributes will be automatically added to the object itself.
This provides digital tracking of the status and answers the questions posed at the start of this help.

Who issued the markup/review?

When did they issue it?

Who has been assigned to undertake the changes to the data?
When did they do this?

Has the change been completed?

Has the completed change been verified?

Was the verified change plotted on a drawing?

The status attributes of a markup can be viewed at any time using:
String=> Properties=> Attributes.
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a‘; String Attributes

Vertex ] Segment l

Name | Mark Up/Reviews/Mon Sep 25 2023/DylanRevell User-» jﬂﬂ
=+ | = [Top] Group name | Reyiew Information @
O Aftribute Type Value =+
] 1 | Status Integer 3 -+
1 2 | Status Text Text Verified 1
= 3 | Comment Text Review Text s
: 4 | Date Created Text Mon Sep 25 2023 A
o 5 | Created By Text MName of Creator m

6 | In Progress Date Text Mon Sep 25 2023 El
T 7| In Progress By  Text MName of person who marked Status =
+ g | Date Completed Text Mon Sep 25 2023 Q
[x] g | Completed By  Text MName of person who marked Status 5

10| Date Verified Text Mon Sep 25 2023

11| Verified By Text MName of person who marked Status

"Review Information" selected

Pick Ok Apply Refresh Finish

Reviews\ 3D Reviews Progress Reviews Verify
P MarkiUp — >
Setup l ark Llpsl Statlys Setup tab
Mark Ups tab
abe |l @abe abc ——
SV e e AN Status tab
W - Reviews tab
Publish tab
|
Reviews Regress Reviews Review Reviews Complete Reviews Bin

Reviews Regress

When Regress option is selected, the User will select a review, and this will regress the Gateway status of
the review back one step. E.g., Regress status from Completed back to In Progress.

Continue to _Reviews 3D or return to _Reviews tab or 6.4 12d Markup.

Reviews 3D

When 3D is selected, the User selects a 3D position and a red inverted pyramid is placed at the selected
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position and a square with the z-coordinate of the 3D position drawn.

- - al

The User is then prompted to enter to enter the review comment about the mark up.

r

i 3D Mark Up Comment = ot

3D Review text

Note the Text Style will be pre-populated with the text style information entered in the Mark-up Settings
panel.

Continue to _Reviews Review or return to Reviews tab or 6.4 12d Markup.

Reviews Review
Choose and then pick and accept the left-hand review extent, the pick and accept the right-hand extent to
complete the creation of a review area.

The User will then be prompted to enter the review comment about the review.

Note the text Style will be pre-populated with the text style information entered in the Mark-up Settings
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panel.

i:: Review Comment

Feview Information

Text Style [“Calibri” lefttop red 1001 A'|

|
Enter| Rezet| Help

This review comment will be displayed automatically in the top-right corner of the review rectangle.

4

Tue Sep 26 2023
DylanRevell

Review Comment:
Review Information

Continue to _Reviews Progress or return to _Reviews tab or 6.4 12d Markup.

Reviews Progress
Choose and select review which has been created/unassigned. Selecting the review will
Change the colour and transparent fill of the review to Orange.

Automatically add attributes to the object with the User name and Date that the status was assigned.

Automatically add the User name and Date as vertex text in the top-left corner of the review rectangle

In Praogress: Tue Sep 26 2022
Tue Sep 26 2023 DvlanRevel|
DylanRevell Revlew Comment:

Review Information

Selecting a 3D markup review will.

Change the colour of the pyramid and surrounding rectangle to Orange.
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Automatically add attributes to the object with the User name and Date that the status was assigned as well as
add attributes recording the x,y and z coordinate position of the 3D mark up.

Continue to Reviews Complete or return to _Reviews tab or 6.4 12d Markup.

Reviews Complete
Choose and select review which has been marked a In Progress. Selecting the review will
Change the colour and transparent fill of the review to Green.
Automatically add attributes to the object with the User name and Date that the status was assigned.

Automatically add the User name and Date as vertex text in the bottom-left corner of the review

rectangle
In Praogress: Tue Sep 26 2022
Tue Sep 26 2023 DvlanRevel|
DylanRevell Revlew Comment:
Completed: Review Information
Tue Sep 26 2023
DylanRevell

Selecting a 3D markup review will.

Change the colour of the pyramid and surrounding rectangle to Green.
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Automatically add attributes to the object with the User name and Date that the status was assigned.

Continue to Reviews Verify or return to _Reviews tab or 6.4 12d Markup.

Reviews Verify
Choose and select review which has been marked as Complete. Selecting the review will

Automatically add attributes to the object with the User name and Date that the status was
assigned.

Automatically add the User name and Date as vertex text in the bottom-right corner of the
review rectangle

In Progress: Tue Sep 26 2023
Tue Sep 26 2023 DylanRevell

DylanRevell Review Comment:

Completed: Review Information
Tue Sep 26 2023

DylanRevell

Selecting a 3D markup review will.

Change the colour of the pyramid and surrounding rectangle to Dark Green. and add a fill to the
surrounding rectangle.
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Automatically add attributes to the object with the User name and Date that the status was assigned.

Continue to _Reviews Bin or return to Reviews tab or 6.4 12d Markup.

Reviews Bin

Selecting this option will bring up a panel for the creation/editing of either a new or existing markup file.

Continue to Publish tab or return to Reviews tab or 6.4 12d Markup.
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Publish tab
The purpose of publishing the markup/review information is to be able to share the reviews between
projects and between 12d View and 12d Model. It will also create a record of all the markup/review data

that can be managed and stored outside of a 12d Model Project.

Mark Up Table 3D Table Review Table

What’s New in 12d Model 15

i Mark-\p — X
Setup l rk Ups | Satus ] feurs F"-Jb|i5h|
209\ <
' \
Export/Publish Markups Report

Export/Publish Markups

Setup tab

Mark Ups tab
Status tab

Reviews tab
Publish tab

Selecting this option brings up a panel for the creation of a new markup file, overwriting an existing mark

up file, or appending to an existing markup file.

h‘; Export Settings

File name | project_File Name
File type | 12da
Export [l

Delete exports from project

1 ®

Overwrite file

E:-:port| Finish | Help

File name file box

The file location and name of the markup file to be written. The name of the project followed by an

underscore (_) is automatically written into the field.

Note: the markup file MUST have the name of the Project to be created. This allows easier tracking of

the project data that has been marked up or reviewed.
File type choice box

Choose the file type to be exported.
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Export choice box

All

Started Reviews
Reviews In Progress
Completed Reviews
Verified Reviews

Reviews
30 Reviews
Mark Ups
Choice of the content to publish.
Delete exports from project tick box ticked

If ticked, all the Markup and Review model information is deleted from the project on export. This is
recommended as it will prevent errors for duplicate Models when trying to Import the markup file back
into the Project.

If not ticked then no models are deleted on export.

Overwrite file tick box not ticked

If no file of the same name exists, then the new file is created and this field is ignored.

If ticked and a file of the same name exists, then the existing file will be overwritten and any existing
contents lost.

If not ticked and a file of the same name exists, it will append the Model data to the existing Markup

file.

Note: The Revision Plot Models will not be exported in the file or deleted and will remain with the
Project when saved.

Continue to Mark Up Table or return to Publish tab or 6.4 12d Markup.
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Mark Up Table

The Mark Up Table is a way for users to view a complete list of the mark up models currently within the
Project It also provides a list of the status and details about the selected type.

Upon selecting this option, the user must select the Refresh button.

Doing so will initiate a search within the Project for markup information display the list of the searched
data.

|
| ¥ Attributes Table

N BEEPECE

Mark Up/Mark Ups/™

Letlie[x [¢[&

Rule set | Mark Up Information v

Skip invalid attribute rows on update | |
| Status Created By Date Created Progressed By | Date Progressed | Completed By | Date Compld 2

1| Unassigned DylanRevell Wed May 24 2023 i

2| In Progress DylanRevell Wed May 24 2023 DylanRevell Wed May 24 2023

3| Completed DylanRevell Wed May 24 2023 DylanRevell  Wed May 24 2023 DylanRevell  Wed May 24

4 | Verified DylanRevell Wed May 24 2023 DylanRevell  Wed May 24 2023 DylanRevell  Wed May 24

5] Completed DylanRevell Wed May 24 2023 DylanRevell ~ Wed May 24 2023 DylanRevell  Fri Aug 04 2

6| Unassigned DylanRevell Fri May 03 2024

7] Unassigned DylanRevell Fri May 03 2024

8 1]

9 ]

10

11

12

13

oages

attributes |
I Update Finish | Help b

Continue to _3D Table or return to _Publish tab or 6.4 12d Markup.
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3D Table

The 3D Table is a way for users to view a complete list of the 3D mark up models currently within the
Project It also provides a list of the status and details about the selected type.

Upon selecting this option, the user must select the Refresh button.

Doing so will initiate a search within the Project for markup information display the list of the searched
data.

[ P Attributes Table
| - Data to edit
- | &| @
Model

Mark Up/3D/*

",

o|o|alc|o| 5| €| +|

Letlie [ | [

Rule set | Review 3D Information ﬂ
Skip invalid attribute rows on update r
| Status Comment | Created By | Date Created Progressed By | Date Progressed | Comg 2
1| Unassigned Check for Clash DylanRevell Thu Nov 21 2024 i
Unassigned Check for Clash DylanRevell Thu Nov 21 2024

In Progress Change the pipe invert DylanRevell Thu Nov 21 2024 DylanRevell Thu Nov 21 2024
In Progress Change the pipe invert DylanRevell Thu Nov 21 2024 DylanRevell Thu Nov 21 2024
Completed Increase thickness DylanRevell Thu Mov 21 2024 DylanRevell Thu Nov 21 2024 Dylan
Completed Increase thickness DylanRevell Thu Mov 21 2024 DylanRevell Thu Nov 21 2024 Dylan
Verified Needs to be moved DylanRevell Thu Mov 21 2024 DylanRevell Thu Nov 21 2024 Dylan
Verified Needs to be moved DylanRevell Thu Mov 21 2024 DylanRevell Thu Nov 21 2024 Dylan

@~ | AW N

attributes logdesd
. Update | Finish Help /

Continue to _Review Table or return to Publish tab or 6.4 12d Markup.
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Review Table
The Review Table is a way for users to view a complete list of the Review models currently within the
Project It also provides a list of the status and details about the selected type.
Upon selecting this option, the user must select the Refresh button.
Doing so will initiate a search within the Project for markup information display the list of the searched

data.
' aw - x|
Data to edit
ol e|m|alc| o] S| €] %]
Model

Mark Up/Reviews,™

Rule set | Review Information ﬂ

Skip invalid attribute rows on update r
Status | Comment | Created By | Date Created | Progressed By | Date Progressed | Completed By | Date Com 24
Unassigned 1234 DylanRevell Wed May 24 2023 i

In Progress 2345 DylanRevell Wed May 24 2023 DylanRevell Wed May 24 2023

Completed 3456 DylanRevell Wed May 24 2023 DylanRevell Wed May 24 2023 DylanRevell  Wed May
Verified 5678 DylanRevell Wed May 24 2023 DylanRevell Wed May 24 2023 DylanRevell Wed May
Completed 7899 DylanRevell Wed May 24 2023 DylanRevell Wed May 24 2023 DylanRevell  Wed May

v e W=

| | attributes loaded

Update | Finish Help A

Continue to Report or return to _Publish tab or 6.4 12d Markup.
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Report

The Mark Up report will create a detailed HTML report of all the currently loaded mark up models.
Any user entered text within the description area will populate the appropriate area within the report.

i¥ Generate HTML Report = o
File name |markup_rep0r‘t.h’[m| M
Description

This is the report generated of the mark up status and detail

Generate Finish Help

@

Mark Up Report

- — 124 Sohitions Py LTd
" PO Bax 351
[ T ] g
gt D rigtion Thels s o rpr gersirdtind of s Ml o e
s el e [02) BATO TIT
Clafs Canwraisd T B oM

Fagecrt Gon e ariaed Dy O Mol waww_12d com

Unassigned Mark Ups

Wik Lt LipaWsd By 74 301 WDvialavmli |
Mok Lt L P My (03 30 DvlmnBlownd 3
Mk Ut Lipa i My 0 HO R DhiasRawell 3

Wk Ut Ut Sdp 16 2200y Ll 8
In Progress Mark Ups
Mcadal Harse Unpim i I repradd By it Lirdermany Urederaney By
Mt Updare Lips“esd wlay 71 ) VOvimeleosld Voo Whay 14 M) ]
Comploted Mark Ups
kit M Dists Crassnied [T Faits Elaimiy Usabaimi [ty Dt Cimitind Coempiutud Iy

The report item summary area is colour coded to the same specifications of the mark up items, allowing
easier determination of the item status.

Total Mark Ups

ok L gt My 1 27 Dol Tied By 2023 Dyl

Continue to 6.5 Project Settings or return to 6.4 12d Markup or 6 Project.
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6.5 Project Settings

Each 12d Model project has its own group of settings that are used by various options. These are
called Project Settings.

When in a 12d Model project, the values of the individual Project Settings for that project are
displayed and modified by the Project Settings panel which is brought up by the menu item

Project =>Settings See 6.5.2 Project =>Settings.

When a value of a Project Setting is modified for a project and the project is saved, the new value of
the setting is recorded with the project.

Hence the individual values of the Project Settings are project specific and can vary from project to
project.

New Projects Versus Existing Projects

When a new project is created, the initial values of the Project Settings are loaded from the file
defaults.12dsettings. The initial values are then saved within the project itself.

For an existing project, whenever a value in Project Settings is changed and a Save is done, the
new value is saved within the project so that the next time the project is opened, the new value is
used.

Hence the values in Project Settings are specific to a project.

So Project Settings are totally different to environment variables which in most cases, are used each
time a project, new or existing, is opened.

Project Settings Profiles and the Active Profile
Even within the one 72d Model session, a user may want to use a different set of Project Settings.
So for a project, it is possible to have more that one set of values for all the Project Settings.

A set of values for the Project Settings is called a Project Settings Profile and any number of
profiles can be defined for a project, and it is possible to switch Profiles at any time in a 72d Model
session.

The current Project Settings Profile being used is called the Active Profile.
The file defaults.12dsettings can contain any number of Project Settings Profiles.

Summary

For a new project, the values for all the Profiles of Project Settings are loaded from a file, the default
name of which is defaults.12dsettings. See 6.5.1 Project Settings Defaults File.

Once a new project is created, the values for the Profiles of Project Settings being used and saved
with the project can be modified using the Project =>Settings option. See 6.5.2 Project =>Settings.

Project Settings files can be created and edited by the Project Settings Editor which is brought
up by Project =>Management => Project setting file editor.

Continue to 6.5.1 Project Settings Defaults File or return to 6.5 Project Settings or 6 Project.
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6.5.1 Project Settings Defaults File

For a new project, the default file containing all the Profiles of Project Settings is
defaults.12dsettings and the file is searched for in the standard set up folders search paths.

However there are environment variables to change both the name of the file, and the folder to look
in, for the file of Project settings.

The environment variable DEFAULT 12D _PROJECT_SETTINGS_ 4D changes the name of the file
that is searched for in the standard set up folders search paths.

DEFAULT_12D PROJECT_SETTINGS_4D project_settings_file_name

The environment variable DEFAULTS_PROJECT_SETTING_FILE_4D is the full pathname of the
file to be used as the default project settings file. So no other areas are searched.

DEFAULT PROJECT SETTINGS FILE_4D project_settings_file

The environment variable DEFAULTS _PROJECT_SETTINGS PROFILE_4D gives the name of the
Profile in the project settings file that is to be used for the new project.

DEFAULT_PROJECT_SETTINGS_PROFILE_4D project_settings_Profile

If DEFAULTS PROJECT_SETTINGS_PROFILE_4D is not defined, or is not the name of a Profile in
the selected project settings file, then the first Profile in the project settings file is used as the starting
Profile to be used for a new project.

If no project settings file is found then any old default files are used. If no old default files exist, then
hard wired default values are used.

Once the new project is created, the values for all the Profiles of Project Settings being used and
saved with the project can be modified using the Project =>Settings option.

Project Settings files can be created and edited by the Project Settings File Editor.

Continue to 6.5.2 Project =>Settings or return to 6.5 Project Settings or 6 Project.
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6.5.2 Project =>Settings

Position of option on menu:  Project =>Settings

Each 12d Model project has its own group of settings that are used by various options. These are
called Project Settings.

When in a 12d Model project, the values of the individual Project Settings for that project are
displayed and modified by the Project Settings panel which is brought up by the menu item

Project =>Settings See 6.5.2 Project =>Settings

When a value of a Project Setting is modified and Set pressed, the new value of the setting is used
for the rest of the session. If the project is saved, the new value of the setting is recorded with the
project.

Hence the individual values of the Project Settings are project specific and can vary from project to
project.

Selecting Settings brings up the Project Settings panel:

il Project Settings - *
Active profile | Default Project Settings b4
e Layout
95 Defaults Autosave screen layout [
2 spstern | M
D Inquire | M
[ Select
- Options Search Bar Userinterface
On-screen Keyboard Praperty list quick popup r
2P0 Cad
[l Drafting Diagrostics
Sawve Send option log files on successful exit v

17 Trash Maodel
= Plats and Reports
L Object Display
ZZ5 WWater String
E Survey Data
2 == Super Alignrnent

E Report

Import/Expart project settings profiles
Import Mode [ Apnend rename ﬂ

File | ﬂ Import| Export
Set Finish Help

See

6.5.2.1 Fields and Buttons at the Top and Bottom of Project Settings
6.5.2.2 Main Page Settings

6.5.2.3 Defaults Settings

6.5.2.4 System Settings

6.5.2.6.1 Select >View Models Settings
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6.5.2.5 Inquire Settings

6.5.2.6.1.1 Select >View Models >Typing over View + or - Settings
6.5.2.6.2 Select >Models, Tins, Functions Settings
6.5.2.6.3 Select >Choices

6.5.2.6.4 Select >Names

6.5.2.7 Search Bar Settings

6.5.2.8 On-Screen Keyboard Settings

6.5.2.9 Cad Settings

6.5.2.9.1 CAD >Heads-Up Display Settings
6.5.2.10 Drafting Settings

6.5.2.11 Save Settings

6.5.2.12 Trash Model Settings

6.5.2.13 Plots and Reports Settings

6.5.2.14 Object Display Settings

6.5.2.15 Water String Settings

6.5.2.16 Water String >Property Controls Settings
6.5.2.17 Water String >House Connections Settings
6.5.2.18 Survey Data Settings

6.5.2.19 Super Alignment

6.5.2.23 Saved Selects
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6.5.2.1 Fields and Buttons at the Top and Bottom of Project Settings

i Project Settings - d
(s - - .
( Active profile | Default Project Settings v
=) Ld}rUUL
' I3 Defaults Autosave screen layout v
O Systern | @
El Inguire | M
[ Select
- Options Search Bar Userinterface
On-screen Keyhoard Froperty list quick popup -
29 Cad
{0 Drafting Diagnostics
Save Send option log files on successful exit [
17 Trash Model
= Plots and Reports
L Object Display
I Wiater String
,E\ Survey Data
B =S Super Aligrrert
El Report
ﬁnpnr‘tﬁExpor‘t praject settings profiles —
Import Mode | Apnend renarme ﬂ
File | d Irnpart| Export
|\ _
‘ Set Finish Help

The fields and buttons used in this panel have the following functions.

Field Description Type Defaults Pop-Up
Field on Top
Active profile choice box list of the projects Project Settings Profiles

This field displays the name of the project settings Profile that is currently being used.
When Set is pressed, any changes to the values in the displayed Settings node or sub node are be modified
in this Profile and used for the duration of the session. The new values are saved when the project is saved.

If another named Profile is selected from the pop-up, it becomes the Active Profile, and any changes fo the
values in the panel will be for the new Active Profile.

The name of the Profile that is the Active Profile is saved with the Project and when the project is
reopened, it will again be the Active Profile.

For more information on Project Settings and Project Settings Profiles, see 6.5 Project Settings.

Fields and Buttons on Bottom:

Import/Export project settings profiles
Another file of named Profiles can be imported (vead in), or the existing named Profiles for the current
project can be exported (written out) to a file.
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Import mode choice box

Select Chnicen

Replace all

Append rename
Append discard
Append replace

If Replace all, all the existing Profiles in the current project are deleted and replaced by the profiles in the
project settings file given in the File field. Hence the Profiles in the given file become the Project Settings
Profiles for the current project. The first Profile in the file marked becomes the Active Profile for the
current project.

If Append rename, read in the project settings file (12dsettings) given in the File field and add all the
Profiles in the given file in to the list of named Project Settings for the current project. If a name already
exists, then give the new named Profile a different name to the existing named Profile.

If Append discard, read in the project settings file (12dsettings) given in the File field and add all the
Profiles in the given file in to the list of named Project Settings for the current project. If a name already
exists, then leave the existing named Profile and do not use the new named Profile.

If Append replace, read in the project settings file (12dsettings) given in the File field and add all the
Profiles in the given file in to the list of named Project Settings for the current project. If a name already
exists, then delete that named Profile and replace it with the one read in the from the file.

File file box *.12dsettings files

Name of the file to write the named Profiles for the current project out to, or a file of Project Setting to read
in.

Import button
Read in the project settings file (12dsettings) given in the File field with the behaviour given by the Import
mode field.

Export button

Write out the named Project Setting Profiles in the current project to the file with the name given in the
File field. The file is given the ending 12dsettings.

Set button

The values in the fields displayed on the right side page of the node become the active values and set as the
values for the current Active Profile.

Continue to 6.5.2.2 Main Page Settings or return to 6.5.2 Project =>Settings or 6.5 Project Settings
or 6 Project.
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6.5.2.2 Main Page Settings

P Project Settings —

*

Active profile | Defaylt Project Settings

o m Layout

4

ﬂi Defaults Autosave screen layout [v

2 Systemn | M
D Inquire | M
[ Select

co Qptions Search Bar ser intetface

On-screen Keyboard Praperty list quick popup r
242 Cad

fl Drafting Diagnostics

Sawe Send aption log files on successful exit v

1 Trash Model
i@ Plots and Reports
O Ohject Display
225 WWater String
? Sureey Data
B = Super Alignment

El Report

Import/Export project settings profiles
Irmpart Mode | Anpend renarme ﬂ

File | u Irmport| Export
Set Finish Help

The fields and buttons used in this panel have the following functions.

Field Description Type Defaults Pop-Up
Layout section

Autosave screen layout.4d tick box

If ticked, when the project is saved, all the menus and panels on the screen that are slx-able, are saved to a
special layout file. And when the project is next opened, the special layout file is read back and the panels
and menus restored to the screen.

If not ticked, no information about the menus and panels on the screen is saved.
Edit toolbar x location integer box

If not blank, the X location is the position of string or element edit toolbar on the x-axis of the application
screen. The top left corner below the top menu is 0.

If blank, the X location "0" is used.

Edit toolbar y location integer box

If not blank, the Y location is the position of string or element edit toolbar on the y-axis of the application
screen. The top left corner below the top menu is 0.

If blank, the Y location "0" is used.

User interface section
Property list quick pop up tick box
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If ticked, clicking on the Property List choices icon will pop-up the choice list.

If not ticked, to access the pop-up choice list for Property List, the user needs to click on the Selection
icon.

Diagnostics section

Send option log files on successful exit tick box

If ticked, then when 12d Model successfully exits (that is, did not crash) a log file will be sent back to 12d
Solutions.

The log file contains information about how 12d Model was used during the session. This information

includes what panels and options were used, how long they took to execute, what modules were accessed
along with license and dongle information.

If not ticked then a log file will not be sent back to 12d Solutions when 12d Model successfully exits.

Important Note

When the values of any fields are changed on a right side page for a node, the Set button must be pressed
for the values in the displayed fields to become active and set as the values for the current Active Profile.

Continue to 6.5.2.3 Defaults Settings or return to 6.5.2 Project =>Settings or 6.5 Project Settings or
6 Project
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6.5.2.3 Defaults Settings

these setting are the same as, and replace, the ones of the same name on the Default Settings tab on the
Defaults panel.

iP Project Settings — X
Active profile | Defaylt Project Settings ﬂ
r Settmgs Default
Defaults Colour ’cyan— J
D Systern Point colour wellowy J
& D Inquire Tir colour green J
M [ Select
Za Options Search Bar Contour colour cyan J
On-screen Keyboard Contaur bald colaur blue ﬂ
& Cad Input/output null height -0og ﬂ
) Drafting Text height (pixels) 6 =
Save el 6 ﬂ
7 Trash Model Chord to arc tolerance .1 ﬂ
= Plots and Reparts Culling size I
= Object Display Culling size {pixels) J
225 Miater String
? Survey Data Carner angle Il iy
B =5 Super Alignment Weed tolerance 0 ﬂ
El Repart Section wiew exaggeration J
Perspective view exaggeration J
Cutwvolume sigh ’negatwe— J
Use density drawing v

The fields and buttons used in this panel have the following functions.
Field Description Type Defaults Pop-Up

Colour colour box default colour available colours

Name of the current default colour used for line strings.

Point colour colour box def point colour  available colours
Current default colour used for point strings.

Tin colour colour box def tin colour available colours
Default tin colour used in the triangulate model and view panels.

Contour colour colour box  default cont colour available colours
Default contour colour used in the contour panel.

Contour bold colour colour box default cont index colour available colours

Default contour bold colour is used in the contour panel.

Input/Output null height real box -999.0

This field contains the value of the value recognised as a null height when reading in and writing out data.

Text height (pixels) real box 6
Default text height used in the sewer option and other panels.

Chord to arc tolerance real box 0.1
Maximum value of a chord to arc distance. If this distance is exceeded when approximating curves by

chords, extra points are inserted into the curve so that the chords all have chord/arc distances less than
this value. A value of zero disables the chord/arc test. See 3.25.2 Chord-to-Arc Tolerance.
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Culling size tick box

If ticked, use the culling setting for any new perspective or plan views.

Culling size (pixels) real box 5

culling size for any new perspective or plan views.

Corner angle angle box 1 degree

When applying templates or calculating interfaces along a string, extra sections may be required at string
vertices with no horizontal curve on them. If the corner angle is non-zero, extra sections are added in at
multiples of the corner angle value for the plan angle at the vertex.

Weed tolerance real box 0

If two points on a string (with the same bearing) are closer that this distance then the second point is left
out. This applies to the extra points added in at chainage points in interfacing and corner angles.

Section view exaggeration real box 10

Default vertical exaggeration used for any new section views.

Perspective view exaggeration realbox 1

Default vertical exaggeration of any new perspective views.

Cut volume sign choice box negative negative, positive
Sign (positive or negative) used for cut volumes and areas. The sign for fill is the opposite.

Use density drawing tick box

If Use density drawing is ticked, the data density for a model is calculated and if it is too high, a red
rectangle is drawn around the model instead of the individual vertices of the strings in the model.

If the data density of the model is low enough not to replace the entire model by a red rectangle, a data
density is calculated for each string in the model and if the data density is too high, the string is replaced
by a red rectangle.

Note: This setting is only applicable to the Bigfoot version of 12d Model.

The default for a new project is given by the environment variable USE_DENSITY_ CHECKS 4D.

Important Note

When the values of any fields are changed on a right side page for a node, the Set button must be pressed
for the values in the displayed fields to become active and set as the values for the current Active Profile.

Continue to 6.5.2.4 System Settings or return to 6.5.2 Project =>Settings or 6.5 Project Settings or 6_
Project.
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6.5.2.4 System Settings

These setting are the same as, and replace, the ones of the same names on the System Settings tab of the

Defaults panel.
il Project Settings - d
Active profile | Default Project Settings v
{5k Settings System
a5 Defaults fngle made |bearings
]

BT

Length system [Meters

m Inguire
[@ Select
- Options Search Bar
On-screen Keyboard | | Points per string — [1000

Angular system |350='"

Display colours |30

< W BEEREEEE |

4 Cad Display precision |3
fll] Drafting 3 .
Save 0x precision |4
TJ Trash Model Angular precision |3
= Plots and Reports Formula precision |14
L Object Display e Vo T
ZZ5 WWater String
E Survey Data Display edit information
=] Super Alignrment Function results
E Repaort
The fields and buttons used in this panel have the following functions.
Field Description Type Defaults Pop-Up
Angle mode choice box bearings cartesian, bearings

Specifies whether bearings or cartesian angles are used in reporting the instantaneous direction of the
selected string in the information menu.

Length system choice box Meters
Length System
Specifies the default units for use in
Angular system choice box bearings
Select Chnicen
360 =
360° dec
400 gon
£400 mil
Circular
Angular System

Specifies the default units for use in Angle boxes (used for entering/displaying angles or bearings.

1f 360 deg min sec, then degrees, minutes and seconds in 3.23.2 HP Notation.
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1f 360 dec, then 3.23.3 Decimal Degrees.

1If 400 gon, then 3.23.4 Gons. There are 400 gons to a full circle.
1f 6400 mil, then 3.23.5 Military mils. There are 6400 mils to a full circle.

The 6400 is used in 6400 mils so there is no confusion with the definition of mils as milliradians where
a milliradian is one thousandth of a radian. There are approximately 6283 milliradians to a full circle.

If Circular, then 3.23.6 Circular or Radians.

Display colours colour box 80
Number of colours from the colours.4d file that are displayed in a Select Colour pop-up.

If'0, all colours are displayed.

The order that the colours are selected is given by the Pop-up number in the colours.4d file. See 3.31.3
Editing Colours.4d.

Points per string integer box 1000
When reading in data from say an xyz file and there are individual points, for efficiency these are collected
in a super string with point linestyle and a new super string is started when there are more than Points per
string vertices in the super string.

Display precision integer box 3

Number of decimal places used for values displayed in the information menus.

Box precision integer box 4
Number of decimal places used for values displayed in real boxes and real panel fields. The minimum
value for the box precision is 3, e.g. the actual precision will 3 if the setting value is less than 3.
Angular precision integer box 3
Number of decimal places used for values displayed in angle boxes and angle panel fields.

Formula precision integer box 14

Number of decimal places used for.

Popup length integer box 28
This is no longer used - the maximum number of items in a pop-up before breaking the pop-up into walk-
rights.

Display edit information tick box tick

If ticked, the Edit Info panel is automatically displayed whenever a string is created or edited. See
10.3.1.2 Super Edit Info Panel.

Function results tick box tick
If ticked, function results such as volumes will be displayed on the screen every time a recalc is done.
If not ticked, no function results as displayed on a function recalc.
Important Note
When the values of any fields are changed on a right side page for a node, the Set button must be pressed

for the values in the displayed fields to become active and set as the values for the current Active Profile.

Continue to 6.5.2.5 Inquire Settings or return to 6.5.2 Project =>Settings or 6.5 Project Settings or 6_
Project.
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6.5.2.5 Inquire Settings

These setting are for use with 10.10 String Inquire.

il Project Settings - d
Active profile | Default Project Settings v
{:{, Settings General
a5 Defaults Use superinguire v
E System Inquire style [Default ﬂ
D | M
[@ Select
Zo Options Search Bar Copy to cliphoard N
On-screen Keyboard Copy wvalue only to clipboard ™
a0
o~ Lad Tab delimiter r
fll] Drafting .
Cave Show grid v
1 Trash Model F e —
) Plats and Reports Use advanced inquire v
L Object Display
S5 Wiater String | J
E Survey Data | m
S| Super Alignment Show heads-up display v
E Report
The fields and buttons used in this panel have the following functions.
Field Description Type Defaults Pop-Up

Inquire section

Use super inquire tick box
If ticked, user defined information is displayed when selecting an object. See 3.16.7 Information
Displayed When Picking an Object.
If not ticked, the pre-Super Inquire of V11 is displayed. See 3.17.5 Non Inquire Style Information.

Inquire style inquire style box
If Use super inquire is ticked, the given Inquire style is used when displaying information in object
Selects.

Word wrap at integer box

When Grid display is ticked, various rows of text data such as string name, text attribute values in the
String Inquire Information panel with more characters than this value with wrap onto more rows.
Copy to clipboard tick box
If ticked, the Copy to clipboard mode is set to yes for object Selects.
If not ticked, the Copy to clipboard mode is set to no for object Selects.
Copy value only to clipboard tick box

If ticked, only copy the values of the items in the Inquire style to clipboard.
If not ticked, copy the names of the items and their values in the Inquire style to clipboard. The two are
separated by either a space or a tab depending upon Tab delimiter.

Tab delimiter tick box

If ticked, use a tab between the item names and the item values when both are copied to the clipboard.
If not ticked, use a space between the item names and the item values when both are copied to the
clipboard.

Show grid tick box

If ticked, the String Inquire Information panel has two column grid display for names and values
If not ticked, the String Inquire Information panel has no grid display, the name and value in each line is
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separated by the = sign

Advanced section

Use advanced inquire tick box

If ticked, the Advanced setting tick box in 10.10 String Inquire is ticked on.
If not ticked, the Advanced setting tick box in 10.10 String Inquire is not ticked on.

Reference string string select box

If not blank, the string to use in the Reference string field in 10.10 String Inquire.
If blank, no string is being used in the Reference string field in 10.10 String Inquire.

Tin tin box

If not blank, the tin to use in the Tin field in 10.10 String Inquire.
If blank, no tin is being used in the Tin field in 10.10 String Inquire.

Show heads-up display tick box

If ticked, the Heads-up display tick box in 10.10 String Inquire is ticked on.
If not ticked, the Heads-up display tick box in 10.10 String Inquire is not ticked on.

Important Note
When the values of any fields are changed on a right side page for a node, the Set button must be pressed

for the values in the displayed fields to become active and set as the values for the current Active Profile.

Continue to 6.5.2.5.1 Inquire Settings >Heads-Up Display or return to 6.5.2 Project =>Settings or
6.5 Project Settings or 6 Project.
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6.5.2.5.1 Inquire Settings >Heads-Up Display

These setting are for use with 10.10 String Inquire when Heads-up display is ticked on.

il Project Settings - d
Active profile | Default Project Settings b
{5 Settings Heads-Up Display Settings
a5 Defaults Showe offset line ™
2 systern a
= D Inguir ﬂ

=

- Options Search Bar

On-screen Keyboard
20 Cad

fIll Drafting

|
® [ Select |
|
|

E[e

The fields and buttons used in this panel have the following functions.

Field Description Type Defaults Pop-Up

Show offset lines tick box
If ticked, offset lines are displayed in the heads-up display.

Linestyle linestyle box

If not blank, the linestyle to use for drawing the line from current position to the reference string when
Head-up display is used in 10.10 String Inquire.

If blank, the Linestyle "1" is used.

Line colour colour box

If not blank, the colour to use for drawing the line from current position to the reference string when
Head-up display is used in 10.10 String Inquire.

If blank, the colour "green" is used.

Textstyle data inquire style box

If not blank, the Textdata to use for the chainage and offset values when Head-up display is used in 10.10
String Inquire.

If blank, the Text style "1" is used for the chainage and offset values when Head-up display is used in
10.10 String Inquire.

Text spacing double box
If not blank, the spacing to use between text lines of chainage and offset values.

The spacing value is a factor applied to the text size defined in the Textstyle data above. That is, a value of
1.0 is equal to 100% of the text size and a value of 0.5 is equal to 50% of the text size.

If blank, the Text spacing value "0.5" is used. That is 50% of the text size.
Display precision double box

If not blank, the Display precision is the number of decimal places to use when showing chainage and
offset values.

If blank, the Display precision is "3". That is, 3 decimal places is used.
Important Note

When the values of any fields are changed on a right side page for a node, the Set button must be pressed
for the values in the displayed fields to become active and set as the values for the current Active Profile.
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6.5.2.6 Select Settings

These setting are the selecting the names of modes, tins, functions, templates, choices and names in the
Names box.

P Project Settings — >
Active profile | Default Global Settings ﬂ
{g-} Settings A

37 Defaults

0 systern

m %

= Muodels, Tins, F
Choices
E Mames

Zo Qptions Search Ba
On-screen Keyboa
27 Cad
flll Drafting
Save
1 Trash Model
= Plots and Reports
O Object Display
225 Wiater String
¥ Surew Data Y

Continue to 6.5.2.6.1 Select >View Models Settings or return to 6.5.2 Project =>Settings or 6.5
Project Settings or 6 Project.
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These setting are used by the Models to Add and Models to Remove panels that come up by clicking LB
over the + and = buttons on any View.

What’s New in 12d Model 15

If a setting is changed then the change is used for the Models to Add and Models to Remove panels that
come up by clicking LB over the + and = buttons on ANY View.

P Project Settings — s @
Active profile | Default Project Settings ﬂ i +_L—JLJ_$] Fl e | e - @l
5F Settings Panel mm Models to Add to "3"
92 Defaults List b width BT M
S System List bax height [0 M |
B [1] Inquire — M base
[E3 Heads-Up Display .
o [E Select li M batter outside
< GEY ﬂ cadastral
= Madels, Tins, Funt li ﬂ construction
Choices Obisctt .
5 Hammes ject tree expansion 1 ﬂ conte
=& Options Search Bar Search mesh
On-screen Keyboard Dyharnit search v movie
ﬂﬁ-:_:- Cad
fll] Drafting htelieln case - pad/pad polygons
Save Wioells worE r pad/pad sections
TJ Trash Model Sorting s .
= Plots and Reports N ko s e
O3 Object Display Case sensitive v point Add fo view display
25 Wfater String Descending order I P — inode path
? Survey Data p
B &5 Super &lignment Savee) Salloely ﬂ road
E| Report 1 ﬂ structures
E ﬂg 4| tank/tank
ﬂ [T — [
< 2 E
The fields and buttons used in this panel have the following functions.
Field Description Type Defaults Pop-Up

Panel section

List box width, List box height, Default row height, Search text length
See 6.5.2.21 List Box Width, List Box Height, Default row Height, Search Text Length.

Add to view display mode choice box tree, path, name
How to display the model name in the list when clicking LB over a +.

If tree, the path name of the model is displayed in object tree form.

If name, the final node of the full path name is shown in the first column and the rest of the path name in a
second column.
If path, the full path name of the model is displayed as text.

Remove from view display mode choice box tree, name, path, view

How to display the model name in the list when clicking LB over a -.

If tree, the path name of the model is displayed in object tree form.

If name, the final node of the full path name is shown in the first column and the rest of the path name in a
second column.

If path, the full path name of the model is displayed as text.

If view order, the models are displayed in the order that they were added to the view.
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Object tree expansion Integer box

Number of levels that object tree path are expanded to when the list is displayed. Value between 1 and 6
inclusive See 3.28.3.1 Select Settings - Displaying Path Name and 3.10 Object Tree.

Search section
Dynamic search tick box

If ticked, the search results are shown dynamically as the query is type in.
If not ticked, after the search query in typed in you need to click on the Search button to show search
results
Match case, Whole word tick boxes
See 3.28.3.2 Select Settings - Match Case and Whole Word

Sorting section

Case sensitive, Descending order tick boxes
See 3.28.3.3 Select Settings - Case Sensitive Sorting and Descending Order

Saved Selects
see 6.5.2.23 Saved Selects.

Important Note

when the values of any fields are changed on a right side page for a node, the Set button must be pressed
for the values in the displayed fields to become active and set as the values for the current Active Profile.

Continue t0 6.5.2.6.1.1 Select >View Models >Typing over View + or - Settings or return to 6.5.2
Project =>Settings.
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6.5.2.6.1.1 Select >View Models >Typing over View + or - Settings

These setting are used by the Models to Add and Models to Remove panels that come up by typing one
character over the + and = buttons on any View.

If a setting is changed then the change is used when typing a character over the + and - buttons on all

Views.
il Project Settings - * =
Active profile |Default Project Settings b4 — _+J lael ol ol ] ol cal e
% Settings Bemcl] = [Models to Add to "3
97 Defaults List box width 320 M |pa-
% ;Syste_m List box height £10 M [ # point
= nquire -
[0 Heads-Up Display % g: pold}fgons
B 0 Select [ — 15 pa
1 <2 View Models | [J # pad polygons
) g G [] ¥ pad sections
T [Typing over Wiew + or - ﬂ =p
= Models, Tins, Fune Obiect t : ] pad temp strings
Chaices jecttree expansion 1 ﬂ
B [E Names Search dd to view display
=& Options Search Bar Dynamic search W ode tree
On-screen Keyboard
20 Cad Match case I~ nd
[||'| Draftirg Wihaole waord v biect t
ject tree
Save Sorting : 2
J Trash Model -~ Xpansion
S Plots and Reports Case sensitive v
L Object Display Descending arder r
ZZ5 WWater String
9 Survey Data Saved Selects ﬂ
2 == Super Alignrnent 1 ﬂ
E Report X
2|
¢ > 3
The fields and buttons used in this panel have the following functions.
Field Description Type Defaults Pop-Up

Panel section

List box width, List box height, Default row height, Search text length
See 6.5.2.21 List Box Width, List Box Height, Default row Height, Search Text Length.

Object tree expansion Integer box
Number of levels that object tree path are expanded to when the list is displayed. Value between 1 and 6
inclusive.3.10 Object Tree.

Add to view display mode choice box tree, name, path
How to display the model name in the list when typing over a +.

If tree, the path name of the model is displayed in object tree form.

If name, the final node of the full path name is shown in the first column and the rest of the path name in a
second column.
If path, the full path name of the model is displayed as text.

Remove from view display model choice box  tree, name, path, view order
How to display the model name in the list when typing over a -.

If tree, the path name of the model is displayed in object tree form.
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If name, the final node of the full path name is shown in the first column and the rest of the path name in a

second column.
If path, the full path name of the model is displayed as text.
If view order, the models are displayed in the order that they were added to the view.

Object tree expansion Integer box
Number of levels that object tree path are expanded to when the list is displayed. Value between I and 6

inclusive See 3.28.3.1 Select Settings - Displaying Path Name and 3.10 Object Tree.

Search section

Dynamic search tick box
If ticked, the search results are shown dynamically as the query is type in.
If not ticked, after the search query in typed in you need to click on the Search button to show search

results

Match case, Whole word tick boxes
See 3.28.3.2 Select Settings - Match Case and Whole Word

Sorting section

Case sensitive, Descending order tick boxes
See 3.28.3.3 Select Settings - Case Sensitive Sorting and Descending Order

ascii sort sequence.

Saved Selects
see 6.5.2.23 Saved Selects.

Important Note
When the values of any fields are changed on a right side page for a node, the Set button must be pressed
for the values in the displayed fields to become active and set as the values for the current Active Profile.

Continue to 6.5.2.6.2 Select >Models, Tins, Functions Settings or return to 6.5.2 Project =>Settings
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6.5.2.6.2 Select >Models, Tins, Functions Settings

These setting are used by the Select panels when clicking LB over the icon at the right hand end for Model
boxes, Tin boxes and Function boxes.
If a setting is changed then the change is used for the icons on all the Model, Tin and Function boxes.

.]_
iP Project Settings — Zf Defaults
Aective profile | Defaylt Project Settings Select Model
{5} Settings Panel |p
I3 Defaults List box width 320 < point
O Gystem List bux height 630 @ polygons
=] El Ingquire -
. h
[ Heads-Up Display | — epegraphy
B [F Select | =~ % pad

B <2 View Models [ #® pad polygens

. I | Typing over Wiew + ar '|:tree expansion |1
Chaoices Search

> pad sections

> pad temp strings

1| WBEEE || %
£ 1]
I .

El Marnes Dynarnic search
IT Options Search Bar Match case Display mode tree
On-screen Keyboard Wéhole word Object tree expansion 2
4~ Cad
[l Drafting Sorting Dynamic search ticked
Save Case sensitive

] Trash Model

S Plots and Reports Descending order

[
-
= Object Display Saved Selects ﬂ
225 Miater String
’E\ Survey Data 1 ﬂ
B =5 Super Alignment b 4
El Report ﬂ
=
< >

The fields and buttons used in this panel have the following functions.
Field Description Type Defaults Pop-Up

Panel section

List box width, List box height, Default row height, Search text length
See 6.5.2.21 List Box Width, List Box Height, Default row Height, Search Text Length.

Display mode choice box tree, name, path
How to display the model name in the list. See 3.28.3.1 Select Settings - Displaying Path Name

If tree, the path name is displayed in object tree form.
If name, the final node of the full path name is shown in the first column and the rest of the path name in a
second column.

If path, the full path name is displayed as text.

Object tree expansion Integer box

Number of levels that object tree path are expanded to when the list is displayed. Value between 1 and 6
inclusive See 3.28.3.1 Select Settings - Displaying Path Name and 3.10 Object Tree.

Search section

Dynamic search tick box
If ticked, the search results are shown dynamically as the query is type in.
If not ticked, after the search query in typed in you need to click on the Search button to show search
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results

Match case, Whole word tick boxes
See 3.28.3.2 Select Settings - Match Case and Whole Word

Sorting section

Case sensitive, Descending order tick boxes
See 3.28.3.3 Select Settings - Case Sensitive Sorting and Descending Order

Saved Selects
See 6.5.2.23 Saved Selects.

Important Note

When the values of any fields are changed on a right side page for a node, the Set button must be pressed
for the values in the displayed fields to become active and set as the values for the current Active Profile.

Continue to 6.5.2.6.3 Select >Choices or return to 6.5.2 Project =>Settings.
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6.5.2.6.3 Select >Choices

This setting is used by the Select panels when clicking LB over the icon at the right hand end for Choice
boxes.

If a setting is changed then the change is used for the icons on all the Choice boxes.

il Project Settings - *
Active profile | Default Project Settings b4
{5} Settings Fanel
9 Defaults List box width 240 (]
2 System List box height  [320 M
= m Inquire | M
|EI Heads-Up Display
B 0 Select | M
B =2 Wiew Models Show search box  [g M

T [Typing over Wiew + or -
= Models, Tins, Fune Fartn

Chaices Dynamic search W
E Marnes hdatch case |—
Zo Options Search Bar Whole word -

On-screen Keyboard

40 Cad Sorting
fll] Drafting Case sensitive
Save Descending order
_J Trash Maodel
= Plats and Reports Saved Selects

L Object Display
ZZ5 WWater String

E Survey Data
2 == Super Alignrnent

E Report

X6 3

The fields and buttons used in this panel have the following functions.
Field Description Type Defaults Pop-Up

Panel section

List box width, List box height, Default row height, Search text length
See 6.5.2.21 List Box Width, List Box Height, Default row Height, Search Text Length.

Show search box Integer box
?2?

Search section

Dynamic search tick box
If ticked, the search results are shown dynamically as the query is type in.
If not ticked, after the search query in typed in you need to click on the Search button to show search
results
Match case, Whole word tick boxes
See 3.28.3.2 Select Settings - Match Case and Whole Word

Sorting section

Case sensitive, Descending order tick boxes
See 3.28.3.3 Select Settings - Case Sensitive Sorting and Descending Order
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Saved Selects

See 6.5.2.23 Saved Selects.

Important Note

When the values of any fields are changed on a right side page for a node, the Set button must be pressed for
the values in the displayed fields to become active and set as the values for the current Active Profile.

Continue to 6.5.2.6.3 Select >Choices or return to 6.5.2 Project =>Settings.
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6.5.2.6.4 Select >Names

This setting is used by the Select panels when clicking LB over the Names icon.

If a setting is changed then the change is used for the icons on all the Names boxes.

il Project Settings - * g
Active profile | Default Project Settings ﬂ Project  File View Maodel String BII'\;"II (
L '_
L Settings |3.ar'|E| : | Select Mame
97 Defaults List box width |320 M 5 @ g X
2 Systern List bax height 640 M I |6 |
= [1] Inquire . | M — | [> @ Alignment
|EI Heads-Up Display . > g Boundaries
2 @ Select | M ‘ B rad
1 <2 View Madels | R4 . D: =
I [Typing overView + or -}y, expansion |1 ﬂ - p > . Design
— 1
= Madels, Tins, Funt D‘ [> mm General
Choices Search - [» @ MNen Survey Data
Em Dynamic search i~ D‘ [» E Survey
za Options Search Bar Match case m -_'\‘
On-screen Keyboard A, isplay mode tree
20 Cad Whale word r rii, play
fll] Drafting Use camment instead of name W — and
e sarting Object tree expansion 1
) Trash Model .
= Plats and Reports 052 SRl W
| Object Display Descending order B
ZZ5 WWater String
T Survey Dats Saved Selects ﬂ
2 == Super Alignrnent 1 ﬂ
E Report x
2|
< > =
The fields and buttons used in this panel have the following functions.
Field Description Type Defaults Pop-Up

Panel section

List box width, List box height, Default row height, Search text length
See 6.5.2.21 List Box Width, List Box Height, Default row Height, Search Text Length.

Display mode choice box tree, name, path
How to display the name in the list. See 3.28.3.1 Select Settings - Displaying Path Name

If tree, the path name is displayed in object tree form.

If name, the final node of the full path name is shown in the first column and the rest of the path name in a
second column.

If path, the full path name is displayed as text.

Object tree expansion Integer box

Number of levels that object tree path are expanded to when the list is displayed. Value between I and 6
inclusive See 3.28.3.1 Select Settings - Displaying Path Name and 3.10 Object Tree.

Search section

Dynamic search tick box
If ticked, the search results are shown dynamically as the query is type in.

If not ticked, after the search query in typed in you need to click on the Search button to show search
results.
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Match case, Whole word tick boxes

See 3.28.3.2 Select Settings - Match Case and Whole Word

Use comment instead of name tick box
If ticked, the Comment field from the names.4d file is used in the pop-ups.
If not ticked, the Names field from the names.4d file is used in the pop-ups.

Sorting section

Case sensitive, Descending order tick boxes
See 3.28.3.3 Select Settings - Case Sensitive Sorting and Descending Order

Saved Selects
See 6.5.2.23 Saved Selects.

Important Note

When the values of any fields are changed on a right side page for a node, the Set button must be pressed for
the values in the displayed fields to become active and set as the values for the current Active Profile.

Continue to 6.5.2.7 Search Bar Settings or return to 6.5.2 Project =>Settings.
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6.5.2.7 Search Bar Settings

These setting are used by the Search for 12d Model Options panel that is brought up by typing into the
Options Search Bar. See 3.27 Options Search Bar.

i Project Settings - d
Active profile | Default Project Settings v
{5h Settings Panel
92 Defaults List bex width 320 |
S System List box height [640 @
=] El Inguire | @
|EI Heads-Up Display
B [ Select [ @

B 52 View Models earch
T [Typing over iew + or -|

— i h W
= Maodels, Tins, Funi FTTIC seare v
Chaices Match case -
El Marnes Whole word -

BN Options Search Bar :

On-screen Keyboard Sorting

40 Cad Caze sensitive

H Drafting Descending order

Sawve

] Trash Maodel Saved Searches

= Plots and Reports 1

L Object Display
I Wiater String

,E\ Survey Data
B =S Super Aligrrert

El Report

et |x ¢ [o | T T

The fields and buttons used in this panel have the following functions.
Field Description Type Defaults Pop-Up

Panel section

List box width, List box height, Default row height, Search text length
See 6.5.2.21 List Box Width, List Box Height, Default row Height, Search Text Length.

Search section

Dynamic search tick box
If ticked, the search results are shown dynamically as the query is type in.
If not ticked, after the search query in typed in you need to click on the Search button to show search
results
Match case, Whole word tick boxes
See 3.28.3.2 Select Settings - Match Case and Whole Word

Sorting section

Case sensitive, Descending order tick boxes
See 3.28.3.3 Select Settings - Case Sensitive Sorting and Descending Order
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Search for 12d Model Options n Search field
[BIM] - Q|
Check strings [BIM-=Check clash] ~

Check trimeshes [BIM->Trimesh]

Clean up [BIM-= ADAC-= Utilities]

Clouds [BIM->Visualisation-= Utilities]

Celour within pelygon [BIM-=Visualisation-> Utilities]
Contour smooth label trimeshes [BIM-=>Trimesh-»> Contours
horizontal scroll bar Contour trimeshes [BIM-=Trimesh-= Contours]

Convert to 12dmesh [BIM-=>Visualisation- = Meshes]

Cookie cut by polygen [BIM->Trimesh- = Split Cut]

Copy LAS files by categories [EIM->Point clouds-> Categori

Copy Point cloud by categories [BIM-»Point clouds-» Categ vertical scroll bar
Cragte [BIM-=Visualisation-» Extrusions] v
< >

Select

Saved Searches

See 6.5.2.23 Saved Selects.
If any Search text for the Search for 12d Model Options has been saved, it will be listed here.

Active profile | Default Project Settings

{g-} Settings Panel
97 Defaults List box width 320
L System Listbox height  [54p

[7 Select
S Scorch 5ar '
On-screen Keyboard |
40 Cad
f][] Drafting
Save 1
J Trazh Model
= Plots and Reports -_—
T Object Display Row 1 |
=== Water String

Saved Searches

alex <o |EEEE |

Insert above
E survey Data Insert below
n%‘, Super Alignment e

New Search text can be added by typing into a row but the new Search text is only available for use by the
Search for 12d Model Options panel by clicking on the Set button.

Similarly rows of existing Search text can be edited but the edited Search text is only available for use by
clicking on the Set button.

There are icons on the right hand side to move a row up and down, delete a row and insert blank rows
above or below a row.
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Clicking on a number icon on the left hand side also brings up the menu to Insert above, Insert Below or
Delete rows.

Any updates to the Search Texts are only saved with the project when a Project =>Save is done.

Important Note

When the values of any fields are changed on a right side page for a node, the Set button must be pressed
for the values in the displayed fields to become active and set as the values for the current Active Profile.

Continue to 6.5.2.8 On-Screen Keyboard Settings or return to 6.5.2 Project =>Settings.
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6.5.2.8 On-Screen Keyboard Settings

These setting are used by the on-screen keyboard. When the Mode is dockable or full screen, double
clicking in any input field will bring up the keyboard.

P Project Settings — >
Active profile | Defaylt Project Settings ﬂ
{ET.} Settings Keyboard
37 Defaults Muode [0 keyboard ﬂ
% System Layout [full keyboard |
=] Inquire Shle
v
[ Heads-Up Display & } Idark J
o [ Select Font size |20 M
B <2 View Models Input font size |20 M
T |Typing owver Wiew + or _ln:lnt r

= Madels, Tins, Func
Choices
E Mames

Zo Qptions Search Bar

-screen Keyboard

40 Cad

The fields and buttons used in this panel have the following functions.
Field Description Type Defaults Pop-Up

Keyboard section

Mode choice box no keyboard, full screen
If no keyboard, then no on-screen keyboard is used.
If full screen, then when a value is to be typed in, a full screen keyboard appears.

Layout choice box full keyboard, numeric pad
If full keyboard, then a full keyboard is used. See Full Keyboard.
If numeric pad, then only a numeric pad is used. See Numeric Pad.

Note: when either the full keyboard or numeric pad is up, there is a button to change to the other style.
Style choice box dark, light, classic, white
If dark, then the background to the keys is black and the text is white.
If light, then the background to the keys is grey and the text is black.
If classic, then the background to the keys is grey and the text is black, with black borders around the keys.
If white, then the background to the keys is white and the text is black.
Font size integer box
Size of the font to use on the on-screen keyboard.
Input Font size integer box
Size of the font to use for typed in values.
Bold Font tick box
If ticked, the text and keyboard font is bold.
If not ticked, the text and keyboard font is normal.

Important Note

When the values of any fields are changed on a right side page for a node, the Set button must be pressed
for the values in the displayed fields to become active and set as the values for the current Active Profile.
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Full Keyboard

Setout CS Raw Ch4
Backspace

Click on Numeric to

replace the Full keyboard
with a Numeric Pad. : : Enter

Caps

Shift z

Clear Numeric Cancel

Numeric Pad

W Keyboard

Setout CS Raw Ch 4

Click on Fullsize to
replace the Numeric pad
with a Full keyboard.

Fullsize

Continue to 6.5.2.9 Cad Settings or return to 6.5.2 Project =>Settings.
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6.5.2.9 Cad Settings

These setting are used for the values in the CAD ControlBars.

i Project Settings - >
Active profile | Default Project Settings b4
{5} Settings Fipe
95 Defaults | ﬂ
2 spstern | ﬂ
=] D Inquire | ﬂ
[0 Heads-Up Display
B 0 Select | ﬂ

B =2 Wiew Models

I [Typing over Wiew + or -

= Models, Tins, Fune
Choices
E Marnes

- Options Search Bar

On-screen Keyboard
ol Cad

fll] Drafting

B Sawe

The fields and buttons used in this panel have the following functions.
Field Description Type Defaults Pop-Up

Pipe node
Values to use for the Pipe ControlBar. The values can be left blank. See 12.1.4 Pipe Controlbar.

Shape choice box diameter, culvert
Value for the Default Pipe Shape field in the Pipe ControlBar.
The value can be blank.
Justify choice box
Value for the Default Pipe Justify field in the Pipe ControlBar.
The value can be blank.
Width/Diameter choice box

Value for the Default Pipe Size 1 field in the Pipe ControlBar.
This is used for the diameter of a round string and the Width for a culvert (box) string.
The value can be blank.

Height choice box
Value for the Default Pipe Size 2 field in the Pipe ControlBar.
This is used for Height for a culvert (box) string and ignored for a round string.
The value can be blank.
Important Note
When the values of any fields are changed on a right side page for a node, the Set button must be pressed

for the values in the displayed fields to become active and set as the values for the current Active Profile.

Continue to 6.5.2.9.1 CAD >Heads-Up Display Settings or return to 6.5.2 Project =>Settings.
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6.5.2.9.1 CAD >Heads-Up Display Settings

The Heads-Up Display has setting for CAD options to show coordinates and angles and distances as you
are dynamically creating a new vertex or segment, and also guides for the values of angles and distances.

Note: Heads-Up Display is currently only implemented for:

1. CAD =>Point =Point, Mid-segment, Mid position, Bearing and distance,
drop perpendicular

2. CAD =>Line =>2 points, Line string, Traverse
3. CAD =>Circle =>3 points
4. CAD =>Arc =>3 pts
5. CAD =>Polygon =>Rectangle from 2 points, Rectangle from 2 points, Parallelogram,
Polygon freehand
il Project Settings - d
Active profile | Default Project Settings ﬂ
15} Settings Heads-Up Display Settings
I3 Defaults Show heads-up display [v
O Sypst
v E.m Guidelines Settings
=] El Inguire :
|EI Heads-Up Display | ﬂ
B [F Select | ﬂ
B 2 View Models Show guided line ]
T Typing over i | j
= Madels, Tins, Funi =
Chaoices | ﬂ
[E] Marmes Show hotspot v
- Options Search Bar N
On-screen Keyboard | j
m 20 Cad
|EI Heads-Up Display,
fl] Drafting
2y Tawva
See

6.5.2.9.1.1 CAD >Heads-Up Display - Main
6.5.2.9.1.2 CAD >Heads-Up Display >Coordinates
6.5.2.9.1.3 CAD >Heads-Up Display >Angle
6.5.2.9.1.4 CAD >Heads-Up Display >Distance
6.5.2.9.1.5 CAD >Heads-Up Display >Text
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6.5.2.9.1.1 CAD >Heads-Up Display - Main

i@ Project Settings —

|i><

Active profile | Defaylt Project Settings

{ET.} Settings Heads-Up Display Settings
37 Defaults Showr heads-up display ™
£l Syst
g E‘ l},fs e.m Guidelines Settings
ngquire
[E3 Heads-Up Display |
2 [ Select |

2 52 View Models
T Typing over i
= Models, Tins, Fune )
Chaoices |
El Marmes Show hotspot
Za Options Search Bar |
On-screen Keyboard
=50 Cad
[8] Headls-Lp Display
FIN Drafting

Show quided line

& gled glefe

The fields and buttons used in this panel have the following functions.
Field Description Type Defaults Pop-Up
Heads-Up Display Settings section

Show heads-up display tick box ticked

If ticked, the heads-up information is displayed near the cursor.
for example, coordinates can be displayed, angle and distance when creating a new segment,
and guide lines for angles, distances and text.

If not ticked, no heads-up information is displayed.

Guidelines Settings section

Pixel tolerance real box
??

Distance tolerance real box
?2?

Show guide line tick box

If ticked, guide lines are displayed for placing segments and text.
If not ticked, guide lines are not displayed.

Linestyle linestyle box
Linestyle for the guidelines.
Line colour colour box
Colour for the guidelines.
Show hotspot tick box ticked

If ticked, the Hotspot symbol is drawn at the hotspot.
If not ticked, no Hotspot symbol is drawn.

Hotspot symbol symbol box
Symbol to use at the hotspot.

Continue to 6.5.2.9.1.2 CAD >Heads-Up Display >Coordinates or return to 6.5.2.9.1 CAD >Heads-
Up Display Settings or 6.5.2.9 Cad Settings or 6.5.2 Project =>Settings.
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6.5.2.9.1.2 CAD >Heads-Up Display >Coordinates
This section defines how the X, Y and Z coordinates are displayed in the Heads-Up information.

P Project Settings

x

Active profile | Default Project Settings

4

5} Settings A Coordinates Settings
95 Defaults Show coordinates v
2 spstern | M
=] D Inquire | J
|EI Heads-Up Disp “
B [ Select ¥ Coordinate Settings
B =2 Wiew Models | A
I [Typing over Wiew + or - |
= Muadels, Tins, F
Choices | ﬂ
E Marnes Y Coordinate Settings
- Options Search Ba | =
Or-screen Keyboa A
2 40 Cad |
B [E3 Heads-Up Disp [ ﬂ
L Coordinate - -
I\ Angle Z Coordinate Settings
?@ Distance | Al
T Text |
fll] Drafting | ol

The fields and buttons used in this panel have the following functions.
Field Description Type Defaults Pop-Up
Coordinate Settings section

Show coordinates tick box

Ifticked, the X, Y and Z coordinates are shown in the heads-up information
If not ticked, the X, Y and Z coordinates are not shown in the heads-up information

Display precision integer box

The number of decimal places to show for the X, Y and Z coordinates.
If blank, "2" is used.

Point symbol symbol box

Symbol to use at the cursor position.

X/YIZ Coordinate Settings section

Textstyle data textstyle data box
Textstyle data to use for the X /Y/Z coordinate.
If blank, a reasonable textstyle data is used so this can be left blank.

Text pre*post input box
Text to use before and after the X/Y/Z coordinate value.
If blank, "X /Y /Z " is used.

Scale factor real box
Value of the X/Y/Z coordinate is multiplied by Scale factor before being displayed.
If blank, "1" is used.

Continue to0 6.5.2.9.1.3 CAD >Heads-Up Display >Angle or return to 6.5.2.9.1 CAD >Heads-Up
Display Settings or 6.5.2.9 Cad Settings or 6.5.2 Project =>Settings.
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6.5.2.9.1.3 CAD >Heads-Up Display >Angle
This section defines how the angle of a segment being drawn is displayed in the Heads-Up information.

x

P Project Settings —

4

Active profile | Defaylt Project Settings

*:.3.} Settings A Angle Settings
37 Defaults Showy angle I~
0 systern ﬂ
=] D Inquire
[ Heads-Up Disp ﬂ
g [ Select ﬂ
Bl %22 View hodels M

T |Typing owver Wiew + or -
= Muodels, Tins, F
Choices
E Mames

Zo Qptions Search Ba
On-screen Keyboa
= %-:1:- Cad

B [ Heads-Up Disp
-o- Coordinate
-~ B
?@ Distance
T Text

I~

[B5[e

The fields and buttons used in this panel have the following functions.
Field Description Type Defaults Pop-Up

Angle Settings section

Show angle tick box
If ticked, the angle of the segment being drawn is shown in the heads-up information
If not ticked, the angle of the segment is not shown in the heads-up information

Textstyle data textstyle data box
Textstyle data to use for angle.
If blank, a reasonable textstyle data is used so this can be left blank.

Angle mode choice box cartesian, bearing
How the angle is calculated.

If cartesian, the angle is measured from the positive x-axis and in a counter-clockwise direction.
If bearing, the angle is measured from the positive y-axis and in a clockwise direction.
Angular system choice box 360 deg min sec,

360 dec, 400 gons,
6400 mil, Circular

The system of units is used for the angle.
If blank, " 360 deg min sec" is used.
1 360 deg min sec, the angle is measured degrees, minutes and decimal seconds.
I 360 dec, the angle is measured in decimal degrees.
1f 400 gons, the angle is measured in decimal gons.
1If 6400 mil, the angle is measured in military mils.
If Circular, the angle is measured in radians.
Display precision integer box
Number of decimal places to use.

If blank, "2" is used.
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Pre*post cartesian text box

the text is use before and after the angle value when Angle mode is cartesian.
If blank, "c " is used.

Pre*post bearing text box
Text to use before and after the angle value when Angle mode is bearing.

If blank, "b " is used.

Text on segment location choice box start, middle, end

The positioning of the angle text with respect to the segment being drawn. The Textstyle data is then
applied to this position.

If blank, the text is positioned at the end of the segment being drawn.

If start, the text is positioned at the start of the segment being drawn.

If middle, the text is positioned at the middle of the segment being drawn.
If end, the text is positioned at the end of the segment being drawn.

Guide angle angle box

If not blank, when the angle that the segment makes is close to
Reference angle + n*Guide angle where n is an integer
then a guide line is drawn at that angle and the segment is snapped to the guide line and remains there
until the cursor is outside the Distance tolerance or Pixel Tolerance. Note that guide angle will be
cartesian or bearing depending on Angle mode.

If blank, no guide lines are shown.

Reference angle angle box

Used with Guide angle for calculating when a guide line is displayed.
If blank, "0" is used.

Continue t0 6.5.2.9.1.4 CAD >Heads-Up Display >Distance or return to 6.5.2.9.1 CAD >Heads-Up
Display Settings or 6.5.2.9 Cad Settings or 6.5.2 Proj